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2.3 Vykresleńı grafu funkce . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
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3.5 Vı́cerozměrný integrál . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
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5.2 Varováńı (Warnings) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 180
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Předmluva

Učebńı text Matematika s programem Maple vznikl přepracováńım p̊uvodńıho d́ıla
”
Matema-

tická analýza – cvičeńı s použit́ım Maple“, které vzešlo z řešeńı projektu FRVŠ č. 2785/2010,
rozš́ı̌reńım o některé nové funkcionality př́ıtomné v později vydaných verźıch systému Ma-
ple, tj. verźıch 15 a 16, a doplněńım o kapitoly věnované lineárńı algebře a diferenciálńım
rovnićım. Současně byly odstraněny některé známé nedostatky předchoźıho textu.

Nejviditelněǰśı změnou uvedenou v Maple 16 je vylepšeńı vizualizace. Veškeré grafy vy-
padaj́ı mnohem lépe a profesionálněji. Daľśı novinkou jsou matematické aplikace zvané Math
Apps přinášej́ıćı interaktivńı výukové demonstračńı dokumenty. Oproti verzi Maple 14 byly
také vylepšeny r̊uzné pomocné nástroje jako např. InverseTutor pro vykresleńı funkce a jej́ı
inverze do jednoho grafu spolu s osou symetrie.

V matematice je zvykem vynechávat symbol pro násobeńı, tečku, mezi výrazy, které spolu
násob́ıme. Dostáváme tak např. výrazy 3x, 2π, xy ve skutečnosti představuj́ıćı 3 ·x, 2 ·π, x ·y.
Přestože je současná verze systému Maple již natolik

”
chytrá“ a umı́ s výrazy t́ımto zp̊usobem

pracovat (tj. vynechávat symbol pro násobeńı), je při tom třeba velké opatrnosti a předevš́ım
zač́ınaj́ıćım uživatel̊um vynecháváńı symbolu pro násobeńı nemůžeme doporučit. Z tohoto
d̊uvodu je ve všech př́ıkazech systému Maple i v samotném textu d̊usledně dodržováno
vkládáńı symbolu pro násobeńı, byt’ to někdy p̊usob́ı nezvykle (viz např. 2 · π).

TATO VERZE TEXTU JEŠTĚ NENÍ DOKONČENA.
POSLEDNÍ AKTUALIZACE: 5. 11. 2012.
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1 Úvod do systému Maple

1.1 Systém Maple

Systém Maple je výkonný program pro řešeńı jednoduchých i složitěǰśıch matematických
problémů. S jeho pomoćı také můžeme vytvářet dokumenty vysoké kvality, prezentace a in-
teraktivńı uživatelské nástroje. Maple patř́ı do skupiny systémů poč́ıtačové algebry umožňuj́ıćı
jak symbolické, tak numerické výpočty. Systém nav́ıc obsahuje komponenty podporuj́ıćı
výuku matematiky.

Výrobcem systému je kanadská společnost Maplesoft Inc., jej́ıž webové stránky1 posky-
tuj́ı široké informace o systému a jeho daľśıch př́ıbuzných programech jako je MapleSim,
MapleNet, Maple T.A. a mnoho daľśıch nástroj̊u a programů. Webové stránky mimo jiné
obsahuj́ı tzv. Aplikačńı centrum2 (Application Center), z nějž si může každý zaregistrovaný
uživatel stáhnout ukázkové programy demonstruj́ıćı použit́ı systému Maple při řešeńı mnoha
r̊uzných matematických i technických problémů. Poskytuj́ı i tzv. Studentské centrum3 (Stu-
dent Help Center), kde si zaregistrovaný student může stáhnout mnoho studijńıch materiál̊u.
Daľśımi významnými zdroji informaćı o Maple jsou diskuzńı fórum uživatel̊u Maple4 a web
distributora Maple pro Českou a Slovenskou republiku5, kde je většina dokument̊u v českém
jazyce [5], [9].

Systém Maple je vyv́ıjen od roku 1980, v němž se objevila jeho prvńı limitovaná verze.
Přelomovým obdob́ım byly roky 2003–2005, v nichž vznikla devátá a následně desátá verze
Maple 10 přinášej́ıćı nové grafické uživatelské rozhrańı zvané Standard Worksheet a poté tzv.
dokumentový režim (Document mode). Dı́ky nim se ovládáńı systému Maple stalo výrazně
jednodušš́ım. V současné době vzniká každý rok nová verze, v době psańı této inovované
a rozš́ı̌rené verze p̊uvodńıho textu byla na trhu nejnověǰśı verze Maple 16. Budeme proto
prezentovat možnosti právě zmı́něné nejnověǰśı verze systému, nicméně naprostá většina
př́ıkaz̊u a funkćı, jež budeme použ́ıvat, je v Maple dostupná již od dř́ıvěǰśıch verźı systému
(zejména od přelomové desáté verze).

Se systémem je možné pracovat několika r̊uznými zp̊usoby, které voĺıme při spuštěńı
programu ze startovaćıho menu poč́ıtače nebo kliknut́ım na př́ıslušnou ikonu na ploše. Maple
je k dispozici pro r̊uzné operačńı systémy. V následuj́ıćım textu poṕı̌seme, jak program
spoušt́ıme v nejrozš́ı̌reněǰśım operačńım systému Windows.

1.1.1 Standardńı zápisńık (Standard Worksheet)

Grafické uživatelské rozhrańı Maple zvané Standard Worksheet se spust́ı ze startovaćıho
menu poč́ıtače výběrem položky Programy > Maple 16 > Maple 16 nebo kliknut́ım

1http://www.maplesoft.com
2http://maplesoft.com/applications/index.aspx
3http://maplesoft.com/studentcenter/index.aspx
4http://www.mapleprimes.com
5http://www.maplesoft.cz
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na ikonu Maple 16 na ploše. Toto prostřed́ı poskytuje veškeré možnosti systému Maple
a pomáhá vytvářet elektronické dokumenty (zápisńıky) zobrazuj́ıćı matematické výpočty,
texty a komentáře spolu s propracovanou poč́ıtačovou grafikou. Některé je možné v zápisńıku

”
schovat“ a nechat

”
odkryté“ jen nejd̊uležitěǰśı pasáže tak, aby dokument poskytoval uživateli

potřebné informace. Jelikož jsou vytvořené dokumenty interaktivńı, tj. v jistém smyslu

”
živé“, může si uživatel sám upravovat předdefinované hodnoty parametr̊u, vyhodnocovat

př́ıkazy, a źıskávat tak nové výsledky.

Menu zápisńıku Maple má tři vodorovné lǐsty: hlavńı menu (Menu Bar, zcela nahoře),
nástrojovou lǐstu (Toolbar, pod hlavńım menu) a kontextovou lǐstu (Context Bar, pod nástrojovou
lǐstou). Zápisńık dále obsahuje palety (Palettes , svislý blok na levé straně6), vlastńı pracovńı
pole – dokument (Document), do nějž zadáváme př́ıkazy, texty, provád́ıme výpočtové a gra-
fické akce, a stavovou lǐstu (Status Bar, zcela dole). Vlastńı pracovńı pole je možné zobrazit
přes celou obrazovku skryt́ım palet a všech lǐst (kromě hlavńıho menu) kliknut́ım na př́ıslušné
položky v záložce View hlavńıho menu.

Obrázek 1.1: Maple 16: Prostřed́ı Standard Worksheet.

1.1.2 Klasický zápisńık (Classic Worksheet)

U 32bitových operačńıch systémů je k dispozici též tzv. Classic Worksheet , který se spust́ı ze
startovaćıho menu poč́ıtače výběrem položky Programy > Maple 16 > Classic Worksheet
Maple 16 nebo kliknut́ım na ikonu Classic Worksheet Maple 16 na ploše. Tento zápisńık
Maple je určen předevš́ım pro méně výkonné poč́ıtače s omezenou pamět́ı. Neposkytuje také
všechny funkce, př́ıkazy a možnosti systému Maple jako Standard Worksheet [5].

6Palety se automaticky zobrazuj́ı v levém bloku. Prostřed́ı systému nab́ıźı blok pro palety i po pravé
straně obrazovky (automaticky zavřený), kam je možné některé (ale i všechny) přesunout.
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Obrázek 1.2: Prostřed́ı Classic Worksheet v Maple 14 (převzato z [5]).

1.1.3 Př́ıkazový řádek a kalkulačka Maple

Se systémem Maple můžeme pracovat i pouze v režimu tzv. př́ıkazového řádku spustitelného
ze startovaćıho menu poč́ıtače výběrem položky Programy > Maple 16 > Command-
line Maple 16. Př́ıkazový řádek je určen k řešeńı rozsáhlých a složitých úloh. K dispozici
přitom nejsou žádné grafické prvky.

Obrázek 1.3: Maple 16: Př́ıkazový řádek.

Dále je možné použ́ıvat (a vytvářet) tzv. maplety, tj. grafická uživatelská rozhrańı ob-
sahuj́ıćı okénka, textová pole a daľśı vizuálńı prvky umožňuj́ıćı pouhým klikáńım spouštět
výpočty. Kalkulačka systému Maple je speciálńı typ mapletu, který je k dispozici pouze
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pro operačńı systémy Windows. Spoušt́ı se ze startovaćıho menu poč́ıtače, kde se vybere
Programy > Maple 16 > Maple Calculator [5].

1.1.4 Document Mode, Worksheet Mode

Dále se budeme věnovat pouze rozš́ı̌renému prostřed́ı Standard Worksheet. V tomto prostřed́ı
je možné pracovat ve dvou základńıch režimech: Worksheet Mode a Document Mode. Prvně
jmenovaný odpov́ıdá prostřed́ı Classic Worksheet, v němž je každý př́ıkaz Maple uvozen sym-
bolem [> a muśı být ukončen středńıkem (výsledek se zobraźı na daľśım řádku uprostřed)
nebo dvojtečkou (výsledek se nezobraźı). Otev́ırá se v hlavńım menu zvoleńım File > New
> Worksheet mode. Document Mode poskytuje přehledněǰśı zápis př́ıkaz̊u a matema-
tických vzorc̊u bez

”
přebytečných“ symbol̊u. Při otevřeńı nového souboru z nástrojové lǐsty

je automaticky spuštěn právě tento režim, jinak je možné jej též otevř́ıt z hlavńıho menu
v položce File > New.

Obvykle je zápisńık nastaven do jednoho režimu7, který je možné zvolit při otev́ıráńı
nového souboru v hlavńım menu (File > New > ...). Existuje však i možnost přeṕınat
mezi režimy v rámci jednoho zápisńıku, kdy je část vytvořena v jednom režimu, část v jiném.
Z Document Mode se přepneme do Worksheet Mode kliknut́ım na ikonku [> v nástrojové
lǐstě. Naopak z Worksheet Mode se do režimu Document Mode přepneme výběrem položky
v hlavńım menu (Format > Create Document block) [5].

Obrázek 1.4: Režimy zápisu (převzato z [5]).

1.1.5 Math Mode, Text Mode

Pro rozlǐseńı př́ıkaz̊u a obyčejného textu slouž́ı kontextová lǐsta zápisńıku, kde máme na
výběr Text Mode a Math Mode. Math Mode odpov́ıdá př́ıkaz̊um (po stisku klávesy Enter
dojde k vyhodnoceńı), v Text Mode ṕı̌seme texty dokumentu podobně jako např. v textovém
editoru (po stisku klávesy Enter přejdeme na nový řádek bez jakéhokoli vyhodnoceńı). Volit
režim zápisu můžeme bud’ kliknut́ım myši (v kontextové lǐstě nad dokumentem jsou uvedeny

7Ten zpravidla voĺıme při prvńım spuštěńı po instalaci systému nebo jej můžeme následně nastavit
v hlavńım menu: Tools > Options... > Interface.

9



názvy představuj́ıćı jednotlivé možnosti) nebo výběrem položky v hlavńım menu (Edit >
Switch to Text/Math Mode). Totéž lze rychleji provést klávesou F5.

V režimu Worksheet Mode lze pro text i pro př́ıkazy použ́ıt oba druhy zápisu. Pro psańı
textu je nutné kliknout na ikonku T v nástrojové lǐstě nebo zvolit položku v hlavńım menu
(Insert > Text). Podobně pro zápis př́ıkaz̊u jazyka Maple je nutné kliknout na ikonku [>
v nástrojové lǐstě nebo zvolit položku v hlavńım menu (Insert > Maple Input). Při otevřeńı
nového souboru je zápisńık automaticky nastaven na psańı př́ıkaz̊u.

K př́ıkaz̊um máme dále možnost zapisovat komentáře uvedeńım symbolu mř́ıžky (#)
před text, který má být komentářem (viz obrázek 1.5) [5].

Obrázek 1.5: Zápis komentáře v př́ıkazovém režimu (převzato z [5]).

1.2 Základńı ovládáńı systému

Již v́ıme, jak spustit systém Maple a jak zvolit pracovńı prostřed́ı, které chceme. Otevř́ıt
již vytvořený program můžeme z hlavńıho menu (File > Open...) nebo spuštěńım pro-
gramu rovnou z operačńıho systému (prostřednictv́ım nějakého souborového manažeru).
Když chceme vytvořený dokument uložit, zvoĺıme položku File > Save (resp. File >
Save As...) v hlavńım menu systému Maple. Dokumenty prostřed́ı Standard Worksheet
maj́ı př́ıponu mw, dokumenty prostřed́ı Classic Worksheet př́ıponu mws. V prostřed́ı Stan-
dard Worksheet je možné otevř́ıt oba typy soubor̊u, v prostřed́ı Classic Worksheet pouze typ
mws.

Maple poskytuje také možnost exportovat dokumenty jako soubory jiných typ̊u. Pod-
porovány jsou typy: HTML, PDF, LaTeX, Maple Input, Maplet, Maple Text, Plain Text,
Maple T.A. a Rich Text Format. Pro export dokumentu vybereme položku Export As...
ze záložky File v hlavńım menu.

Nyńı si ukážeme, jak v Document Mode zadávat jednoduché př́ıkazy. Budeme proto
předpokládat, že zápisńık je již nastaven pro psańı př́ıkaz̊u (Math Mode).

Základńı operace: pro sč́ıtáńı použ́ıváme symbol plus (+), pro odč́ıtáńı mı́nus (–), pro násobeńı
(*), ale pozor, pro děleńı muśıme použ́ıvat pouze lomı́tko (/), dvojtečka (:) má jiný význam
(viz dále).

Zadáńı zlomku: zadáme čitatel, lomı́tko (/) a jmenovatel. Pro opuštěńı zápisu jmenovatele
stač́ı stisknout šipku doprava (ve zlomku je též možno pohybovat se šipkami).

Zadáńı mocniny: zadáme základ, symbol stř́ı̌ska (ˆ) a exponent. Pro opuštěńı zápisu ex-
ponentu je opět možné použ́ıt šipku doprava.
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1.2.1 Vyhodnoceńı př́ıkaz̊u

Př́ıkaz vyhodnot́ıme stiskem klávesy Enter. Výsledek se zobraźı na daľśım řádku uprostřed.
V dř́ıvěǰśıch verźıch (méně než 10) systému Maple bylo nutné př́ıkaz ukončovat středńıkem,
aby se provedl. Tato možnost nadále z̊ustala (tj. zadáme-li za př́ıkaz středńık,

”
nic nepo-

kaźıme“) a v některých situaćıch je dokonce jediná možná – např. textový režim (Text Mode)
př́ıkaz̊u v Worksheet Mode nebo při psańı př́ıkaz̊u v prostřed́ı Classic Worksheet. Z předešlých
verźı Maple se uchovala i funkcionalita symbolu dvojtečka (:), která po zařazeńı za př́ıkaz
a následného stisku klávesy Enter potlač́ı zobrazeńı výsledku na daľśım řádku (tj. př́ıkaz
se vyhodnot́ı, ale na obrazovku se nic nevyṕı̌se). Proto neńı možné dvojtečku použ́ıvat jako
operátor děleńı. V Document Mode je nav́ıc možné zapisovat př́ıkaz i s výsledkem na jeden
řádek. Po napsáńı př́ıkazu k tomu stač́ı namı́sto stisku klávesy Enter použ́ıt klávesovou
zkratku

”
Ctrl + =“.

Obrázek 1.6: Palety.

Jak bylo zmı́něno dř́ıve, interaktivńı dokumenty v Maple jsou

”
živé“. T́ım máme na mysli skutečnost, že i v dř́ıve vytvořeném doku-

mentu s vyhodnocenými př́ıkazy otevřeném po libovolně dlouhé době
můžeme kterýkoli výraz upravit, znovu vyhodnotit (stisknout En-
ter nebo

”
Ctrl + =“) a dostaneme nový výsledek. Označ́ıme-li myš́ı

několik (libovolně mnoho) př́ıkaz̊u a stiskneme ikonku ! (vykřičńık)
z nástrojové lǐsty, všechny označené př́ıkazy budou postupně vyhod-
noceny. K vyhodnoceńı všech př́ıkaz̊u v dokumentu slouž́ı ikonka
!!! (tři vykřičńıky).

Maple obsahuje v́ıce než tiśıc symbol̊u, pomoćı nichž můžeme
tvořit matematické výrazy a typograficky kvalitńı text. Patř́ı mezi
ně ṕısmena a č́ıslice, jimiž vytvář́ıme jména (posloupnost znak̊u
zač́ınaj́ıćı ṕısmenem, za kterým může následovat kombinace ṕısmen,
č́ısel a vybraných symbol̊u), reálná č́ısla (celá, racionálńı, iracionálńı,
s desetinou tečkou nebo v notaci pohyblivé řádové čárky), komplexńı
č́ısla, aritmetické, booleovské a jiné operátory (+, –, !, /, *,

∫
, lim, . . .

), konstanty (π, e, . . . ), imaginárńı jednotku, nekonečno, matema-
tické funkce (cos(x), sin(π

3
), . . . ) a proměnné (pojmenované jménem

. . . ). Velkou přednost́ı systému Maple je jeho schopnost symbo-
lických matematických výpočt̊u. Některé z matematických symbol̊u,
které můžeme použ́ıt, nejsou na klávesnici, a tak se zadávaj́ı bud’

z palety nebo pomoćı svých názv̊u [5].

1.2.2 Palety

Palety jsou pojmenované
”
obdélńıčky“ s nab́ıdkou předdefinovaných

symbol̊u, zápis̊u, výraz̊u apod. (obrázek 1.6), zpravidla při levém
okraji zápisńıku. Každá paleta obsahuje symboly př́ıslušné sku-
piny. Např́ıklad paleta s názvem Expression nab́ıźı některé základńı
matematické výrazy, paleta Greek ṕısmena řecké abecedy atd.
Standardně z̊ustává několik palet nezobrazených. V hlavńım menu
(View > Palettes) můžeme seznam zobrazených palet upravit t́ım,
že některé přidáme, odebereme, ale třeba i jinak seřad́ıme. Totéž lze
provést jen za pomoci myši. Přidržeńım levého tlač́ıtka vybranou pa-
letu přesuneme na jiné mı́sto, stisknut́ım pravého tlač́ıtka vyvoláme
stejnou nab́ıdku, jako bychom postupovali přes hlavńı menu. Kliknut́ı levého tlač́ıtka myši na
některou z palet zobraźı (př́ıp. skryje) symboly, které paleta nab́ıźı. Vložit z palety symbol
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do zápisńıku pak stač́ı pouhým kliknut́ım, př́ıpadně
”
přetáhnut́ım“ s pomoćı levého tlač́ıtka

myši. Obecné barevně zvýrazněné symboly ve výrazu je možné dále specifikovat (upravovat)
dosazeńım hodnoty, s ńıž potřebujeme pracovat [5].

Př́ıklad 1.1: Vložte do dokumentu výraz
10∑
i=1

2i.

Řešeńı: Pro zapsáńı zadaného výrazu potřebujeme celkem dva r̊uzné symboly: sumu
a mocninu. Sumačńı symbol nalezneme v paletě Expression. Kliknut́ım na tuto paletu
ji otevřeme (na obrázku 1.6 je jako jediná otevřená) a vybereme z ńı př́ıtomný sumačńı
symbol. Po jeho vložeńı do zápisńıku pak jednoduše přeṕı̌seme obecné symboly (k, n a f)
požadovanými hodnotami. Pohybovat ve vzorci se můžeme pomoćı šipek na klávesnici,
s výhodou lze využ́ıt klávesy Tab, přitom k úpravě výrazu můžeme použ́ıvat i všechny
ostatńı klávesy jako např. Delete, Backspace, mezerńık, ... Znak f přeṕı̌seme mocninným
výrazem. To můžeme provést bud’ vložeńım daľśıho symbolu z palety Expression (symbol
ab) a následnou úpravou (specifikaćı hodnot a, b), nebo užit́ım již známé klávesy pro tvorbu
mocnin – stř́ı̌sky (ˆ).

Př́ıklad 1.2: Vložte do dokumentu výraz
∞∑
i=1

1
i
.

Př́ıklad 1.3: Vložte do dokumentu výraz
∣∣∣323−642

17·24

∣∣∣.
Př́ıklad 1.4: Vložte do dokumentu výraz

√
ln(e5)!·sin( 17·π

2
)−3·13√

log2(16)−1
.

1.2.3 Názvy symbol̊u

Mimo palet můžeme k zápisu symbol̊u už́ıvat jejich názv̊u. Např́ıklad symbol π vlož́ıme
zapsáńım jeho názvu Pi8, pro odmocninu je vyhrazen název sqrt, takže

√
x vlož́ıme napsáńım

sqrt(x). Při vkládáńı symbol̊u pomoćı názv̊u nebo při tvorbě př́ıkaz̊u se může hodit funkce

”
dokončováńı“. Pro zadáńı symbolu pak stač́ı napsat jeho úvodńı ṕısmeno (ṕısmena) a po-

moćı klávesy Esc nebo kláves
”
Ctrl + mezerńık“ následně z vyskakovaćıho okénka zvolit

požadovaný př́ıkaz. Na obrázku 1.7 je ukázka nab́ıdky pro dokončeńı zápisu ṕısmen so [5].

Př́ıklad 1.5: Vložte do dokumentu výraz
∣∣∣323−642

17·24

∣∣∣ bez použit́ı palet.

Řešeńı: Pro absolutńı hodnotu z požadovaného výrazu použijeme př́ıkaz abs, při zadáváńı
mocnin využijeme symbolu stř́ı̌sky (ˆ). Výsledný zápis zadaného výrazu tedy bude:
abs((32^3-64^2)/(17*2^4)).

Př́ıklad 1.6: Vložte do dokumentu výraz

√
ln(e5)!·sin( 17·π

2
)−3·13√

log2(16)−1
bez použit́ı palet.

8Maple rozlǐsuje malá a velká ṕısmena. Např́ıklad zápis Pi představuje Ludolfovo č́ıslo π i s jeho hodnotou,
zat́ımco zápis pi představuje pouze symbol (řecké ṕısmeno) π.
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Obrázek 1.7: Funkce automatického dokončováńı (převzato z [5]).

1.3 Nápověda

Významnou součást́ı systému Maple je jeho nápověda. K dispozici je několik r̊uzných typ̊u
nápovědy, které nejlépe najdeme v hlavńım menu v nab́ıdce Help. Základńı stránky nápovědy
zobraźıme výběrem položky Maple Help9.

Vyhledávat v nápovědě můžeme bud’ zadáńım hledaného textu do textového pole v levé
horńı části okna (na obrázku 1.8 je v tomto poli zapsán text abs), nebo tematickým vy-
hledáváńım v připravené stromové struktuře témat v levé části okna (na obrázku 1.8 je roz-
balena Matematika a v ńı téma Calculus, tedy Matematická analýza). Odkliknut́ım zadaného
slova abs v textovém vyhledávaćım poli nápovědy zobraźıme v hlavńı části okna nápovědu
právě k př́ıkazu abs. Jak můžeme vidět na obrázku 1.8, nápověda obsahuje základńı popis
př́ıkazu, obecný zápis př́ıkazu pro jeho použit́ı a konkrétńı ukázkové př́ıklady.

1.3.1 Tour of Maple, Quick Reference, Quick Help

Nab́ıdka Help hlavńıho menu poskytuje ještě několik jiných forem nápovědy. Položka Take
a Tour of Maple zobraźı interaktivńı přehled systému (jeho nejd̊uležitěǰśıch prvk̊u). Klik-
nut́ı na Quick Reference otevře tabulku informaćı o ovládáńı systému Maple, zejména pro
nové uživatele. Jedná se o základńı informace s odkazy do nápovědy Maple Help pro je-
jich př́ıpadné doplněńı. Položka Quick Help nab́ıźı ještě stručněǰśı tabulku než předchoźı
nápověda. Standardně se objevuje v každém novém zápisńıku při pravé straně v podobě
černého okénka (pokud toto nastaveńı nezruš́ıme). Po zavřeńı je možné ji vyvolat stiskem
klávesy F1, či jako položku v hlavńım menu [5].

1.3.2 What’s New, Startup Dialog

Daľśımi druhy nápovědy jsou přehled rozš́ı̌reńı stávaj́ıćı verze Maple oproti předcházej́ıćı verzi
(dostupné přes Help > What’s New) a tzv. Startup Dialog obsahuj́ıćı tipy pro práci
se systémem Maple. Startup Dialog se zobrazuje vždy po spuštěńı systému (pokud toto
nastaveńı nezruš́ıme) [5].

9Pro vyvoláńı této nápovědy můžeme také použ́ıt klávesovou zkratku
”
Ctrl + F1“, nebo posledńı ikonku

nástrojové lǐsty.
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Obrázek 1.8: Hlavńı nápověda systému Maple.

1.3.3 Manuals, Resources, and more

Vyvoláńım Manuals, Resources, and more přejdeme do daľśı oblasti nápovědy, z ńıž
poṕı̌seme tři nejd̊uležitěǰśı části.

Maple Portal

Od předcházej́ıćı verze (tedy Maple 13) je k dispozici tzv. Maple Portal. Spustit jej můžeme
samostatně (Maple Portal má vlastńı ikonu na ploše) nebo přes nápovědu v hlavńım menu
(Help > Manuals, Resources, and more > Maple Portal). Maple Portal slouž́ı jako po-
mocńık novým i zkušeněǰśım uživatel̊um hledaj́ıćıch pokročileǰśı nápovědu. Je v něm možné
rychle naj́ıt detailńı popis práce se systémem Maple od řešeńı nejjednodušš́ıch problémů až
po velmi složité úlohy [5].

Applications and Examples

Z nápovědy je možno vyvolat i spustitelné soubory (tj. již vytvořené dokumenty) demon-
struj́ıćı možnosti systému Maple. Otevřeme je přes nápovědu v hlavńım menu (Help >
Manuals, Resources, and more > Applications and Examples) a pak kliknutim na
zvolený př́ıklad [5].

Manuals

Dále je je možné vyvolat anglické manuály User manual, Introductory Programming
Guide, Advanced Programming Guide a Getting Started with Maple Toolboxes
podrobně popisuj́ıćı možnosti systému Maple. Otevřeme je přes nápovědu v hlavńım menu
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Obrázek 1.9: Maple Portal (převzato z [5]).

(Help > Manuals, Resources, and more > Manuals) a pak kliknutim na zvolený
manuál [5].

1.3.4 Pomocńıci, instruktoři a řešené úlohy

Systém Maple poskytuje také již připravené
”
pomocné nástroje“ pro řešeńı úloh. Jsou to tzv.

Pomocńıci (Assistants), Instruktoři (Tutors) a Úlohy (Tasks), které vyvoláme z hlavńıho
menu (Tools > Assistants nebo Tools > Tutors anebo Tools > Tasks). Pomocńıci (As-
sistants) obsahuj́ı např́ıklad nástroje pro hledáńı funkčńı závislosti v datech, optimalizaci
funkćı, řešeńı diferenciálńıch rovnic a daľśı. Pro daný typ úlohy maj́ı implementováno několik
často použ́ıvaných algoritmů. Po vyvoláńı provedou uživatele nastaveńım a specifikaćı pa-
rametr̊u úlohy a zvolenou metodou úlohu vyřeš́ı. Instruktoři (Tutors) provedou uživatele
řešenou problematikou pomoćı jednoduchých názorných př́ıklad̊u. Úlohy (Tasks) zobrazuj́ı
na př́ıkladech, jak řešit r̊uzné úlohy. Zobraźı se vyvoláńım z hlavńıho menu (Tools > Tasks
> Browse) [5].

Od verze Maple 16 najdeme v záložce Tools hlavńıho menu také výukové demonstračńı
dokumenty pod názvem Math Apps. Tyto matematické aplikace byly vytvořeny ke znázorněńı
r̊uzných matematických a fyzikálńıch koncept̊u. Každý z dokument̊u obsahuje stručný popis
př́ıslušného konceptu a některé interaktivńı prvky jako např. tlač́ıtka, posuvńıky,

”
klikatelné“

grafy apod.

1.3.5 Př́ıkaz ? (otazńık)

Symbol ? (otazńık) je daľśım ze zp̊usob̊u zobrazeńı nápovědy. Zapsáńım a provedeńım př́ıkazu
? otevřeme hlavńı stránku nápovědy. Otazńık spolu s názvem př́ıkazu otevře nápovědu na
stránce týkaj́ıćı se zadaného př́ıkazu. Tedy např. př́ıkaz ?evalf otevře hlavńı nápovědu
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systému na stránce popisuj́ıćı syntaxi a sémantiku př́ıkazu evalf spolu s př́ıklady jeho
použit́ı. Zapsáńım dvou otazńık̊u na začátek př́ıkazu otevřeme tutéž stránku nápovědy
ve

”
sbaleném“ tvaru osnovy, v ńıž je možné otevř́ıt (odkrýt) libovolné části. Zadáńım tř́ı

otazńık̊u před př́ıkaz otevřeme nápovědu na př́ıkladech použit́ı tohoto př́ıkazu [5].
Otevř́ıt nápovědu na stránce zadaného př́ıkazu (resp. kĺıčového slova) můžeme též stisk-

nut́ım klávesy F2 (za př́ıtomnosti kurzoru na kĺıčovém slově).

Př́ıklad 1.7: Zjistěte, k čemu slouž́ı př́ıkaz sum a jak se použ́ıvá.

Př́ıklad 1.8: Zjistěte, jak je možné v systému Maple pracovat s vektory a maticemi.

1.4 Prováděńı výpočt̊u

Maple provád́ı přesně numerické výpočty s celými, racionálńımi i iracionálńımi č́ısly. Každý
zadaný matematický výraz se snaž́ı zjednodušit (např. zlomek zkrátit a převést na základńı
tvar, upravit algebraický výraz, . . . ), ale ne za cenu ztráty přesnosti. To znamená, že např́ıklad
racionálńı č́ısla (zlomky) udržuje stále v jejich základńım tvaru. Podobně s konstantami π,
e a daľśımi, s odmocninami a jinými výrazy pracuje jako se symboly. T́ımto je zaručena
absolutńı přesnost výpočt̊u i v př́ıpadě, kdy nepracujeme pouze s celými č́ısly [5].

Jsou však situace, kdy potřebujeme znát přibližnou hodnotu reálného nebo racionálńıho
č́ısla v pohyblivé řádové čárce. K tomu slouž́ı př́ıkaz evalf, jenž vrát́ı zaokrouhlenou hod-
notu svého argumentu na počet platných cifer mantisy specifikovaný systémovou proměnnou
Digits. Ta je standardně nastavena na hodnotu 10. Všechny výpočty, při nichž je nutné za-
okrouhlovat č́ısla, provád́ı proto Maple s přesnost́ı na 10 platných mı́st. Proměnnou Digits

můžeme nastavit na takřka libovolné přirozené č́ıslo. Omezeńı, jak vysoké toto č́ıslo může
být, zjist́ıme př́ıkazem kernelopts(maxdigits). Pro představu uved’me, že pro Maple 14
je toto č́ıslo 268 435 448, tedy v́ıce než 268 milion̊u platných cifer, s kterými dokáže systém

”
teoreticky“10 poč́ıtat [5].

Obrázek 1.10: Př́ıkaz evalf (převzato z [5]).

Aniž bychom měnili nastaveńı proměnné Digits, můžeme zobrazit libovolný výraz s požadovanou
přesnost́ı pouze pomoćı př́ıkazu evalf. Př́ıkaz je možné použ́ıt s jedńım nebo dvěma pa-
rametry. Jediný zadaný parametr znamená, že tento zadaný výraz bude vyhodnocen na

10Výpočet se s rostoućım počtem platných mı́st prodlužuje a je pamět’ově náročněǰśı, což zp̊usobuje prak-
tickou nepoužitelnost pro vyšš́ı počet (závislý na typu úlohy) cifer.
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počet platných mı́st specifikovaný v proměnné Digits. Přidaný druhý parametr řekne funkci
evalf, na kolik platných mı́st má výraz vyhodnotit, viz př́ıklady na obrázku 1.10 [5].

Maple rozeznává přesná č́ısla (mezi něž patř́ı i zmı́něné symboly π a e, zlomky atp.)
a č́ısla typu Floating-Point, nebo-li č́ısla v pohyblivé řádové čárce. Jestliže systému zadáme
výraz, v němž některý z jeho podvýraz̊u bude typu Floating-Point, může Maple na celý
výraz pohĺıžet jako by byl tohoto typu a bude výsledky výpočt̊u zaokrouhlovat. To nejlépe
uvid́ıme na daľśıch př́ıkladech na obrázku 1.11 [5].

Obrázek 1.11: Přesná č́ısla a č́ısla typu Floating-Point (převzato z [5]).

1.4.1 Př́ıkazy

Pro provedeńı výpočtu máme zpravidla v́ıce možnost́ı. Tou základńı, která je k dispo-
zici ve všech verźıch systému, jsou př́ıkazy jazyka Maple. Chceme-li např́ıklad vypoč́ıtat
odmocninu z č́ısla 2,5, zaṕı̌seme v systému Maple př́ıkaz sqrt(2.5). Stejného výsledku
dosáhneme použit́ım symbolu pro odmocninu z palety Expression. Pokud chceme určit
nejmenš́ı společný násobek č́ısel 10, 12 a 15, můžeme využ́ıt př́ıkazu lcm, nebo zapsat č́ısla
na řádek za sebe (oddělená čárkami) a přes pravé tlač́ıtko myši zvolit z kontextové nab́ıdky
Apply Function > Least Common Multiple, viz obrázky 1.12, 1.13 [5].

Obrázek 1.12: Provedeńı výpočtu pomoćı kontextové nab́ıdky (převzato z [5]).
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Obrázek 1.13: Různé možnosti provedeńı výpočtu (převzato z [5]).

Př́ıklad 1.9: Zobrazte č́ıslo π s přesnost́ı na pět desetinných mı́st.
Řešeńı: Pro zobrazeńı přibližné (zaokrouhlené) hodnoty s požadovanou přesnost́ı využ́ıváme

př́ıkazu evalf. Funkci evalf dáme jako prvńı argument výraz, jehož přibližnou hodnotu
chceme určit (tj. π). Druhý argument bude specifikovat počet platných mı́st. Jelikož chceme,
aby počet desetinných mı́st byl roven pěti, počet platných mı́st nastav́ıme na 6. Źıskáme tak
výsledek na obrázku 1.14.

Obrázek 1.14: Řešeńı př́ıkladu 1.9.

Př́ıklad 1.10: Zobrazte Eulerovo č́ıslo s přesnost́ı na dvě desetinná mı́sta.

Př́ıklad 1.11: Vypoč́ıtejte, kolik je 1− 1.0
3.0
− 1.0

3.0
− 1.0

3.0
. Proč neńı výsledek roven 0?

1.4.2 Označeńı výsledk̊u

Každému zobrazenému výsledku se v zápisńıku přǐrazuje č́ıselné označeńı, které se zapisuje
zcela vpravo na řádek s odpov́ıdaj́ıćım výsledkem. Označeńı je možné potlačit (tj. nezobra-
zovat), znovu vyvolat, př́ıpadně upravit jeho formát v hlavńım menu (Format > Equation
Labels > ...). Dı́ky označeńı se můžeme na předešlé výsledky odvolávat a použ́ıvat je
při tvorbě daľśıch př́ıkaz̊u. V ukázkách vytvořených dokument̊u (prezentovaných v tomto
textu) je označeńı výsledk̊u vždy potlačeno. Použit́ı označeńı ilustruje obrázek 1.15.

Pokud chceme např́ıklad přič́ıst č́ıslo 10 k výsledku s označeńım (2), pak naṕı̌seme
”
10

+ “ a přes klávesovou zkratku
”
Ctrl + L“ vlož́ıme požadované označeńı (tedy do

”
vyska-

kuj́ıćıho okénka“ zadáme č́ıslo 2 a potvrd́ıme (OK)). Mı́sto klávesové zkratky
”
Ctrl + L“

je možné použ́ıt horńı menu (Insert > Label. . . ). Pozor, zápis (2) vytvořený (pouze)
na klávesnici při tvorbě př́ıkazu Maple nepochoṕı, pro vložeńı označeńı do př́ıkazu je třeba
d̊usledně použ́ıvat předešlý postup s

”
vyskakuj́ıćım okénkem“ zobrazeným na obrázku 1.16

[5].
Maple dále nab́ıźı možnost odkazovat se na posledńı tři výsledky (v tomto př́ıpadě je

jedno, zda byly zobrazeny či nikoliv, a zda maj́ı nějaké označeńı) pomoćı symbolu % (pro-
cento). Jedno procento (%) představuje posledńı výsledek, dvě procenta (%%) předposledńı
a tři procenta (%%%) před-předposledńı. Upozorněme, že výsledek źıskaný těmito př́ıkazy
záviśı na pořad́ı vykonaných př́ıkaz̊u, ne na jejich umı́stěńı v zápisńıku! Tedy např. % vyṕı̌se
posledńı výsledek źıskaný předchoźım (časově) vykonaným př́ıkazem (obrázek 1.17).
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Obrázek 1.15: Označeńı výsledk̊u (převzato z [5]).

Obrázek 1.16:
”
Vyskakuj́ıćı okénko“ pro zadáńı označeńı (převzato z [5]).

Obrázek 1.17: Využit́ı procent při odkazováńı se na předchoźı výsledky (převzato z [5]).
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1.4.3 Přǐrazeńı hodnot do proměnných

Odkazovat se na výrazy můžeme také po jejich přǐrazeńı k nějaké proměnné. Operátorem
přǐrazeńı je (dvoj)symbol := (dvojtečka + rovńıtko).

Namı́sto (dvoj)symbolu := můžeme k přǐrazeńı použ́ıt př́ıkaz assign. Tak, jak můžeme
výrazy do proměnných přǐrazovat, můžeme též přǐrazeńı zrušit (tj. odebrat proměnné uloženou
hodnotu). Zmı́něné provedeme př́ıkazem unassign nebo přǐrazeńım názvu proměnné v apo-
strofech (obrázek 1.18).

Obrázek 1.18: Přǐrazeńı hodnot do proměnných a odstraněńı uložené hodnoty (převzato z [5]).

Přǐrazovat hodnoty můžeme i do tzv. systémových proměnných. Již jsme se setkali
s proměnnou Digits vyjadřuj́ıćı počet platných mı́st, s nimiž Maple poč́ıtá. Ilustraci na obrázku
1.19 můžeme srovnat s obrázkem 1.10.

Obrázek 1.19: Proměnná Digits a př́ıkaz evalf (převzato z [5]).

Odstranit uloženou hodnotu v systémové proměnné nelze. Do systémových proměnných
můžeme hodnoty pouze přǐrazovat, nebo vrátit př́ıkazem restart nastaveńı všech systémových
proměnných na jejich p̊uvodńı hodnoty. Provedeńı př́ıkazu odstrańı všechny uložené hodnoty
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v paměti (tedy i námi definované proměnné, načtené baĺıky atd.). Př́ıkaz restart se proto
použ́ıvá zpravidla na počátku řešeńı nové úlohy, zejména pak na začátku každé práce se
zápisńıkem (aby se předešlo tomu, že budeme použ́ıvat proměnnou, v ńıž je z dř́ıvěǰska
uložena pro nás nesprávná hodnota) [5].

1.4.4 Baĺıky

Knihovna př́ıkaz̊u jazyka Maple je rozdělena na hlavńı knihovnu a tzv. baĺıky11. Př́ıkazy,
s nimiž jsme se doposud setkali, patř́ı do hlavńı knihovny, a můžeme je tak použ́ıvat ihned
po spuštěńı systému. Naproti tomu většina speciálńıch př́ıkaz̊u nálež́ı do baĺık̊u, které muśıme
před použit́ım př́ıslušného př́ıkazu bud’ nač́ıst do dokumentu pomoćı př́ıkazu with, nebo za-
dat př́ıkaz spolu s názvem baĺıku. Načteńı baĺıku pomoćı př́ıkazu with umožńı použ́ıváńı
všech př́ıkaz̊u z př́ıslušného baĺıku. Naopak zadáńı př́ıkazu spolu s názvem baĺıku je nutné
provádět při každém použit́ı tohoto př́ıkazu, pokud baĺık nenačteme (př́ıkazem with).

Načteńı baĺıku můžeme zrušit př́ıkazem unwith. Pokud baĺık nenačteme a použijeme
z něj nějaký př́ıkaz, Maple jej nerozpozná a př́ıkaz vyṕı̌se jako textový řetězec. Např́ıklad
př́ıkazy pro práci s vektory a maticemi nálež́ı do baĺıku LinearAlgebra. Jestliže chceme
tedy použ́ıt př́ıkaz Eigenvalues pro nalezeńı vlastńıch č́ısel matice, načteme nejprve baĺık
LinearAlgebra, jak dokumentuje obrázek 1.20 [5].

Obrázek 1.20: Použit́ı baĺık̊u.

11Kromě pojmu baĺık se v češtině použ́ıvá také termı́n knihovna.
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Jedńım z významných baĺık̊u je baĺık s názvem RealDomain. Systém Maple pracuje s
komplexńımi č́ısly a právě baĺık RealDomain umožňuje omezit se pouze na množinu reálných
č́ısel12 (obrázek 1.21).

Obrázek 1.21: Použit́ı baĺıku RealDomain.

Jednotky

Práci s jednotkami umožňuje baĺık Units. Při výpočtech tak nemuśıme pracovat jen s č́ısly,
ale můžeme jim přǐrazovat i jednotky. K vložeńı jednotek do zápisńıku využijeme palety
Units. Obrázek 1.22 ilustruje použit́ı jednotek při výpočtu gravitačńı śıly p̊usob́ıćı v t́ıhovém
poli Země (kde gravitačńı zrychleńı je přibližně rovno 9,81 ms−2) na těleso o hmotnosti
10 kg. Vid́ıme, že Maple umı́ jednotky také zjednodušovat (resp. upravovat na jiný tvar).
Ke zjednodušeńı výraz̊u přitom slouž́ı př́ıkaz simplify.

Obrázek 1.22: Použit́ı jednotek (převzato z [5]).

Maple rozpoznává jednotky r̊uzných soustav a velikost́ı, s nimiž umı́ pracovat a vzájemně
je převádět. Pro převod jednotek je k dispozici speciálńı nástroj zvaný Units Calculator.
Spustit jej můžeme z hlavńıho menu přes Tools > Assistants > Units Calculator....
Ukázku poskytuje obrázek 1.23.

Pokud chceme použ́ıt jednotku, která neńı v paletě Units, můžeme si ji vytvořit sami
tak, že přidáme jednotku s názvem unit a název přeṕı̌seme. V systému Maple 16 je imple-
mentováno přes 500 jednotek (tzn. v paletě Units je pouze několik vybraných) [5].

12Úplný seznam př́ıpad̊u (resp. př́ıkaz̊u), v nichž se můžeme pomoćı tohoto baĺıku omezit jen na reálná
č́ısla, nalezneme v nápovědě k baĺıku RealDomain
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Obrázek 1.23: Units Calculator (převzato z [5]).

1.4.5 Řešeńı rovnic

K řešeńı rovnic v systému Maple slouž́ı př́ıkaz solve a několik př́ıkaz̊u k němu př́ıbuzných
závislých na typech rovnic, viz tabulka 1.1.

Tabulka 1.1: Př́ıkazy pro řešeńı rovnic

Typ rovnice Př́ıkaz pro řešeńı
Rovnice a nerovnice solve, fsolve
Obyčejné diferenciálńı rovnice dsolve

Parciálńı diferenciálńı rovnice pdsolve

Rovnice v oboru celých č́ısel isolve

Rovnice v oboru celých č́ısel v konečném tělese msolve

Lineárńı integrálńı rovnice intsolve

Systémy lineárńıch rovnic LinearAlgebra[LinearSolve]

Rekurentńı rovnice rsolve

Pomoćı interaktivńıho prostřed́ı Standard Worksheet můžeme řešit rovnice též pomoćı
kontextové nab́ıdky. Zaṕı̌seme rovnici a pravým tlač́ıtkem myši zvoĺıme požadovaný př́ıkaz.
Obrázek 1.24 ilustruje některé př́ıklady řešeńı rovnic.

Př́ıkazy pro řešeńı rovnic nemuśı vždy zobrazit všechna řešeńı. Pokud je chceme zobrazit,
přidáme př́ıkazu solve nepovinný parametr AllSolutions, viz obrázek 1.25 [5].

Symbol Z2∼ na obrázku 1.25 představuje libovolnou celoč́ıselnou proměnnou. Že jde
o celoč́ıselnou proměnnou poznáme podle toho, že se v symbolu vyskytuje ṕısmeno Z. Po-
dobně by výskyt např́ıklad ṕısmena C značil proměnnou komplexńı. Cifra 2 v symbolu
proměnné označuje pořad́ı, v jakém byla proměnná v zápisńıku zavedena. A nakonec znak
∼ vyjadřuje, že proměnná splňuje nějaký předpoklad. Jaké předpoklady proměnná splňuje
přitom zjist́ıme př́ıkazem about, př́ıpadně zápisem proměnné a po kliknut́ı pravým tlač́ıtkem
myši zvoleńım What Assumptions z kontextové nab́ıdky. V zobrazeném př́ıkladu na
obrázku 1.25 je předpoklad celoč́ıselnosti (u již celoč́ıselné) proměnné přebytečný.
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Obrázek 1.24: Ukázka řešeńı r̊uzných druh̊u rovnic použit́ım jednak př́ıkazu, jednak kontextové
nab́ıdky (převzato z [5]).

Obrázek 1.25: Zobrazeńı všech řešeńı rovnice (převzato z [5]).

Dále může př́ıkaz solve zobrazit výsledek se strukturou RootOf vyjadřuj́ıćı kořen (tj. řešeńı)
rovnice v nevyhodnoceném tvaru. Řešeńı pak vyhodnot́ıme bud’ př́ıkazem allvalues (pro
symbolické vyjádřeńı), nebo př́ıkazem evalf (pro numerické vyjádřeńı) – obrázek 1.26. Ve-
dle př́ıkaz̊u můžeme též využ́ıt pravého tlač́ıtka myši, zvolit z kontextové nab́ıdky položku
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All Values (pro symbolické vyjádřeńı) a źıskaný výsledek převést na numerickou hodnotu
zvoleńım Approximate > 10 (pro 10 platných mı́st) z kontextové nab́ıdky.

Obrázek 1.26: Tvar zobrazeńı řešeńı rovnice (převzato z [5]).

Obrázek 1.27: Proměnná infolevel a
”
prázdný výpis“ př́ıkazu solve (převzato z [5]).

Symboly Z ve struktuře RootOf nyńı nepředstavuj́ı celoč́ıselnou proměnnou (nebot’ za
ṕısmenem Z nenásleduje č́ıslo), nýbrž proměnnou libovolnou (tj. i komplexńı).

Systém Maple po zadáńı př́ıkazu vyṕı̌se zpravidla pouze řešeńı, př́ıpadně chybová hlášeńı
či varováńı. U př́ıkazu solve (a nejen u něj) toto chováńı zp̊usobuje

”
prázdný výpis“ v př́ıpadě,

že Maple žádné řešeńı nenašel. Pro výpis podrobněǰśıch informaćı o pr̊uběhu vyhodnoceńı
př́ıkazu a výsledćıch slouž́ı proměnná infolevel. Můžeme ji nastavit bud’ pro každý př́ıkaz
samostatně, přičemž do hranatých závorek za proměnnou vlož́ıme název př́ıslušného př́ıkazu,
nebo ji nastav́ıme všem př́ıkaz̊um současně na stejnou hodnotu uvedeńım slova all do hra-
natých závorek. Proměnná může nabývat hodnot 1, 2, ..., 5. Č́ım vyšš́ı hodnota je přǐrazena
v proměnné infolevel, t́ım v́ıce informaćı o vyhodnoceńı př́ıkazu obdrž́ıme. Standardně
neńı proměnná nastavena na žádnou hodnotu, což v podstatě odpov́ıdá nastaveńı proměnné
na hodnotu 0. Použit́ı proměnné infolevel dokumentuj́ı obrázky 1.27 a 1.28 [5].

Př́ıklad 1.12: Řešte nerovnici: |x− 2| < 1 pro x ∈ R.
Řešeńı: Pro řešeńı nerovnice použijeme př́ıkaz solve. Źıskaný výsledek odpov́ıdá zápisu

x ∈ (1, 3). Výraz RealRange znač́ı reálný interval, výraz Open(1) vyjadřuje otevřený in-
terval (v bodě 1). Pokud bychom zadali argument př́ıkazu solve do složených závorek (tj.
solve({|x-2|<1})), źıskali bychom výsledek ve tvaru nerovnost́ı.
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Obrázek 1.28: Proměnná infolevel a př́ıkaz solve.

Obrázek 1.29: Řešeńı př́ıkladu 1.12.

Př́ıklad 1.13: Řešte nerovnici |x− 2| < 1 pro x ∈ Z.

Př́ıklad 1.14: Řešte nerovnici |x− 2| ≥ 1 pro x ∈ Z.

Př́ıklad 1.15: Určete kořeny polynomu x3 − 3 · x2 − 13 · x+ 15 pro x ∈ R.
Řešeńı: Kořeny polynomu můžeme určit r̊uznými zp̊usoby. Jednak je možné použ́ıt př́ıkaz

solve a hledat body, v nichž je polynom nulový. Systém Maple nab́ıźı též př́ıkaz roots pro
hledáńı kořen̊u polynomu jedné proměnné. Oba postupy ilustruje obrázek 1.30.

Výstup př́ıkazu roots je tvořen seznamem dvojic. Každá dvojice obsahuje hodnotu
kořenu a jeho násobnost.
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Obrázek 1.30: Řešeńı př́ıkladu 1.15.

Př́ıklad 1.16: Řešte nerovnici x ≤ x2 − 12 ≤ 4 · x pro x ∈ R.

Př́ıklad 1.17: Určete obecně kořeny kvadratického polynomu tvaru a · x2 + b · x + c pro
a ∈ R \ {0}, b ∈ R, c ∈ R, x ∈ C. Zamyslete se, jak byste v řešeńı postupovali, kdybychom
povolili možnost a = 0 a x omezili jen na reálná č́ısla.

Př́ıklad 1.18: Řešte rovnici tan(x) =
√

3 pro x ∈ R.

Př́ıklad 1.19: Řešte soustavu rovnic

5 · x− 7 · y = −9,

3 · x+ y = 5

pro x ∈ R, y ∈ R.

27



2 Matematická analýza s Maple v R

2.1 Výrazy a jejich úpravy

2.1.1 Zjednodušeńı výrazu

Ke zjednodušeńı výrazu slouž́ı předevš́ım př́ıkazy simplify, normal a combine. Př́ıkaz
simplify provád́ı základńı zjednodušeńı zadaného výrazu, př́ıkaz normal je určen pro úpravy
zlomk̊u a př́ıkaz combine slučuje výrazy. Vybrané př́ıklady použit́ı můžeme pozorovat na
obrázku 2.1.

Obrázek 2.1: Zjednodušováńı výraz̊u.

2.1.2 Omezuj́ıćı podmı́nky

Př́ıkazu simplify (stejně jako ostatńım př́ıkaz̊um) můžeme doplnit omezuj́ıćı podmı́nky
(resp. předpoklady), které budou aplikovány při zjednodušováńı zadaného výrazu. Prove-
deme to bud’ přidáńım druhého parametru assume = podmı́nka , nebo zápisem assuming
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podmı́nka za př́ıkaz simplify. Jako druhý parametr můžeme uvést také množinu ome-
zuj́ıćıch rovnost́ı. Konkrétńı př́ıklady vid́ıme na obrázku 2.2.

Obrázek 2.2: Zjednodušováńı výraz̊u – daľśı možnosti př́ıkazu simplify.

2.1.3 Úprava polynomu

Předevš́ım pro úpravy polynomů máme k dispozici př́ıkazy collect, coeff, sort, factor
a expand, jejichž použit́ı shrnuje tabulka 2.1 a na př́ıkladech dokumentuj́ı obrázky 2.3, 2.4.

Tabulka 2.1: Př́ıkazy pro úpravy předevš́ım polynomů

Př́ıkaz Použit́ı
collect vytýkáńı ve výrazech (nejen polynomech)
coeff koeficient u zvoleného členu polynomu
sort setř́ıděńı člen̊u polynomu (nebo prvk̊u seznamu)
factor rozklad polynomu na součin kořenových činitel̊u
expand roznásobeńı / rozvinut́ı (nejen u polynomů)

2.1.4 Převod výrazu na jiný tvar

Závěrem této sekce zmı́ńıme velmi univerzálńı př́ıkaz convert. S jeho pomoćı můžeme
převádět zadaný výraz (př́ıpadně jinou datovou strukturu jako např. seznam) na jiný (zvo-
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Obrázek 2.3: Použit́ı př́ıkaz̊u collect, coeff a sort.

Obrázek 2.4: Použit́ı př́ıkaz̊u factor a expand.

lený) tvar1. Obrázky 2.5 a 2.6 ukazuj́ı použit́ı př́ıkazu pro převod desetinného č́ısla na zlomek

1Jelikož má př́ıkaz convert mnoho r̊uzných použit́ı, doporučujeme čtenáři pod́ıvat se na stránku nápovědy
k tomuto př́ıkazu (viz ?convert).
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(přidáváme parametr rational) a pro převod výrazu na parciálńı zlomky (přidáváme para-
metr parfrac2).

Obrázek 2.5: Použit́ı př́ıkazu convert.

Jak jsme již viděli, v prostřed́ı Standard Worksheet je obvykle v́ıce možnost́ı, jak řešit
danou úlohu. U výše uvedených př́ıklad̊u (na obrázćıch 2.1 – 2.6) je možné využ́ıt také
kontextové nab́ıdky. Do dokumentu vlož́ıme výraz, který chceme upravovat, klikneme na
něj pravým tlač́ıtkem myši a z kontextové nab́ıdky zvoĺıme požadovaný př́ıkaz (často i s
upřesněńım požadované úpravy, tj. např. vybereme Simplify>Simplify nebo Combine>exp
či Simplify>Assuming Real atp.). T́ımto zp̊usobem můžeme obdržet např́ıklad výsledky
na obrázku 2.7.

2Symbol I v systému Maple znač́ı imagonárńı jednotku.
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Obrázek 2.6: Možnosti př́ıkazu convert při rozkladu výrazu na parciálńı zlomky.

Obrázek 2.7: Zjednodušováńı výraz̊u pomoćı kontextové nab́ıdky.
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Př́ıklad 2.1: Určete hodnotu výrazu
√
x+b · (a·x−b·x)
y3 · (a−b) pro b = 16, x = 9, y = 3.

Řešeńı: Pro vyřešeńı máme v́ıce možnost́ı. Použijme nejprve př́ıkaz simplify podobně
jako na obrázku 2.2. Může se stát, že př́ıkaz neuprav́ı

”
najednou“ zadaný výraz až na nej-

jednodušš́ı tvar. V takovém př́ıpadě (který právě nyńı nastane) jej použijeme dvakrát. Daľśı
možnost́ı je použ́ıt vyhodnocovaćı př́ıkaz eval.

Obrázek 2.8: Řešeńı př́ıkladu 2.1.

Př́ıklad 2.2: Vytvořte polynom, který má jeden trojnásobný kořen s hodnotou 3
2

a jeden
dvojnásobný s hodnotou −5. Necht’ je výsledný polynom v roznásobeném tvaru.

Řešeńı: Polynomů splňuj́ıćıch zadáńı je nekonečně mnoho, připust́ıme-li možnost mı́t
i daľśı kořeny. Kořeny jednoznačně určuj́ı kořenové činitele polynomu. Polynom maj́ıćı pouze
kořeny zmı́něné v zadáńı bude tvořený třemi činiteli tvaru (x − 3

2
) a dvěma tvaru (x − 5).

Roznásobený tvar źıskáme př́ıkazem expand.

Obrázek 2.9: Řešeńı př́ıkladu 2.2.

Př́ıklad 2.3: Zjednodušte výraz cos(n · π) za předpokladu, že n je sudé.
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Př́ıklad 2.4: Zjednodušte výraz
a−b
a+b

1− a
b

.

Př́ıklad 2.5: Zjednodušte výraz

sin(2 · x)− cos(x)

cos(2 · x)− 1 + sin(x)
.

Př́ıklad 2.6: Rozložte na součin: 4 · x2 · (y2 − z2) + 25 · v · (z2 − y2).

Př́ıklad 2.7: Zjednodušte: (2 · h+ 5 · s)2 − (2 · h+ 5 · s) · (2 · h− 5 · s).

Př́ıklad 2.8: Necht’

p1 = x5 + 15 · x4 + 85 · x3 + 225 · x2 + 274 · x+ 120, p2 = x2 + 6 · x+ 8.

Zjednodušte p1
p2

. Výsledek rozložte na součin kořenových činitel̊u. Výraz p2
p1

rozložte na
parciálńı zlomky.

2.2 Funkce jedné proměnné

2.2.1 Definice funkce

V prostřed́ı Standard Worksheet jsou 2 zp̊usoby, jak definovat funkci. Vytvořme např́ıklad
funkci f(x) = x2. Prvńı možnost́ı (k dispozici jen v prostřed́ı Standard Worksheet a pro
matematický režim Math Mode) je napsat funkčńı předpis stejně, jak jsme to udělali před
chv́ıĺı, s t́ım rozd́ılem, že namı́sto rovńıtka (

”
=“) použijeme symbol pro přǐrazeńı (

”
:=“),

tedy f(x):=x^2. Po spuštěńı př́ıkazu muśıme v následně zobrazeném vyskakuj́ıćım okénku
potvrdit, že se jedná o definici funkce. Druhou možnost́ı (platnou i v jiných prostřed́ıch
systému Maple), jak vytvořit funkci, je použit́ı šipkové notace. Př́ıkaz pak vypadá následovně:
f:=x->x^2. Šipku vytvoř́ıme pomlčkou následovanou symbolem

”
větš́ı než“ (

”
>“).

V prostřed́ı Standard Worksheet si definováńı funkce můžeme ulehčit využit́ım palet.
Bud’ je možné při vytvářeńı př́ıkazu použ́ıt šipku z palety Arrows, nebo můžeme vźıt celou
šablonu př́ıkazu vytvořeńı funkce z palety Expression a modifikovat v ńı požadované sym-
boly. Funkčńı hodnotu definované funkce v daném bodě źıskáme zápisem názvu funkce spolu
s hodnotami parametr̊u v závorce (nemuśıme přitom zadávat pouze numerické hodnoty).

Důležité je v Maple d̊usledně rozlǐsovat funkce a výrazy, lépe řečeno funkčńı operátory
a výrazy. V matematice totiž už́ıváme pojem funkce i v př́ıpadech, které v Maple představuj́ı
výrazy (funkčńı výrazy – např. f(x)). Jestliže vytvoř́ıme výraz, např́ıklad x^2, a přǐrad́ıme
jej k nějaké proměnné, např. g, jedná se stále pouze o výraz. Hodnotu g pro x = 5 nemůžeme
proto určit jako funkčńı hodnotu v bodě 5, ale muśıme použ́ıt vyhodnocovaćıho př́ıkazu eval,
př́ıpadně do x přǐradit hodnotu 5. Naproti tomu funkčńı hodnotu funkce f (nebo vhodněji
řečeno funkčńıho operátoru) v bodě 5 źıskáme specifikaćı argumentu operátoru (funkce) f ,
viz obrázek 2.11 [5].

Dále Maple nab́ıźı př́ıkaz unapply, který ze zadaného výrazu udělá funkci (funkčńı
operátor). Tento př́ıkaz má dva argumenty: výraz, z něhož chceme udělat funkci, a nezávisle
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Obrázek 2.10: Definice funkce v prostřed́ı Standard Worksheet.

Obrázek 2.11: Rozd́ıl mezi funkćı a výrazem (převzato z [5] a doplněno).

proměnnou. Podobně máme k dispozici též př́ıkaz apply, který z funkčńıho operátoru udělá
výraz (aplikuje funkčńı operátor na zadaný argument/argumenty) – pravá část obrázku 2.11.

Výrazy a funkce můžeme též definovat po částech pomoćı př́ıkazu piecewise. Argu-
menty v závorce určuj́ı vždy nejprve interval následovaný funkčńı hodnotou na tomto in-
tervalu. Posledńı množinu bod̊u již zapisovat nemuśıme, stač́ı funkčńı hodnota. Maple ji
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doplńı ve zbývaj́ıćı množině zat́ım nedefinovaných bod̊u. Je možné též sestrojit funkci,
která je definována pouze na libovolné podmnožině reálných č́ısel. Pokud má funkce de-
finovaná po částech pouze dva r̊uzné předpisy, můžeme k jej́ımu vytvořeńı využ́ıt symbolu
otevřené složené závorky z palety Expression (viz obrázek 2.12) [5].

Obrázek 2.12: Funkce definovaná po částech (převzato z [5]).

2.2.2 Vlastnosti funkćı

Definice 2.1: Definičńım oborem funkce f nazýváme množinu všech hodnot, pro něž je
funkce f definována. Znač́ıme ji D(f)3. Oborem hodnot funkce f nazýváme množinu všech
hodnot, kterých funkce f na svém definičńım oboru nabývá. Znač́ıme ji H(f)4.

Definice 2.2: Funkce f se nazývá shora ohraničená, pokud existuje K ∈ R tak, že f(x) ≤
K pro všechna x ∈ D(f). Analogicky, funkce f se nazývá zdola ohraničená, pokud existuje
L ∈ R tak, že f(x) ≥ L pro všechna x ∈ D(f). Funkci f nazýváme ohraničenou (omezenou),
pokud je f ohraničená zdola i shora.

3V literatuře je též možné se setkat s označeńım Dom(f).
4V literatuře je též možné se setkat s označeńım Im(f), př́ıpadně R(f).
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Definice 2.3: Funkce f se nazývá sudá, pokud pro všechna x ∈ D(f) plat́ı, že −x ∈ D(f)
a f(x) = f(−x). Funkce f se nazývá lichá, pokud pro všechna x ∈ D(f) plat́ı, že −x ∈ D(f)
a f(x) = −f(−x).

Definice 2.4: Necht’ M ⊆ D(f) obsahuje alespoň 2 body. Řekneme, že funkce f je na M
(a) rostoućı, jestliže ∀x1, x2 ∈M : x1 < x2 ⇒ f(x1) < f(x2),
(b) klesaj́ıćı, jestliže ∀x1, x2 ∈M : x1 < x2 ⇒ f(x1) > f(x2),
(c) nerostoućı, jestliže ∀x1, x2 ∈M : x1 < x2 ⇒ f(x1) ≥ f(x2),
(d) neklesaj́ıćı, jestliže ∀x1, x2 ∈M : x1 < x2 ⇒ f(x1) ≤ f(x2),
(e) konstantńı, jestliže ∀x1, x2 ∈M : f(x1) = f(x2).

Definice 2.5: Necht’ M ⊆ D(f) obsahuje alespoň 2 body. Řekneme, že funkce f je na M
(a) prostá (injektivńı), jestliže ∀x1, x2 ∈M : x1 6= x2 ⇒ f(x1) 6= f(x2),
(b) zobrazeńım na množinu N ⊆ H(f) (surjektivńı), jestliže ∀y ∈ N : ∃x ∈M ∧ f(x) = y,
(c) bijektivńı z M do N , jestliže je prostá na M a současně je zobrazeńım na množinu N
(tedy injektivńı a surjektivńı).

Systém Maple nemá žádné př́ıkazy na určováńı právě definovaných vlastnost́ı. To však
neznamená, že tyto vlastnosti nemůžeme určovat sami. V některých př́ıpadech nám může
systém Maple pomoci.

I definičńı obor a obor hodnot funkce muśıme zjistit sami. Systém Maple můžeme efek-
tivně využ́ıt pouze v př́ıpadech, kdy si nejsme jisti, jestli daný bod patř́ı do některé z množin,
a to bud’ pokusem o vyhodnoceńı funkce v daném bodě nebo hledáńım řešeńı rovnice, kdy
se uvažovaná funkce rovná danému bodu.

Př́ıklad 2.9: Určete D(f) a H(f) funkce f(x) = ln(x).
Řešeńı: Z přednášky Matematické analýzy v́ıme, že D(f) = R+ = {x ∈ R|x > 0}

a H(f) = R. Systém Maple bychom využili asi jen v př́ıpadě, kdybychom si nebyli jist́ı, jak je
definována funkce ln(x) a chtěli se např́ıklad přesvědčit, že neńı definována pro x = 0. V tom
př́ıpadě bychom mohli zkusit źıskat funkčńı hodnotu v bodě 0. Na obrázku 2.13 vid́ıme, že
obdrž́ıme chybovou zprávu, která je sice trochu matoućı (zmiňováno je děleńı nulou), nicméně
funkčńı hodnota neexistuje. Podobně můžeme např́ıklad ověřit, že 0 ∈ H(f), řešeńım rovnice
ln(x) = 0. Upozorněme, že Maple poč́ıtá standardně s komplexńımi č́ısly, a tak vyhodnoceńı
funkce ln(x) pro záporné x nezp̊usob́ı žádnou chybu. Jelikož se pohybujeme v oboru reálných
č́ısel, je třeba se omezit pouze na něj načteńım baĺıku RealDomain (viz obrázek 1.21).

Obrázek 2.13: Řešeńı př́ıkladu 2.9.

Pro zjǐstěńı, zda je funkce (shora, zdola) ohraničená, či nikoliv, můžeme využ́ıt př́ıkaz̊u
minimize a maximize pro hledáńı nejmenš́ıch a největš́ıch funkčńıch hodnot. V př́ıpadě, že
funkce neńı

”
v některém směru“ ohraničená, vraćı zmı́něné př́ıkazy hodnotu ∞, resp. −∞.
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Daľśı funkčńı vlastnosti můžeme určovat (ověřovat) za pomoci př́ıkaz̊u evalb nebo verify.
Tyto př́ıkazy otestuj́ı, zda je zadaný výraz pravdivý, či nikoliv. Ukažme si to na následuj́ıćım
př́ıkladu.

Př́ıklad 2.10: Určete, zda je funkce cos(x) sudá nebo lichá.
Řešeńı: Opět z přednášky v́ıme, že funkce cos(x) je funkćı sudou. Sudost funkce otestu-

jeme zjǐstěńım pravdivostńı hodnoty výrazu cos(x) = cos(−x), lichost podobně podle prav-
divostńı hodnoty výrazu cos(x) = −cos(−x). I tentokrát bychom správně měli použ́ıt baĺık
RealDomain, nebot’ bez něj ověřujeme zmı́něné rovnosti pro všechna komplexńı x. V obou
př́ıpadech však źıskáme stejný výsledek.

Obrázek 2.14: Řešeńı př́ıkladu 2.10.

Přestože můžeme vytvořit logické výrazy i pro zbylé funkčńı vlastnosti, př́ıkazy evalb

a verify většinou vracej́ı hodnotu FAIL jako znameńı, že nedokáž́ı o pravdivostńı hodnotě
rozhodnout. Některé daľśı př́ıklady je proto potřeba řešit samostatně a systém Maple využ́ıt
jen k

”
drobným podúlohám“ – jako v následuj́ıćım př́ıkladu 2.11.

Př́ıklad 2.11: Určete, zda je funkce cos(x) na R rostoućı, klesaj́ıćı, prostá či bijektivńı.
Řešeńı: Z přednášky v́ıme, že funkce cos(x) na celé množině R žádnou ze zmı́něných

vlastnost́ı nesplňuje, což můžeme dokázat nalezeńım protipř́ıkladu. Vezměme např. body
x1 = 0 a x2 = 2 ·π. Plat́ı, že x1 < x2 (tj. x1 6= x2) a současně cos(x1) = cos(x2). Tedy funkce
neńı rostoućı, neńı klesaj́ıćı a neńı prostá, z čehož plyne, že nemůže být ani bijektivńı.
Systém Maple tu můžeme použ́ıt ke zjǐst’ováńı funkčńıch hodnot (i když v tomto př́ıpadě
známe funkčńı hodnoty zpaměti).

V praxi se nám však často hod́ı naj́ıt intervaly, v nichž funkce některé vlastnosti splňuje.
Funkce cos(x) je periodická s periodou 2 · π a na intervalech [k · π, (k + 1) · π] pro k ∈ Z
je bijektivńı (tedy i prostá), pro sudá k je na těchto intervalech vždy klesaj́ıćı, pro lichá k
rostoućı.

Př́ıklad 2.12: Dokažte, že funkce sin(x) je ohraničená.

Př́ıklad 2.13: Uvažujme funkci f(x) = 1
x2−5·x+6

. Je f sudá nebo lichá? Určete jej́ı definičńı
obor a obor hodnot. Je f ohraničená?

Př́ıklad 2.14: U následuj́ıćıch funkćı určete, zda jsou sudé, liché, nebo ani jedno.

(a) f(x) = 9− x2, (b) f(x) =
√
x, (c) f(x) = 1

x
.

38



Př́ıklad 2.15: Definujte funkci f , pro niž plat́ı:

(a) D(f) = (0, 1), H(f) = (0, 2),

(b) D(f) = R \ {1}, H(f) = R \ {0},

(c) D(f) = R \ {0}, H(f) = R \ {1},

(d) D(f) = R, H(f) = R+, f je prostá,

(e) D(f) = R \ (−2, 2), H(f) = R,

(f) D(f) = R, H(f) = R \ (−2, 2),

(g) D(f) = R, f je prostá a ohraničená,

(h) H(f) = R, f je sudá.

Př́ıklad 2.16: Nalezněte k ∈ R tak, aby byla funkce f(x) = x3 − k · x2 + 2 · x lichá.

Př́ıklad 2.17: U následuj́ıćıch funkćı určete, zda se jedná o bijekci, či nikoliv.

(a) f : R→ R, f(x) = a · x+ b, a, b ∈ R,

(b) f : R+
0 → R+

0 , f(x) =
√
x,

(c) f : R→ R+
0 , f(x) = x2,

(d) f : R→ R, f(x) = x3,

(e) f : R \ {0} → R \ {0}, f(x) = 1
x
.

2.2.3 Inverzńı funkce

Definice 2.6: Necht’ f je prostá funkce. Funkci f−1, pro niž plat́ı: D(f−1) = H(f) a ∀x ∈
D(f) : ∃y ∈ H(f) tak, že f−1(y) = x⇔ f(x) = y, nazýváme inverzńı funkćı.

Poznámka 2.1: Z definice plyne, že funkce a jej́ı inverze jsou osově symetrické vzhledem
k př́ımce y = x.

Systém Maple má uchováno několik základńıch funkćı s jejich inverzemi v tabulce s názvem
invfunc. Praktičtěǰśı je využ́ıt př́ıkaz̊u InverseTutor nebo InversePlot z baĺıku Student[Calculus1]

vykresluj́ıćıch do jednoho grafu funkci, jej́ı inverzi a osu y = x jakožto osu symetrie. Př́ıkaz
InverseTutor provád́ı zmı́něné v mapletu, př́ıkaz InversePlot slouž́ı pro použit́ı v doku-
mentu (obrázek 2.15).

Hledat předpis inverzńı funkce můžeme rovnou podle definice 2.6, a to řešeńım rovnice
f(y) = x pro neznámou y.
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Obrázek 2.15: Vykresleńı funkce a jej́ı inverze.

Obrázek 2.16: Řešeńı př́ıkladu 2.18.

Př́ıklad 2.18: Nalezněte inverzńı funkci k funkci f(x) = x2.

Řešeńı: Naše odpověd’ by mohla být velice stručná, nebot’ funkce f neńı prostá, a tak
k ńı neexistuje funkce inverzńı. Nicméně je možné funkci f rozdělit na dvě funkce prosté
a hledat inverzi ke každé zvlášt’.

V systému Maple provedeme dř́ıve zmı́něný postup, tj. budeme řešit rovnici f(y) = x.
Źıskáme 2 řešeńı, a to právě pro 2

”
prosté části“ funkce f . Pro x ≤ 0 je inverze k x2 rovna

−
√
x, pro x ≥ 0 je rovna

√
x (obrázek 2.16).
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Př́ıklad 2.19: Nalezněte inverzńı funkce k následuj́ıćım funkćım:

(a) f(x) = 2 · x+ 1,

(b) f(x) = x3,

(c) f(x) = 1+x
1−x ,

(d) f(x) =
√

1− x,

(e) f(x) = 1
x
,

(f) f(x) =
∣∣ 1
x

∣∣.
Př́ıklad 2.20: Existuje funkce, která je sama sobě inverźı? Pokud ano, je jediná, nebo jich
existuje v́ıce?

2.2.4 Složená funkce

Operátorem složeńı funkćı je v systému Maple symbol @ (zavináč). V praxi se bez něj však
obejdeme, když použijeme kulaté závorky. Na obrázku 2.17 je několik př́ıklad̊u vytvořeńı
složené funkce, které potvrzuj́ı rovnost f(f−1(x)) = x.

Obrázek 2.17: Složená funkce.

2.3 Vykresleńı grafu funkce

2.3.1 Vykreslováńı

Prostřed́ı Standard Worksheet poskytuje několik možnost́ı, jak zobrazit graf funkce nebo
výrazu. Nejrychleǰśı a zřejmě nejjednodušš́ı možnost́ı je zapsat do dokumentu výraz (resp.
funkci), který chceme vykreslit, kliknout na něj pravým tlač́ıtkem a z kontextové nab́ıdky
zvolit Plots > 2-D Plot.
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Obrázek 2.18: Zvoleńı typu vykresleńı v Plot Builder (převzato z [5]).

Obrázek 2.19: Okénko pro zadáńı výrazu z funkčńıho předpisu a nezávisle proměnných v Plot
Builder (převzato z [5]).
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Dále můžeme využ́ıt pomocńık Plot Builder, a to dvěma zp̊usoby. Bud’ opět zaṕı̌seme
do dokumentu výraz z funkčńıho předpisu, klikneme pravým tlač́ıtkem myši a zvoĺıme Plots
> Plot Builder, nebo zamı́̌ŕıme do hlavńıho menu a vybereme Tools > Assistants > Plot
Builder.... V prvńım př́ıpadě se objev́ı okénko Interactive Plot Builder (obrázek 2.18),
v němž upřesńıme typ vykresleńı. Pokud uvažujeme funkci jedné proměnné, voĺıme 2-D
Plot. Je možné volit i jinou možnost jako např́ıklad vykresleńı v polárńıch souřadnićıch
(2-D polar plot). Kliknut́ım na tlač́ıtko Plot zobraźıme graf v dokumentu [5].

V druhém př́ıpadě, kdy Plot Builder vyvoláme z hlavńıho menu, se nám objev́ı okénko
(viz obrázek 2.19), do nějž zadáme výraz z předpisu funkce, kterou chceme zobrazit (zadáńı
nám umožńı tlač́ıtka Add, resp. Edit), a proměnné (pokud výraz obsahuje pouze proměnné,
systém je vyplńı sám). Kliknut́ım na tlač́ıtko OK přejdeme do již známého okénka pro zvoleńı
typu vykresleńı (obrázek 2.18). Daľśı možnost́ı k vykresleńı grafu výrazu nebo funkce je př́ıkaz
plot.

Při vykreslováńı můžeme specifikovat několik atribut̊u měńıćıch podobu grafu. Opět je
několik možnost́ı, jak atributy zadávat. Při použit́ı pomocńıka Plot Builder se v okénku
Interactive Plot Builder (obrázek 2.18) objevuje tlač́ıtko Options. Kliknut́ım na toto
tlač́ıtko přejdeme na okénko (viz obrázek 2.21) umožňuj́ıćı nastavit parametry vykresleńı
jako jsou rozsah hodnot závisle i nezávisle proměnné, barva a styl vykreslované křivky, titulek
grafu, legenda atd. Užitečné je nav́ıc tlač́ıtko Preview umožňuj́ıćı předběžně si prohlédnout
současný stav a následně pokračovat v daľśım nastavováńı atribut̊u vykresleńı grafu.

Obrázek 2.20: Vykresleńı graf̊u pomoćı kontextové nab́ıdky a př́ıkazu plot (převzato z [5]).

Při použit́ı př́ıkazu plot můžeme totéž provést specifikaćı nepovinných parametr̊u jako
jsou thickness pro tloušt’ku křivky, color pro jej́ı barvu, labels pro popisky os, legend
pro tvar legendy u obrázku, axes pro nastaveńı souřadých os a daľśı. Ukázku použit́ı př́ıkazu
plot s nastaveńım některých nepovinných parametr̊u nab́ıźı obrázek 2.22 [5].

Vzhled grafu můžeme upravovat i po jeho vytvořeńı a umı́stěńı do dokumentu. Jednak lze
na graf kliknout pravým tlač́ıtkem myši a z kontextové nab́ıdky vyb́ırat vlastnosti grafu, které
jsme mohli měnit již dř́ıve, nebo můžeme využ́ıt kontextové lǐsty těsně nad dokumentem. Po
kliknut́ı levým tlač́ıtkem myši na graf se ve zmı́něné lǐstě zobraźı nástroje skupiny nazvané
Plot. K dispozici je též skupina s názvem Drawing. Nástroje v těchto skupinách umožňuj́ı
do hotového grafu přidávat text, kreslit, či jinak graf upravovat [5].

Jestliže chceme vykreslit v́ıce funkćı (resp. výraz̊u) do jediného grafu, zaṕı̌seme všechny
do hranatých, př́ıpadně složených, závorek jako prvńı parametr př́ıkazu plot. Uživatel̊um
doporučujeme použ́ıvat sṕı̌se hranaté závorky, v nichž systém Maple respektuje pořad́ı. Po-
kud nechceme u vykreslovaných funkćı nic dále specifikovat, je nám jedno, v jakém pořad́ı
Maple funkce

”
vezme“ a vykresĺı, použijeme libovolné závorky (tj. hranaté nebo složené).

43



Obrázek 2.21: Okénko Plot Builder pro nastaveńı parametr̊u grafu (převzato z [5]).

Obrázek 2.22: Vykresleńı grafu při specifikaci některých nepovinných parametr̊u (převzato z [5]).
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Pokud však chceme např. každé z křivek přǐradit nějakou barvu, použit́ım hranatých závorek
se barvy aplikuj́ı v tom pořad́ı, v jakém očekáváme. Při použit́ı složených závorek tomu tak
být nemuśı, viz obrázek 2.23.

Obrázek 2.23: Vykresleńı grafu v́ıce výraz̊u př́ıkazem plot.

K dispozici je dále př́ıkaz display z baĺıku plots, kterým můžeme dosáhnout stejného
výsledku. Jednotlivé grafy nejprve vytvoř́ıme a přǐrad́ıme do proměnných, jež dáme jako
parametry právě př́ıkazu display (obrázek 2.24).

Obrázek 2.24: Vykresleńı grafu v́ıce výraz̊u pomoćı př́ıkazu display.
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2.3.2 Animace

V systému Maple můžeme též vytvářet animace. Animace se skládá z několika graf̊u, které
jsou po spuštěńı zobrazené v sekvenci za sebou. Vytvoř́ıme ji bud’ př́ıkazem animate z baĺıku
plots, nebo pomoćı Plot Builderu. Obrázky 2.25 a 2.26 ukazuj́ı nastaveńı Plot Builderu
pro vytvořeńı animace, obrázek 2.27 ilustruje tentýž př́ıklad při použit́ı př́ıkazu animate.

Obrázek 2.25: Zadáńı výrazu z předpisu funkce v Plot Builderu (převzato z [5]).

Ukončeńı Plot Builderu, resp. provedeńı př́ıkazu, umı́st́ı do dokumentu
”
prázdný“ graf.

Kliknut́ım na něj zobraźıme skupinu nástroj̊u v kontextové lǐstě s názvem Animation.
Pomoćı těchto nástroj̊u můžeme animaci spustit, změnit jej́ı rychlost, pod́ıvat se na libovolný
sńımek animace atd.

Animace můžeme upravovat stejně jako grafy, tj. měnit tloušt’ku, barvu a druh křivky,
souřadné osy, legendu apod. Nav́ıc máme k dispozici několik nepovinných parametr̊u, d́ıky
nimž můžeme např́ıklad určit počet graf̊u, z nichž se animace skládá (parametr frames), nebo
kolik graf̊u vyjma posledńıho má z̊ustat trvale zobrazených po spuštěńı animace (parametr
trace) [5].
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Obrázek 2.26: Zvoleńı druhu vykresleńı (animace) v Plot Builderu (převzato z [5]).

Obrázek 2.27: Animace vytvořená př́ıkazem animate (převzato z [5]).
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Př́ıklad 2.21: Vykreslete funkci f(x) = x5 + 15 · x4 + 85 · x3 + 225 · x2 + 274 · x+ 120.

Řešeńı: K vykresleńı zadané funkce ji stač́ı zapsat do dokumentu a použ́ıt některý z dř́ıve
uvedených postup̊u. Muśıme však mı́t na paměti, co bychom rádi na grafu viděli a že je
možné źıskaný výsledek ovlivnit. Např́ıklad v tomto př́ıpadě, když nespecifikujeme rozsah
vykresleńı (použije se standardńı rozmeźı -10..10) zcela zkresĺıme informaci o chováńı funkce
na intervalu [−5, 0].

Obrázek 2.28: Řešeńı př́ıkladu 2.21.

Př́ıklad 2.22: K funkci g(x) = e2·x nalezněte inverzńı funkci. Vykreslete do jednoho grafu
funkci g(x), jej́ı inverzi a funkci f(x) = x. Do grafu přidejte také legendu.

Př́ıklad 2.23: Zkoumejte závislost funkce h(x) = ea·x na parametru a ∈ R (pomoćı ani-
mace). Kdy je funkce rostoućı a kdy klesaj́ıćı?

Př́ıklad 2.24: Vrat’te se k př́ıklad̊um 2.12 – 2.20 předchoźı sekce a vykresleńım graf̊u se
ujistěte o správnosti vašich odpověd́ı.

2.4 Limita a spojitost funkce

Definice 2.7: Funkce f(x) má v bodě x0 ∈ R limitu L ∈ R, jestliže ke každému ε > 0
existuje δ > 0 tak, že pro všechna x ∈ (x0 − δ, x0 + δ) r̊uzná od x0 plat́ı: |f(x) − L| < ε.
Takovou limitu nazýváme vlastńı limitou ve vlastńım bodě.

Definice 2.8: Funkce f(x) má v bodě x0 ∈ R limitu L ∈ R zleva, jestliže ke každému
ε > 0 existuje δ > 0 tak, že pro všechna x ∈ (x0 − δ, x0) plat́ı: |f(x) − L| < ε. Analogicky
definujeme limitu zprava.

Definice 2.9: Funkce f(x) má v bodě x0 ∈ R limitu rovnu +∞, jestliže ke každému M ∈ R
existuje δ > 0 tak, že pro všechna x ∈ (x0−δ, x0+δ) r̊uzná od x0 plat́ı: f(x) > M . Analogicky
definujeme limitu rovnu −∞. Takovou limitu nazýváme nevlastńı limitou ve vlastńım bodě.
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Definice 2.10: Funkce f(x) má v bodě +∞ limitu rovnu L ∈ R, jestliže ke každému ε > 0
existuje K ∈ R tak, že pro všechna x > K plat́ı: |f(x) − L| < ε. Analogicky definujeme
limitu v bodě −∞. Takovou limitu nazýváme vlastńı limitou v nevlastńım bodě.

Př́ıklad 2.25: Definujte limitu zprava.

Př́ıklad 2.26: Definujte nevlastńı limitu v nevlastńım bodě.

Systém Maple ve verzi 16 nab́ıźı též tzv. Matematické aplikace, které najdeme v hlavńım
menu (Tools > Math Apps). Jednou z položek v sekci Calculus je dokument s názvem
Definition of a Limit s definićı limity a jej́ı názornou interaktivńı demonstraćı – viz obrázek
2.29.

Obrázek 2.29: Interaktivńı demonstrace limity.

K výpočtu limity použijeme bud’ př́ıslušný symbol z palety Expression (a uprav́ıme
v něm barevné symboly, jak potřebujeme), nebo př́ıkaz limit, který má povinně dva para-
metry – výraz (tj. i funkčńı výraz) a bod, v němž hledáme limitu. Také je možné zadat do
dokumentu výraz, jehož limitu chceme určit, kliknout na něj pravým tlač́ıtkem a z kontex-
tové nab́ıdky zvolit položku Limit. Otevře se nám okénko, v němž je dále třeba specifikovat
bod, v němž hledáme limitu. Můžeme dále uvést i typ limity – oboustrannou (základně
zvolená), limitu zleva nebo limitu zprava.

V př́ıpadě použit́ı palety specifikujeme jednostrannou limitu zapsáńım symbolu + nebo
− do exponentu bodu, v němž chceme limitu určit. Př́ıkazu limit můžeme zadat třet́ı
(nepovinnný) parametr ve tvaru right nebo left pro limitu zprava, resp. zleva. Všechny
zmı́něné postupy ilustruje obrázek 2.30. V jeho pravé části je definována funkce a při určováńı
limit použ́ıván funkčńı výraz f(x). Funkčńı operátor (tj. f) použ́ıt nemůžeme.

Systém Maple v některých př́ıpadech zobrazuje neočekávané výsledky, které můžeme
označit za chybné. Jedná se např́ıklad o limity na obrázku 2.31. Vypsaným výsledkem se nám
systém snaž́ı dát omezeńı na funkčńı hodnoty v okoĺı bodu, v němž hledáme limitu. Podle
uvedených definic v tomto textu však muśıme konstatovat, že př́ıslušné limity neexistuj́ı.
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Obrázek 2.30: Určeńı limity v bodě.

Obrázek 2.31: Nedostatky Maplu při určováńı limity.

Př́ıklad 2.27: Určete následuj́ıćı limity:

(a) lim
x→0

sin(x)
x

,

(b) lim
x→0

sin(a·x)
sin(b·x)

,

(c) lim
x→0

ex−1
x

,

(d) lim
x→π

2
+

tan(x).

Př́ıklad 2.28: Určete následuj́ıćı limity:

(a) lim
x→0

3√
x2− 3√x

3√
x2+ 3√x

,

(b) lim
x→π

2

cos(x
2

)−sin(x
2

)

cos(x)
,

(c) lim
x→2

√
x2+5−3
x2−2·x ,

(d) lim
x→−∞

3·x+2√
x2−1

,

(e) lim
x→−∞

5x+3x

4x
,

(f) lim
t→0

sin(t)·cos(t)
t−t2 .

Jak byste limity určovali bez systému Maple?

Př́ıklad 2.29: Definujte funkci, která:

(a) má vlastńı limitu ve vlastńım bodě,

(b) má vlastńı limitu v nevlastńım bodě,
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(c) má nevlastńı limitu ve vlastńım bodě,

(d) má nevlastńı limitu v nevlastńım bodě,

(e) splňuje všechny předchoźı body (a) – (d).

Jak jsme se zmı́nili v sekci 1.3.4, Maple obsahuje pomocné nástroje, které nám ulehčuj́ı
řešeńı úloh a pomáhaj́ı v učeńı některých matematických postup̊u při jejich řešeńı. Jedńım
z takových nástroj̊u je maplet zvaný Limit Methods. Spust́ıme jej z hlavńı nab́ıdky zvo-
leńım Tools > Tutors > Calculus − Single Variable > Limit Methods.... Tento
nástroj umı́ řešit zadané limity krok po kroku pomoćı implementovaných matematických
pravidel. Můžeme mu tedy zadat výraz a bod, v němž chceme určit jeho limitu, a ne-
chat např́ıklad maplet zobrazit celé řešeńı krok za krokem kliknut́ım na tlač́ıtko All Steps.
Výsledek tohoto postupu na př́ıkladu 2.28.(b) můžeme vidět na obrázku 2.32. V mapletu si
však můžeme zobrazit pouze následuj́ıćı krok výpočtu, pokusit se použ́ıt některé z imple-
mentovaných pravidel nebo požádat o nápovědu, které pravidlo použ́ıt.

Obrázek 2.32: Pomocńık pro určováńı limit.

Definice 2.11: Řekneme, že funkce f(x) je spojitá v bodě x0, pokud má v tomto bodě
vlastńı limitu a plat́ı: lim

x→x0
f(x) = f(x0).
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Definice 2.12: Řekneme, že funkce f(x) je zprava (resp. zleva) spojitá v bodě x0, pokud
má v tomto bodě př́ıslušnou jednostrannou vlastńı limitu a plat́ı: lim

x→x0+
f(x) = f(x0) (resp.

lim
x→x0−

f(x) = f(x0)).

Definice 2.13: Řekneme, že funkce f(x) je spojitá na intervalu J ∈ D(f), pokud

(a) f je spojitá v každém vnitřńım bodě intervalu J

(b) a patř́ı-li levý (resp. pravý) koncový bod do intervalu J , je v něm funkce f spojitá
zprava (resp. zleva).

V systému Maple můžeme jednak testovat rovnost limity a funkčńı hodnoty, jak plyne
z definice. Pro určováńı spojitosti funkce na intervalu je však možné (a vhodné) využ́ıt
př́ıkazu discont hledaj́ıćıho nespojistosti funkce. Př́ıkaz má dva povinné parametry, a to
výraz, jehož nespojitosti určujeme, a nezávisle proměnnou. Daľśı možnost́ı je použ́ıt př́ıkaz
iscont testuj́ıćı spojitost na zadaném intervalu. Odpověd́ı je pravdivostńı hodnota, zda je
funkce na daném intervalu spojitá, či nikoliv.

Obrázek 2.33: Zobrazováńı nespojitých funkćı.

Pokud je funkce y = f(x) nespojitá na daném intervalu jen v konečně mnoha (izolo-
vaných) bodech, systém Maple ji v těchto bodech spojuje úsečkami rovnoběžnými s osou y.
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Jestliže chceme nespojitosti zobrazit korektně, použijeme nepovinný atribut discont př́ıkazu
plot, který nastav́ıme na hodnotu true – viz obrázek 2.33.

Od verze Maple 14 je možné také zobrazovat odstranitelné nespojitosti (obrázek 2.34).

Obrázek 2.34: Zobrazováńı nespojitých funkćı a vyznačováńı odstranitelných nespojitost́ı.

Výsledkem př́ıkazu discont u funkćı definovaných po částech jsou vždy body
”
podezřelé“

z nespojitost́ı. Pro zjǐstěńı, zda se jedná o nespojitosti či nikoliv, je potřeba v těchto bodech
provést test (existence a) rovnosti limity a funkčńı hodnoty. Obrázek 2.35 ukazuje použit́ı
př́ıkazu discont v př́ıpadě funkce f(x) zadefinované po částech.

Obrázek 2.35: Použit́ı př́ıkazu discont u funkce definované po částech.
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Př́ıklad 2.30: Nalezněte č́ıslo C ∈ R tak, aby funkce f(x) =

{
x2−16
x−4

. . . x 6= 4

C . . . x = 4

byla spojitá pro všechna x ∈ R.
Řešeńı: Jelikož x2−16 = (x−4)·(x+4), plat́ı f(x) = x+4 pro x 6= 4, a tedy lim

x→4
f(x) = 8.

Z definice spojitosti pak dostáváme: C = f(4) = 8.

Př́ıklad 2.31: Určete body nespojitosti funkćı:

(a) f(x) =


x+ 1 . . . x ≥ 2

2 · x− 1 . . . 1 < x < 2,

x− 1 . . . x ≤ 1

(b) f(x) = 3·x+3
x2−3·x−4

,

(c) f(x) = x2−b2
x−b , b ∈ R.

Př́ıklad 2.32: Nalezněte č́ısla c, d ∈ R tak, aby funkce f(x) =


3 · x2 − 1 . . . x < 0

c · x+ d . . . 0 ≤ x ≤ 1√
x+ 8 . . . x > 1

byla spojitá pro všechna x ∈ R.

Př́ıklad 2.33: Uved’te př́ıklad funkce, která na uzavřeném intevalu neńı spojitá, ale má
limitu v každém bodě tohoto intervalu.

2.5 Derivace funkce

Definice 2.14: Necht’ f je funkce, x0 ∈ R. Existuje-li lim
x→x0

f(x)−f(x0)
x−x0 , nazýváme tuto limitu

derivaćı funkce f v bodě x0.

Poznámka 2.2: Derivace funkce f(x) je funkce, která je definovaná ve všech bodech,
v nichž existuje limita z předchoźı definice. Tuto funkci znač́ıme několika zp̊usoby: f ′(x),
df(x)
dx

nebo ∂f(x)
∂x

. Analogicky můžeme definovat druhou derivaci funkce f(x) jako derivaci
funkce f ′(x) a podobně derivace vyšš́ıch řád̊u.

Poznámka 2.3: Limita v definici 2.14 může být vlastńı i nevlastńı. Podle toho rozlǐsujeme
také vlastńı a nevlastńı derivaci. V tomto textu si situaci ulehč́ıme a budeme uvažovat pouze
vlastńı derivace. Z tohoto d̊uvodu budeme slovo

”
vlastńı“ vynechávat a slovem

”
derivace“

budeme vždy rozumět vlastńı derivaci.

Systém Maple nab́ıźı (jako obvykle) několik možnost́ı, jak určit derivaci funkce. Opět
můžeme využ́ıt kontextové nab́ıdky (tj. zapsat do dokumentu výraz, který chceme derivovat,
kliknout na něj pravým tlač́ıtkem myši a z nab́ıdky zvolit položku Differentiate s výběrem
nezávisle proměnné). Dále je možné použ́ıt oba již uvedené symboly zápisu derivace, které
jsou k dispozici v paletě Expression. Systém Maple (v režimu Document Mode) rozpozná
i zápis f ′(x) (tj. použit́ı apostrofu jako symbolu derivace). Dlaš́ı možnost́ı je př́ıkaz diff

maj́ıćı dva povinné argumenty: výraz a nezávisle proměnnou.
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Obrázek 2.36: Přehled možnost́ı při výpočtu derivace.

Při poč́ıtáńı derivaćı muśıme být opět opatrńı a rozlǐsovat mezi funkčńım operátorem
a výrazem. Všechny zmı́něné zp̊usoby určeńı derivace funkce (nebo lépe výrazu) vraćı výsledek
jako výraz. Pokud chceme poté určit jeho funkčńı hodnotu, muśıme bud’ použ́ıt př́ıkaz eval,
nebo ze źıskaného výrazu udělat funkci př́ıkazem unapply, př́ıpadně použ́ıt apostrofovou
notaci pro zápis derivace, viz obrázek 2.37.

Obrázek 2.37: Výpočet derivace v bodě.

Systém Maple disponuje též př́ıkazem D představuj́ıćım diferenciálńı operátor. Jeho ar-
gumentem je funkčńı operátor a výsledkem derivace opět jako funkce (funkčńı operátor) –
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pravá část obrázku 2.37.

Obrázek 2.38: Výpočet derivaćı vyšš́ıch řád̊u.

Derivace vyšš́ıch řád̊u zadáváme tak, jak jsme zvykĺı
”
s tužkou na paṕı̌re“. Při použit́ı

př́ıkazu diff se n-tá derivace specifikuje tak, že zadáme nezávisle proměnnou n-krát (jako
argument př́ıkazu)5. Systém Maple (opět pouze v režimu Document Mode) umı́ rozpoznat
i zápis s č́ıslem derivace v exponentu výrazu v kulatých závorách – toto je nutné při odkliknut́ı
ještě potvrdit ve vyskakuj́ıćım okénku (obrázek 2.38).

Stejně jako u limit poskytuje Maple jednak pomocné nástroje pro výpočet derivaćı, ale
od verze 16 také matematickou aplikaci s definićı a znázorněńım derivace (Tools > Math
Apps > Calculus − Derivative Definition) – viz obrázek 2.39.

Obrázek 2.39: Interaktivńı znázorněńı derivace.

Prvńım z pomocných nástroj̊u pro výpočet derivace je maplet zvaný Derivatives. Spust́ıme

5Je možné použ́ıt i zkrácený zápis ve tvaru diff(f(x),x$n).
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jej z hlavńı nab́ıdky zvoleńım Tools > Tutors > Calculus − Single Variable > Deri-
vatives.... Maplet pro zadanou funkci vypoč́ıtá jej́ı prvńı a druhou derivaci, zvolené funkce
vykresĺı do jednoho grafu.

Obrázek 2.40: Pomocńık pro výpočet a zobrazeńı derivaćı.

Obrázek 2.41: Pomocńık pro výpočet derivaćı.

Druhý takový nástroj je maplet s názvem Differentiation Methods. Spust́ıme jej
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z hlavńı nab́ıdky zvoleńım Tools > Tutors > Calculus − Single Variable > Differen-
tiation Methods.... Stejně jako analogický pomocńık u limit umı́ řešit derivace zadaných
funkćı krok po kroku pomoćı implementovaných matematických pravidel (která nalezneme
v nápovědě). Můžeme mu tedy opět zadat výraz a nezávisle proměnnou a nechat maplet
zobrazit celé řešeńı krok za krokem kliknut́ım na tlač́ıtko All Steps. Výsledek tohoto po-
stupu můžeme vidět na obrázku 2.41. V mapletu si také můžeme zobrazit pouze následuj́ıćı
krok výpočtu (Next Step), pokusit se použ́ıt některé z implementovaných pravidel nebo
požádat o nápovědu (Get Hint), které pravidlo použ́ıt.

Př́ıklad 2.34: Určete:

(a) d
dx

(f(x) · g(x)),

(b) d
dx

(f(g(x)),

(c) d
dx

(a · x3 + b · x2 + c · x+ d),

(d) d
dx

(
(x−1)3

x2−1

)
.

Př́ıklad 2.35: Uved’te př́ıklad spojité funkce na intervalu J , která na tomto intervalu neńı
diferencovatelná (tj. nemá v alespoň jednom bodě derivaci). Dokážete uvést př́ıklad funkce
spojité na intervalu J , která na tomto intervalu nemá derivaci právě ve dvou bodech?

Poznámka 2.4: Geometrickou interpretaćı derivace funkce f(x) v bodě x0 je směrnice
tečny k funkci f(x) v tomto bodě. Jestliže tedy y = k ·x+ q je rovnićı tečny v bodě x0, pak
k = f ′(x0).

Př́ıklad 2.36: Určete rovnici tečny k funkci f(x) = x2 v bodě x0 = 1. Vykreslete do
jednoho grafu funkci f(x) i tuto tečnu.

Př́ıklad 2.37: Najděte bod x0 tak, aby tečna k funkci f(x) = x3 v tomto bodě byla
rovnoběžná s př́ımkou y = 12 · x − 5. Vykreslete do jednoho grafu funkci f(x), nalezenou
tečnu a zadanou př́ımku.

Př́ıklad 2.38: Najděte bod x0 tak, aby tečna k funkci f(x) = x3 v tomto bodě byla kolmá
na př́ımku y = −1

3
·x−5. Vykreslete do jednoho grafu funkci f(x), nalezenou tečnu a zadanou

př́ımku.

2.5.1 Diferenciál

Definice 2.15: Řekneme, že funkce f je diferencovatelná v bodě x0, jestliže je v něm
definovaná a jestliže existuje A ∈ R tak, že lim

h→0

f(x0+h)−f(x0)−A·h
h

= 0. Funkce A · h (h ∈ R)

se nazývá diferenciálem funkce f v bodě x0 a znač́ı se df(x0)(h).

Poznámka 2.5: Jak již bylo zmı́něno v př́ıkladu 2.35,
”
diferencovatelná funkce“ je totéž

co
”
funkce maj́ıćı derivaci“.

Diferenciál je možné použ́ıt k určeńı přibližné hodnoty funkce v okoĺı bodu se známou
funkčńı hodnotou. V systému Maple se tato

”
výhoda“ smazává, jelikož samotný Maple nám

okamžitě vyṕı̌se přibližnou funkčńı hodnotu s
”
libovolnou“ přesnost́ı. Přesto je možné si na

př́ıkladech význam pojmu ověřit a využ́ıt Maple alespoň k d́ılč́ım výpočt̊um.
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Př́ıklad 2.39: Určete přibližně: arctan(1.01).
Řešeńı: Vyjdeme z definice 2.15. Ta nám ř́ıká, že f(x0 +h) ≈ f(x0) +df(x0) ·h. V našem

př́ıpadě x0 = 1 a h = 0.01. Řešeńı źıskané v Maple je znázorněno na obrázku 2.42.

Obrázek 2.42: Řešeńı př́ıkladu 2.39.

Př́ıklad 2.40: Určete přibližně:
√

51.

Př́ıklad 2.41: Určete přibližně: 3
√

123.

Př́ıklad 2.42: Určete přibližně: 2.954.

2.5.2 Taylor̊uv polynom

Definice 2.16: Necht’ n ∈ N∪{0} a f je funkce maj́ıćı v bodě x0 ∈ R derivace až do řádu
n. Polynom

T fn (x) = f(x0) +
f ′(x0)

1!
· (x− x0) +

f ′′(x0)

2!
· (x− x0)2 + . . .+

f (n)(x0)

n!
· (x− x0)n, x ∈ R,

se nazývá Taylor̊uv polynom stupně n funkce f v bodě x0. Funkci

Rf
n(x) = T fn (x)− f(x)

ř́ıkáme Taylor̊uv zbytek a celý výraz

T fn (x) +Rf
n(x)

nazýváme Taylorovým vzorcem.

Poznámka 2.6: Jak jsme si mohli všimnout, aproximace funkčńı hodnoty pomoćı dife-
renciálu je vlastně speciálńı př́ıpad Taylorova polynomu pro n = 1. Taylor̊uv polynom také
můžeme využ́ıt k aproximaci funkčńı hodnoty v okoĺı bodu se známou funkčńı hodnotou.
Aproximace je t́ım přesněǰśı, č́ım vyšš́ı je n. Dı́ky následuj́ıćı poznámce můžeme zjistit, jak
vysoké muśı být n, abychom doćılili požadované přesnosti aproximace.

Poznámka 2.7: Necht’ jsou splněny předpoklady definice 2.16. Pak existuje č́ıslo Θ ∈ (0, 1)
tak, že

Rf
n(x) =

f (n+1)(x0 + Θ · (x− x0))

(n+ 1)!
· (x− x0)n+1.
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Poznámka 2.8: Když polož́ıme v Taylorově vzorci x0 = 0, všechny výrazy se nám zjedno-
dušš́ı. V takovém př́ıpadě také někdy mluv́ıme o Maclaurinově vzorci . Pro Maclaurin̊uv
zbytek pak plat́ı:

Rf
n(x) =

f (n+1)(Θ · x)

(n+ 1)!
· xn+1.

Systém Maple obsahuje př́ıkaz taylor vypisuj́ıćı Taylor̊uv vzorec př́ıslušný zadané funkci
v prvńım parametru př́ıkazu. Druhým povinným parametrem je bod, v němž se vzorec
realizuje. Standardně je vzorec vypisován pro n = 5, což je o jedna nižš́ı hodnota než
základńı nastaveńı systémové proměnné Order. Tato proměnná představuje řád Taylorova
zbytku, tedy č́ıslo n + 1. Počet člen̊u Taylorova vzorce tak můžeme ovlivnit přenastaveńım
proměnné Order nebo zapsáńım této hodnoty na mı́sto třet́ıho (nepovinného) parametru
př́ıkazu taylor6.

Někdy se nám může hodit pracovat pouze s Taylorovým polynomem (tedy bez Taylorova
zbytku). K tomu je potřeba použ́ıt př́ıkaz convert, kterému zadáme jako prvńı parametr
Taylor̊uv vzorec (źıskaný př́ıkazem taylor) a na mı́sto druhého parametru zaṕı̌seme slovo
polynom (č́ımž se

”
zbav́ıme“ vyjádřeńı Taylorova zbytku pomoćı funkce O).

Obrázek 2.43: Ukázka použit́ı př́ıkazu taylor.

Maple 16 dále poskytuje matematickou aplikaci Taylor’s Theorem (Tools > Math Apps
> Calculus − Taylor’s Theorem) – viz obrázek 2.44 s interaktivńı demonstraćı zave-
deného pojmu.

Př́ıklad 2.43: Najděte Maclaurin̊uv polynom funkce tan(x) pátého stupně.

Př́ıklad 2.44: Vytvořte Taylor̊uv polynom pro funkci xx čtvrtého stupně v bodě 1.

Př́ıklad 2.45: Pomoćı Taylorova polynomu vyjádřete funkci f(x) = x5+x4+x3+x2+x+1
jako polynom v proměnné x− 2.

Jak jsme se zmı́nili v poznámce 2.6, Taylor̊uv polynom můžeme využ́ıt k nalezeńı přibližné
funkčńı hodnoty. Dı́ky poznámkám 2.7 a 2.8 máme nav́ıc nástroj, jak určit tuto hodnotu se
zadanou přesnost́ı. Podobně jako v př́ıpadě použit́ı diferenciálu plat́ı i zde, že (podstatně)

6V tomto př́ıpadě nedojde ke změně hodnoty uložené v proměnné Order, ovlivněn bude pouze př́ıslušný
výpis př́ıkazu taylor.
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Obrázek 2.44: Interaktivńı demonstrace Taylorova polynomu.

jednodušš́ım zp̊usobem źıskáme dokonce přesněǰśı hodnotu pouhým použit́ım systému Maple.
Přesto může Maple sloužit jako pomocńık při výpočtu a současně d́ıky němu můžeme ověřit,
zda byla splněna požadovaná přesnost výpočtu.

Př́ıklad 2.46: Určete hodnotu Eulerova č́ısla e s chybou menš́ı než 10−3.
Řešeńı: Chceme zjistit hodnotu č́ısla e, vezmeme si proto na pomoc funkci f(x) = ex a bu-

deme hledat funkčńı hodnotu f(1). Funkci muśıme aproximovat v nějakém jiném bodě než
je bod 1 (nebot’ pro ten bychom dostali přesnou hodnotu e a v ničem by nám to nepomohlo),
současně ale ne př́ılǐs daleko od tohoto bodu (č́ım dále od tohoto bodu bychom hledali apro-
ximaci, t́ım nepřesněǰśı bude výsledek). Abychom si situaci co nejv́ıce zjednodušili, vezmeme
bod 0 (který je

”
bĺızko“ bodu 1), pro nějž máme tvar Taylorova (resp. Maclaurinova) zbytku

určený poznámkou 2.8.
Máme tedy funkci f(x) = ex a v́ıme, že pro př́ıslušný Maclaurin̊uv zbytek plat́ı:

Rex

n (x) =
eΘ·x

(n+ 1)!
· xn+1,

kde Θ ∈ (0, 1). Nás bude zaj́ımat funkčńı hodnota v bodě 1, tj. pro x = 1 dostáváme:

Rex

n (1) =
eΘ

(n+ 1)!
.

V zadáńı je požadována přesnost 10−3. Má tedy platit:∣∣Rex

n (1)
∣∣ < 10−3.

Dosazeńım źıskáme: ∣∣∣∣ eΘ

(n+ 1)!

∣∣∣∣ =
eΘ

(n+ 1)!
< 10−3.

Nyńı je třeba si uvědomit, že eΘ < 3, jelikož Θ ∈ (0, 1). Můžeme proto psát, že plat́ı:

eΘ

(n+ 1)!
<

3

(n+ 1)!
.
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Když nyńı najdeme n takové, že
3

(n+ 1)!
< 10−3,

pak bude jistě platit:

eΘ

(n+ 1)!
< 10−3.

Źıskané n představuje stupeň Maclaurinova polynomu, takže už zbývá pouze popsaný postup
aplikovat v systému Maple – obrázek 2.45.

Obrázek 2.45: Řešeńı př́ıkladu 2.46.

Př́ıklad 2.47: S chybou menš́ı než 10−3 určete hodnotu č́ısla:

(a) 1
e
, (b) 5

√
250.
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2.6 Vyšetřeńı pr̊uběhu funkce

Než začneme s vyšetřováńım pr̊uběhu funkce na př́ıkladech, připomeňme si základńı d̊uležité
pojmy a jejich vlastnosti.

Poznámka 2.9: Necht’ f(x) je funkce. Pokud f ′(x) > 0 pro všechna x ∈ J , pak je f(x)
na intervalu J rostoućı. Pokud f ′(x) < 0 pro všechna x ∈ J , pak je f(x) na intervalu J
klesaj́ıćı.

Definice 2.17: Řekneme, že funkce f(x) má v bodě x0 ∈ R lokálńı minimum, jestliže
existuje δ ∈ R, δ > 0 tak, že f(x) ≥ f(x0) pro všechna x ∈ (x0 − δ, x0 + δ). Analogicky
definujeme lokálńı maximum funkce. Lokálńı minima a maxima se souhrnně nazývaj́ı lokálńı
extrémy.

Poznámka 2.10: Necht’ f(x) je spojitá v bodě x0. Jestliže existuje δ ∈ R, δ > 0 tak, že
f(x) je neklesaj́ıćı na intervalu (x0 − δ, x0) a nerostoućı na intervalu (x0, x0 + δ), má f(x)
v bodě x0 lokálńı maximum. Analogické tvrzeńı plat́ı pro lokálńı minimum.

Poznámka 2.11: V předchoźı poznámce jsou záměrně použity výrazy
”
neklesaj́ıćı“ a

”
ne-

rostoućı“. Lokálńı minimum (resp. maximum) se totiž může podle definice nacházet i na
intervalu, kde je funkce konstantńı. V tom př́ıpadě se jedná o tzv. neostrý extrém. Pro př́ıpad
ostrých extrémů je možné v předchoźı poznámce nahradit slovo

”
neklesaj́ıćı“ za

”
rostoućı“

a
”
nerostoućı“ za

”
klesaj́ıćı“.

Poznámka 2.12: Body x0, v nichž f ′(x0) = 0, nazýváme stacionárńımi body . Tyto body
a body, v nichž funkce f(x) nemá derivaci, jsou

”
podezřelé“ z toho, že jsou lokálńımi extrémy

funkce. Jestli se skutečně jedná o extrém, urč́ıme bud’ podle definice 2.17, poznámky 2.10
nebo poznámky 2.13.

Poznámka 2.13: Necht’ f ′(x0) = 0 a f ′′(x0) 6= 0. Pokud f ′′(x0) < 0, má funkce f(x)
v bodě x0 lokálńı maximum. Pokud f ′′(x0) > 0, má funkce f(x) v bodě x0 lokálńı minimum.

Definice 2.18: Necht’ f(x) je funkce, J interval. Ř́ıkáme, že f je konvexńı na J , jestliže
pro každé dva body x1, x2 ∈ J , x1 < x2 a každá dvě nezáporná reálná č́ısla a1, a2 taková, že
a1 + a2 = 1 plat́ı:

f(a1 · x1 + a2 · x2) ≤ a1 · f(x1) + a2 · f(x2).

Pokud za týchž předpoklad̊u plat́ı:

f(a1 · x1 + a2 · x2) ≥ a1 · f(x1) + a2 · f(x2),

ř́ıkáme, že f je konkávńı na J . Pokud změńıme všechny neostré nerovnosti na ostré, mluv́ıme
o ryźı konvexitě, resp. ryźı konkávitě.

Poznámka 2.14: Necht’ f má na intervalu J ⊆ D(f) druhou derivaci. Pokud f ′′(x) ≥ 0
pro všechna x ∈ J , pak je f na J konvexńı. Pokud plat́ı ostrá nerovnost, je f na J ryze
konvexńı. Analogicky, pokud f ′′(x) ≤ 0 pro všechna x ∈ J , pak je f na J konkávńı. V př́ıpadě
ostré nerovnosti je ryze konkávńı.
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Poznámka 2.15: Body, v nichž se měńı ryźı konvexita funkce na ryźı konkávitu a naopak,
nazýváme inflexńımi body. Necht’ tedy x0 ∈ R, δ ∈ R, δ > 0. Pokud f(x) je na (x0−δ, x0) ryze
konvexńı a na (x0, x0 + δ) ryze konkávńı (resp. naopak), nazýváme bod x0 bodem inflexńım.

Poznámka 2.16: V bodech nespojitosti x0 funkce f(x) zkoumáme, jestli v nich jsou
asymptoty bez směrnice, a to ověřeńım, zda lim

x→x0−
f(x) = ±∞ nebo lim

x→x0+
f(x) = ±∞.

Dále zkoumáme, zda má funkce f(x) asymptotu (asymptoty) se směrnićı, tj. zda existuj́ı
A,B ∈ R tak, že lim

x→∞
f(x) = A · x+B nebo lim

x→−∞
f(x) = A · x+B.

Plat́ı, že

A = lim
x→∞

f(x)

x

(
resp. A = lim

x→−∞

f(x)

x

)
a

B = lim
x→∞

(f(x)− A · x)

(
resp. B = lim

x→−∞
(f(x)− A · x)

)
.

Při vyšetřováńı pr̊uběhu zadané funkce f(x) zkoumáme vlastnosti popsané v předchoźıch de-
finićıch a poznámkách, spolu s některými dř́ıve zavedenými pojmy. Aplikujeme tak následuj́ıćı
postup:

1. Zjǐst’ujeme D(f), hledáme nulové body (tj. taková x, pro která f(x) = 0), pr̊useč́ık
s osou y (tj. f(0)), určujeme, kdy je funkce kladná, záporná, a hledáme body nespoji-
tosti funkce f .

2. Vyšetřujeme funkci f ′(x). Hledáme D(f ′), nulové body a intervaly, kde je funkce f ′(x)
kladná (tj. f(x) je rostoućı) a kde záporná (tj. f(x) je klesaj́ıćı).

3. Vyšetřujeme funkci f ′′(x). Hledáme nulové body a intervaly, kde je funkce f ′′(x) kladná
(tj. f(x) je konvexńı) a kde záporná (tj. f(x) je konkávńı). Ověřujeme, zda je některý
z dř́ıve nalezených stacionárńıch bod̊u lokálńım extrémem funkce f(x).

4. Hledáme asymptoty funkce f , a to asymptoty bez směrnice a asymptoty se směrnićı.

5. Vykreslujeme graf funkce f(x).

Př́ıklad 2.48: Vyšetřete pr̊uběh funkce f(x) = x · e 1
x .

Řešeńı:

Budeme procházet právě uvedený postup, přičemž budeme využ́ıvat možnost́ı Maple 14.

1. Definičńı obor funkce vid́ıme na prvńı pohled z jej́ıho předpisu. Funkce neńı definovaná
pouze v bodě nula, tedy D(f) = R \ {0}. K nalezeńı nulových bod̊u a interval̊u, kde je
funkce kladná, resp. záporná, využijeme př́ıkaz solve7. V tomto př́ıpadě však př́ıkaz
žádné řešeńı nenajde. Muśıme jej proto určit

”
sami“. Výraz e

1
x je pro libovolná x

kladný, z čehož plyne, že f(x) > 0 pro x > 0 a f(x) < 0 pro x < 0. Pro nalezeńı
nespojitost́ı použijeme př́ıkaz discont.

7Upozorněme, že př́ıkaz solve má jednu
”
nepř́ıjemnou“ vlastnost: v př́ıpadech, kdy nenalezne žádné

řešeńı, na výstup nic nevyṕı̌se a přejde na daľśı řádek.
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Obrázek 2.46: Řešeńı př́ıkladu 2.48 – bod 1.

2. Vypočteme f ′(x). Definičńı obor prvńı derivace je stejný jako u p̊uvodńı funkce, tedy
D(f ′) = R\{0}. Dále použijeme př́ıkaz solve. Nyńı již dostáváme všechny požadované
výsledky od Maple. Pro nalezeńı stacionárńıch bod̊u je možné též použ́ıt př́ıkaz extrema
vypisuj́ıćı funkčńı hodnoty ve stacionárńıch bodech. Prvńım parametrem př́ıkazu je
výraz, jehož stacionárńı body hledáme, druhým parametrem je množina omezuj́ıćıch
podmı́nek (když žádné nejsou, uvedeme prázdné složené závorky). Daľśım paramet-
rem je nezávisle proměnná zadané funkce a posledńım čtvrtým parametrem je název
proměnnné (v apostrofech), do ńıž se ulož́ı stacionárńı body – viz obrázek 2.47.

Obrázek 2.47: Řešeńı př́ıkladu 2.48 – bod 2.

3. Vypočteme f ′′(x) a do třetice použijeme př́ıkaz solve, který podobně jako poprvé

nezvládne vypoč́ıtat zkoumané nerovnosti. Jelikož je výraz e
1
x vždy kladný, můžeme

nerovnosti zjednodušit a hledat pouze znaménka výrazu x3. Vyhodnoceńım druhé de-
rivace ve stacionárńım bodě x = 1 zjist́ıme, že se jedná o lokálńı minimum.

4. Poč́ıtáme dř́ıve uvedené limity a zjǐst’ujeme, že zadaná funkce má asymptotu se směrnićı
tvaru y = x+ 1 a asyptotu bez směrnice v bodě x = 0 (obrázek 2.49).
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Obrázek 2.48: Řešeńı př́ıkladu 2.48 – bod 3.

Obrázek 2.49: Řešeńı př́ıkladu 2.48 – bod 4.

5. Vykresĺıme graf funkce f(x). Použijeme k tomu př́ıkaz plot, jemuž nastav́ıme několik
nepovinných parametr̊u pro lepš́ı vzhled. Do grafu vykresĺıme zadanou funkci f (červeně)
a asymptotu se směrnićı y = x + 1 (zeleně čárkovaně). Parametr discont nastav́ıme
na true, aby byla správně zobrazena nespojitost funkce f .
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Obrázek 2.50: Řešeńı př́ıkladu 2.48 – bod 5.

Př́ıklad 2.49: Vyšetřete pr̊uběh funkce f(x) = x
x2+1

.

Řešeńı:

1. Definičńı obor funkce f je celá množina reálných č́ısel, tj. D(f) = R. K nalezeńı
nulových bod̊u a interval̊u, kde je funkce kladná, resp. záporná, využijeme klasicky
př́ıkaz solve. Pro nalezeńı nespojitost́ı použijeme opět př́ıkaz discont.

Obrázek 2.51: Řešeńı př́ıkladu 2.49 – bod 1.

2. Postupujeme zcela analogicky předchoźımu př́ıkladu. D(f ′) = R.

3. Opět postupujeme stejně jako v př́ıkladu 2.48. Tentokrát však źıskáváme nulové body
druhé derivace zadané funkce. Jak vid́ıme z interval̊u konvexity a konkávity, všechny
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Obrázek 2.52: Řešeńı př́ıkladu 2.49 – bod 2.

tři źıskané body jsou body inflexńı. Stacionárńı body jsou dva, bod x = 1 je lokálńım
maximem funkce f a bod x = −1 jej́ım lokálńım minimem.

Obrázek 2.53: Řešeńı př́ıkladu 2.49 – bod 3.

4. Urč́ıme asymptoty se směrnićı a bez směrnice.

5. Vykresĺıme graf funkce f(x).
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Obrázek 2.54: Řešeńı př́ıkladu 2.49 – bod 4.

Obrázek 2.55: Řešeńı př́ıkladu 2.49 – bod 5.

69



Př́ıklad 2.50: Vyšetřete pr̊uběh funkce:

(a) f(x) = (x2 − 1)3,

(b) f(x) = x
3√x2−1

,

(c) f(x) = (x−1)3

x2
,

(d) f(x) = sin(x) + x,

(e) f(x) =

{
x2 · ln |x| . . . x 6= 0

0 . . . x = 0.

Při vyšetřováńı pr̊uběhu funkce nám mohou dále pomoci některé př́ıkazy nacházej́ıćı se
v baĺıku Student[Calculus1]. Představme si alespoň několik z nich. Př́ıkaz FunctionChart
zobraźı graf funkce (zadané jako výraz) s vyznačeńım významných bod̊u a funkčńıch vlast-
nost́ı. Na obrázku 2.56 jsou zobrazeny graf vyšetřovaných funkćı z př́ıklad̊u 2.48 a 2.49. Jsou
v něm znázorněny extrémńı a limitńı body, monotonie funkce a konvexita s konkávitou.

Obrázek 2.56: Použit́ı př́ıkazu FunctionChart z baĺıku Student[Calculus1].

Obrázek 2.57: Použit́ı př́ıkazu Asymptotes z baĺıku Student[Calculus1].
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Dı́ky daľśımu př́ıkazu, Asymptotes, źıskáme asymptoty funkce (zadané systému jako
výraz) se směrnićı i bez směrnice. Použit́ı na funkćıch z př́ıklad̊u 2.48 a 2.49 ilustruje obrázek
2.57.

Do baĺıku Student[Calculus1] dále nálež́ı př́ıkazy CriticalPoints pro hledáńı sta-
cionárńıch bod̊u, ExtremePoints pro hledáńı extrémů, InflectionPoints pro hledáńı in-
flexńıch bod̊u, Roots pro hledáńı kořen̊u a daľśı.

Závěrem uved’me ještě př́ıkazy RollesTheorem a MeanValueTheorem pro vizualizaci Rolle-
ovy věty, resp. Lagrangeovy věty o středńı hodnotě.

Obrázek 2.58: Ilustrace významných tvrzeńı př́ıkazy z baĺıku Student[Calculus1].

Poznámka 2.17: Rolleova věta: Necht’ funkce f splňuje tyto předpoklady:

(1) Je spojitá na uzavřeném intervalu [a, b].

(2) V každém bodě otevřeného intervalu (a, b) má vlastńı nebo nevlastńı derivaci.

(3) Plat́ı f(a) = f(b).

Pak existuje č́ıslo c ∈ (a, b) tak, že f ′(c) = 0.

Poznámka 2.18: Lagrangeova věta o středńı hodnotě: Necht’ funkce f splňuje tyto
předpoklady:

(1) Je spojitá na uzavřeném intervalu [a, b].

(2) V každém bodě otevřeného intervalu (a, b) má vlastńı nebo nevlastńı derivaci.

Pak existuje č́ıslo c ∈ (a, b) tak, že plat́ı f ′(c) = f(b)−f(a)
b−a .
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2.7 Integrál funkce

2.7.1 Neurčitý integrál

Definice 2.19: Řekneme, že funkce F (x) je na intervalu I primitivńı funkćı k f(x), jestliže
pro všechna x ∈ I plat́ı F ′(x) = f(x).

Poznámka 2.19: Ke každé funkci f(x) spojité na I existuje na intervalu I nekonečně
mnoho primitivńıch funkćı lǐśıćıch se o tzv. integračńı konstantu.

Definice 2.20: Množinu všech primitivńıch funkćı k funkci f(x) nazýváme neurčitý in-
tegrál a znač́ıme ∫

f(x) dx.

Poznámka 2.20: Necht’ F (x) je primitivńı k funkci f(x). Pak plat́ı:∫
f(x) dx = F (x) + C,

kde C ∈ R je integračńı konstanta.

V systému Maple máme opět několik možnost́ı, jak spoč́ıtat integrál ze zadané funkce,
přesněji řečeno, jak k této funkci určit funkci primitivńı. Systém Maple totiž k výsledk̊um
nepřidává integračńı konstantu (resp. ji pokládá standardně rovnu 0), což muśıme mı́t stále
na paměti.

Při výpočtu můžeme využ́ıt symbol pro integrováńı z palety Expression, př́ıkaz int,
jehož parametry jsou výraz, který chceme integrovat, a proměnná podle ńıž integrujeme.
Nakonec můžeme zapsat výraz do dokumentu, kliknout na něj pravým tlač́ıtkem myši a z
kontextové nab́ıdky zvolit Integrate a následně proměnnou, podle ńıž chceme integrovat
(viz obrázek 2.59).

Obrázek 2.59: Výpočet primitivńı funkce.

K výpočtu integrál̊u se nejčastěji použ́ıvaj́ı 2 základńı metody - metoda per partes a sub-
stitučńı metoda.
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Poznámka 2.21: Metoda per partes vycháźı z pravidla pro derivaci součinu. Jej́ı předpis
pro funkce u(x) a v(x) (které maj́ı na daném intervalu spojité derivace) vypadá následovně:∫

u(x) · v′(x) dx = u(x) · v(x)−
∫
u′(x) · v(x) dx.

Substitučńı metoda poskytuje řešeńı pro integraci složené funkce. Jestliže F (x) je primitivńı
funkćı k f(x) a funkce ϕ(x) má derivaci v každém bodě svého definičńıho oboru, pak plat́ı:∫

f(ϕ(x)) · ϕ′(x) dx =

∫
f(t) dt = F (t) = F (ϕ(x))

při substituci t = ϕ(x).

2.7.2 Metoda per partes

Systém Maple obsahuje baĺık s názvem IntegrationTools. Pro aplikaci metody per partes
slouž́ı př́ıkaz Parts maj́ıćı dva parametry – integrál, který chceme určit, a funkci, jej́ıž
derivaci chceme poč́ıtat (v poznámce 2.21 tomu odpov́ıdá funkce u(x)). Pro zápis integrálu
se v tomto př́ıpadě použ́ıvá př́ıkaz Int8, který vytvoř́ı integrál symbolicky a nevyhodnot́ı jej
(narozd́ıl od př́ıkazu int). Pro vyhodnoceńı symbolicky zapsaného výrazu můžeme použ́ıt
př́ıkaz value.

Př́ıklad 2.51: Pomoćı metody per partes určete
∫
x · ex dx.

Řešeńı: V systému Maple použijeme výše popsané př́ıkazy. Při aplikaci metody per partes
máme vždy v́ıce možnost́ı9, jak volit funkci, která se bude derivovat. Některé možnosti vedou
k ćıli, jiné ne, jak je vidět i na tomto řešeńı (obrázek 2.60). Druhá volba funkce, která se má
derivovat, vedla k ještě výpočetně náročněǰśımu integrálu, než byl v zadáńı.

Př́ıklad 2.52: Pomoćı metody per partes určete
∫
x2 · sin(x) dx.

Řešeńı: Aplikujeme stejný postup jako v předchoźım př́ıkladu10. Přestože zvoĺıme vhodně
funkci, která se bude derivovat, nedospějeme hned k výsledku. Metodu per partes je třeba
v některých př́ıpadech aplikovat v́ıcekrát, a toto je právě jeden z nich. Takže metodu per
partes aplikujeme na źıskaný výsledek ještě jednou a źıskáme hledané řešeńı (které opět
vyhodnot́ıme př́ıkazem value).

2.7.3 Substitučńı metoda

Pro aplikaci substitučńı metody slouž́ı př́ıkaz Change, opět z baĺıku IntegrationTools.
Př́ıkaz má dva parametry (zcela analogicky k př́ıkazu Parts) – integrál, který chceme určit,
a substituci, již zamýšĺıme použ́ıt.

Zavedeńım substituce přejdeme k jiné proměnné, v ńıž také obdrž́ıme výsledek. Na
závěr se proto muśıme

”
vrátit“ k proměnné p̊uvodńı, což provedeme zavedeńım téže substi-

tuce (nazpět) pomoćı př́ıkazu subs. Př́ıkaz subs má 2 povinné parametry – substituce, jež
hodláme zavést, a výraz, v němž budou substituce aplikovány11.

8Pozor na to, že Maple rozlǐsuje malá a velká ṕısmena!
9Ve skutečnosti jich je nekonečně mnoho.

10Pouze nebudeme nač́ıtat baĺık IntegrationTools, nebot’ jsme jej načetli již dř́ıve.
11Upozorněme na rozd́ıl mezi př́ıkazy Change a subs. Př́ıkaz Change zavede substituci proměnných v za-

daném integrálu, zat́ımco př́ıkaz subs provede substituce v zadaném výrazu.
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Obrázek 2.60: Řešeńı př́ıkladu 2.51.

Obrázek 2.61: Řešeńı př́ıkladu 2.52.

Př́ıklad 2.53: Pomoćı substitučńı metody určete
∫

sin3(x) · cos(x) dx.

Řešeńı: Postupujeme analogicky jako v předchoźıch př́ıkladech. Pokud jsme při předchoźı
práci se systémem Maple nenačetli baĺık IntegrationTools, je třeba jej nač́ıst. Zavedeme
substituci, źıskáme

”
tabulkový“ integrál, který vyhodnot́ıme př́ıkazem value, a daľśı substi-
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tućı se vrát́ıme k p̊uvodńı proměnné.

Obrázek 2.62: Řešeńı př́ıkladu 2.53.

Při výpočtech integrál̊u se uplatňuj́ı i některé daľśı postupy jako např́ıklad rozklad na
parciálńı zlomky, pravidlo o integraci součtu funkćı, či pravidlo o integraci funkce násobené
konstantou (podrobnosti najdeme též v nápovědě systému). Pro rozklad na parciálńı zlomky
je možné použ́ıt již dř́ıve zmı́něný př́ıkaz convert s parametrem parfrac.

Př́ıklad 2.54: Pomoćı vhodné metody (resp. vhodného postupu) určete následuj́ıćı in-
tegrály. Př́ıkazem int následně ověřte správnost vašeho výpočtu.

(a)
∫

5·x2−3√
x

dx,

(b)
∫ √

x4−2+x−4

x3
dx,

(c)
∫

(x− 1) · (x− 2) · (x− 3) dx,

(d)
∫

x
(x−1)·(x−2)2

dx,

(e)
∫

1
x3+1

dx,

(f)
∫

cos(5 · x+ 6) dx,

(g)
∫

1
x·ln(x)

dx,

(h)
∫
x ·
√
x2 + 1 dx,

(i)
∫
x · cos2(x) dx,

(j)
∫
x · ln(x) dx,

(k)
∫

arctan(x) dx,

(l)
∫
x3 · ex2 dx.

Již jsme se setkali s výukovými nástroji pro výpočet limit a derivaćı. Podobný nástroj
je k dispozici i pro integrováńı. Spust́ıme jej z hlavńı nab́ıdky zvoleńım Tools > Tutors >
Calculus – Single Variable > Integration Methods.... Maplet nás krok po kroku povede
výpočtem zadaného integrálu, nab́ıźı tradičně nápovědu k jednotlivým krok̊um a pravidla,
která je možno použ́ıt (viz obrázek 2.63).
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Obrázek 2.63: Výukový nástroj pro poč́ıtáńı integrál̊u.

2.7.4 Určitý integrál

Definice 2.21: Mějme funkci f(x), která je ohraničená na uzavřeném intervalu [a, b].
Rozdělme interval [a, b] na n podinterval̊u a označme toto děleńı d. Délku i-tého podin-
tervalu (pro i = 1, 2, ..., n) i samotný podinterval označme stejným symbolem ∆xi. Označme
dále mi infimum f(x) pro x ∈ ∆xi a Mi supremum f(x) na tomtéž intervalu. Nyńı definujeme
dolńı integrálńı součet předpisem:

s(d) =
n∑
i=1

mi ·∆xi

a horńı integrálńı součet předpisem:

S(d) =
n∑
i=1

Mi ·∆xi.

Definice 2.22: Necht’ plat́ı předpoklady a označeńı definice 2.21. Nyńı definujeme dolńı
integrál jako supremum všech dolńıch integrálńıch součt̊u (pro r̊uzná děleńı d), tj.:

b∫
a

f(x) dx = sup
d
s(d)
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a horńı integrál jako infimum všech horńıch integrálńıch součt̊u (pro r̊uzná děleńı d), tj.:

b∫
a

f(x) dx = inf
d
S(d).

Definice 2.23: Jestliže plat́ı:

b∫
a

f(x) dx =

∫ b

a

f(x) dx,

pak řekneme, že ohraničená funkce f(x) je na intervalu [a, b] integrovatelná (resp. má určitý
integrál). Společnou hodnotu z předchoźı rovnosti nazýváme Riemannovým integrálem z funkce
f(x) na intervalu [a, b] a znač́ıme:

b∫
a

f(x) dx.

Poznámka 2.22: (Newtonova-Leibnizova formule) Jestliže je funkce f(x) na intervalu
[a, b] integrovatelná, funkce F (x) na intervalu [a, b] spojitá a primitivńı k f(x), pak plat́ı:

b∫
a

f(x) dx = [F (x)]ba = F (b)− F (a).

K výpočtu určitého integrálu systém Maple nab́ıźı předdefinovaný symbol v paletě Ex-
pression. Je možné použ́ıt i př́ıkaz int podobně jako pro neurčitý integrál s t́ım rozd́ılem, že
nyńı při specifikaci proměnné, podle ńıž integrujeme, uvád́ıme i jej́ı rozsah (rozsah integrace).

Obrázek 2.64: Výpočet určitého integrálu.

77



Obrázek 2.65: Výpočet určitého integrálu pomoćı Newtonovy-Leibnizovy formule.

Je samozřejmě možné využ́ıt i Newtonovy-Leibnizovy formule, přičemž si pomůžeme
př́ıkazem unapply pro převod výrazu na funkci. Na tomto př́ıkladu si můžeme všimnout, že
r̊uznými postupy je možné doj́ıt ke stejnému, ale jinak upravenému výsledku.

Pro geometrickou interpretaci určitého integrálu a názorné zobrazeńı dř́ıve definovaných
pojmů (dolńı integrálńı součet, horńı integrálńı součet, ...) poskytuje systém Maple př́ıkaz
RiemannSum z baĺıku Student[Calculus1]. Př́ıkaz má dva povinné argumenty, a to funkci,
již chceme integrovat, a interval, přes který chceme integrovat. Pokud zadáme jen tyto pa-
rametry, př́ıkaz vypoč́ıtá integrálńı součet pro funkčńı hodnoty ve středech podinterval̊u
vzniklých rozděleńım p̊uvodńıho intervalu a vyṕı̌se hodnotu tohoto součtu. K dispozici je
však několik parametr̊u, které můžeme nastavit.

Obrázek 2.66: Geometrická interpretace určitého integrálu – vykresleńı.

Prvńım je parametr method určuj́ıćı, jakou metodou budou voleny funkčńı hodnoty
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v podintervalech vzniklých z rozděleńı p̊uvodńıho intervalu. Pro dolńı integrálńı součet
použijeme nastaveńı method=lower, pro horńı integrálńı součet nastaveńı method=upper

(základńı nastaveńı odpov́ıdá zápisu method=midpoint). Daľśım parametrem je output

(výstup). Pro nás jsou zaj́ımavé zejména možnosti output=plot (zobraźı funkci v grafu
i s děleńım p̊uvodńıho intervalu a základńımi informacemi) a output=animation (vytvoř́ı
animaci sestávaj́ıćı z graf̊u v př́ıpadě output=plot pro r̊uzně jemná děleńı p̊uvodńıho inter-
valu)12. Nakonec uved’me ještě parametr partition specifikuj́ıćı děleńı p̊uvodńıho intervalu.
Parametru je možné přǐradit č́ıslo (v tom př́ıpadě se p̊uvodńı interval rozděĺı na zadaný počet
stejně velkých interval̊u) nebo seznam bod̊u, v nichž se má p̊uvodńı interval rozdělit.

Obrázek 2.67: Geometrická interpretace určitého integrálu – animace.

Pokud nechceme použ́ıvat př́ıkaz RiemannSum, je možné využ́ıt daľśı z nástroj̊u systému
Maple, který nalezneme v menu zvoleńım Tools > Tutors > Calculus – Single Variable
> Approximate Integration.... V tomto mapletu (obrázek 2.68) můžeme zadat funkci,
interval, počet podinterval̊u tohoto intervalu a zvolit metodu, která bude použita k výpočtu
určitého integrálu. Na výběr máme přitom i několik daľśıch metod kromě Riemannových
součt̊u. Maplet také nab́ıźı srovnáńı provedené aproximace integrálu a jeho skutečné hodnoty.
Přesto tento nástroj postrádá některé možnosti, které nám poskytuje př́ıkaz RiemannSum.

Př́ıklad 2.55: Pomoćı vhodné metody (resp. vhodného postupu) aplikované pomoćı exis-
tuj́ıćıch př́ıkaz̊u určete následuj́ıćı integrály. Př́ıkazem int následně ověřte správnost vašeho
výpočtu.

(a)
1∫
0

arctan(x) dx, (b)
9∫
1

1
1+
√
x
dx,

12V animaci tak můžeme sledovat, jak se pro r̊uzně jemná děleńı p̊uvodńıho intervalu měńı hodnota
aproximace integrálu.
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Obrázek 2.68: Maplet pro přibližný výpočet určitého integrálu a jeho geometrická interpretace.

(c)

π
4∫

0

sin(x) · cos2(x) dx,

(d)
ln(3)∫
ln(2)

ex

e2·x−1
dx,

(e)
2·π∫
0

x2 · cos(x) dx,

(f)
ln(2)∫
0

√
ex − 1 dx.

2.7.5 Aplikace určitého integrálu

Obsah plochy

Již z geometrické interpretace určitého integrálu vid́ıme jednu z jeho možných aplikaćı pro
řešeńı praktických úloh, a tou je výpočet obsahu plochy vymezené dvěma (př́ıpadně i v́ıce)
křivkami.

Poznámka 2.23: Necht’ f(x) je na intervalu [a, b] nezáporná integrovatelná funkce. Pak
pro obsah S plochy vymezené funkćı f(x), osou x a př́ımkami x = a, x = b plat́ı:

S =

b∫
a

f(x) dx.

Pokud je naopak funkce f(x) na tomto intervalu nekladná, pak pro obsah S plochy vymezené
týmiž křivkami plat́ı:

S = −
b∫

a

f(x) dx.
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Z předchoźı poznámky můžeme odvodit i jak poč́ıtat obsah plochy v př́ıpadě, kdy funkce
f(x) na intervalu [a, b] prot́ıná osu x (interval rozděĺıme na podintervaly, v nichž je funkce
nezáporná, a podintervaly, v nichž je nekladná). Podobně můžeme odvodit, že pro výpočet
obsahu S plochy vymezené funkcemi f(x), g(x) (f(x) ≥ g(x)), a př́ımkami x = a, x = b
plat́ı:

S =

b∫
a

(f(x)− g(x)) dx.

Př́ıklad 2.56: Určete obsah plochy vymezené křivkami x2 a x3.
Řešeńı: V zadáńı př́ıkladu neńı zmı́něn interval, na kterém se plocha nacháźı, nebot’ in-

terval urč́ı samotné křivky x2 a x3 prot́ınaj́ıćı se právě ve dvou bodech. Souřadnice pr̊useč́ık̊u
na ose x tvoř́ı hledané body a a b. Pr̊useč́ıky zadaných funkćı zjist́ıme např. př́ıkazem solve.
Poté stač́ı pouze

”
dosadit do vzorečku“13. Plochu, jej́ıž obsah poč́ıtáme, můžeme zobrazit též

graficky. K vybarveńı plochy mezi funkcemi využijeme př́ıkaz implicitplot z baĺıku plots

(viz obrázek 2.69).

Obrázek 2.69: Řešeńı př́ıkladu 2.56.

13Ještě je třeba vědět, která ze zadaných funkćı je na źıskaném intervalu
”
větš́ı“.
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Funkce je možné zadávat též parametricky, a to např́ıklad rovnicemi x = ϕ(t),
y = ψ(t), t ∈ [a, b].

Poznámka 2.24: Necht’ je funkce f zadána rovnicemi
x = ϕ(t), y = ψ(t), t ∈ [a, b], přičemž funkce ϕ(t), ψ(t) jsou spojité pro t ∈ [α, β]. Je-li ϕ(t)
ryze monotonńı a má spojitou derivaci na [a, b], přičemž ϕ(α) = a, ϕ(β) = b, pak pro obsah
S plochy vymezené funkćı f(x), osou x a př́ımkami x = a, x = b plat́ı:

S =

∣∣∣∣∣∣
β∫
α

ψ(t) · ϕ′(t) dt

∣∣∣∣∣∣ .

Př́ıklad 2.57: Určete obsah plochy vymezené osou x a funkćı zadanou rovnicemi
x = t− sin(t), y = 1− cos(t), t ∈ [0, 2 · π].

Řešeńı: Funkce x = t− sin(t) je na [0, 2 ·π] ryze monotonńı a má spojitou derivaci, takže
můžeme využ́ıt předchoźı poznámku. Při vykreslováńı plochy využijeme atributu filled,
jenž nastav́ıme na hodnotu true. T́ım dosáhneme vykresleńı plochy pod křivkou funkce až
k ose x. Současně nastav́ıme atribut scaling na hodnotu constrained, abychom měli na
obou osách stejné měř́ıtko (a graf funkce tak nebyl zkreslený).

Obrázek 2.70: Řešeńı př́ıkladu 2.57.

Př́ıklad 2.58: Určete obsah plochy ohraničené křivkami:
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(a) y = 4− x2, y = x2,

(b) y = x3, y = −x, y = 1,

(c) y = x2, x = y2,

(d) y = tan(x), y = 0, x = π
4
,

(e) y = ex, y = e−x, y = 2.

Př́ıklad 2.59: Určete obsah plochy ohraničené:

(a) funkćı y = x2 − 2 · x+ 2, jej́ı tečnou v bodě [3, 5] a souřadnými osami,

(b) funkćı y = x3 a tečnou v bodě x = 1,

(c) parabolou y = x2 − 6 · x+ 8 a tečnami v bodech [1, 3] a [4, 0].

Př́ıklad 2.60: Určete obsah plochy ohraničené osou x a křivkou zadanou parametricky:

(a) x = 3 · t2, y = 3 · t− t3, t ∈ [−
√

3,
√

3],

(b) x = 2 · (t− sin(t)), y = 2 · (1− cos(t)), t ∈ [0, 2 · π],

(c) x = 3 · sin3(t), y = 3 · cos3(t), t ∈ [0, π].

Př́ıklad 2.61: Odvod’te vzorec pro obsah kruhu o poloměru r.

Délka oblouku křivky

Poznámka 2.25: Necht’ má funkce f(x) spojitou derivaci na intervalu [a, b]. Pak pro délku
křivky l funkce f(x) od bodu a k bodu b plat́ı:

l =

b∫
a

√
1 + (f ′(x))2 dx.

Poznámka 2.26: Necht’ je funkce f zadána parametricky rovnicemi x = ϕ(t), y = ψ(t), t ∈
[α, β], přičemž funkce ϕ(t), ψ(t) maj́ı spojité derivace pro t ∈ [α, β]. Pak pro délku křivky l
funkce f od α k β plat́ı:

l =

β∫
α

√
(ϕ′(t))2 + (ψ′(t))2 dt.

Př́ıklad 2.62: Určete délku křivky funkce y = ln(x) mezi body x = 1 a x = 10.
Řešeńı: Funkce (ln(x))′ = 1

x
je spojitá na [1, 10], můžeme tedy využ́ıt poznámky 2.25,

př́ıpadně př́ıkazu ArcLength z baĺıku Student[Calculus1] (obrázek 2.71).

Př́ıklad 2.63: Určete délku křivky zadané parametricky rovnicemi x = cos3(t), y = sin3(t),
t ∈ [0, 2 · π].

Řešeńı: Funkce cos3(t), sin3(t) maj́ı na intervalu [0, 2 · π] spojité derivace, takže můžeme
využ́ıt poznámky 2.26, př́ıpadně opět př́ıkazu ArcLength z baĺıku Student[Calculus1]

(obrázek 2.72).
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Obrázek 2.71: Řešeńı př́ıkladu 2.62.

Obrázek 2.72: Řešeńı př́ıkladu 2.63.

Př́ıklad 2.64: Určete délku křivky:
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(a) y2 = x3 na intervalu [0, 1],

(b) y = ex+e−x

2
na intervalu [−1, 1],

(c) y = sin(x) na intervalu [0, π],

(d) y = sin2(x) na intervalu [0, π].

Př́ıklad 2.65: Určete délku křivky zadané parametricky:

(a) x = t2, y = t− t3

3
, t ∈ [0,

√
3],

(b) x = t · cos(t), y = t · sin(t), t ∈ [0, 4 · π],

(c) x = cos(t) + t · sin(t), y = sin(t)− t · cos(t), t ∈ [0, 2 · π].

Př́ıklad 2.66: Odvod’te vzorec pro délku kružnice o poloměru r.

Objem rotačńıho tělesa

Poznámka 2.27: Necht’ je funkce f(x) spojitá a nezáporná na intervalu [a, b]. Pak rotačńı
těleso vzniklé rotaćı křivočarého lichoběžńıka ohraničeného shora funkćı f(x), osou x a př́ımkami
x = a, x = b kolem osy x má objem V :

V = π ·
b∫

a

f 2(x) dx.

Poznámka 2.28: Necht’ je funkce f zadána parametricky rovnicemi x = ϕ(t), y = ψ(t), t ∈
[α, β], přičemž funkce ϕ(t) má spojitou derivaci pro t ∈ [α, β] a funkce ψ(t) je spojitá
a nezáporná pro t ∈ [α, β]. Pak pro objem V rotačńıho tělesa vzniklého rotaćı oblasti x ∈
[ϕ(α), ϕ(β)] a y ∈ [0, ψ(t)] kolem osy x plat́ı:

V = π ·
β∫
α

ψ2(t) · |ϕ′(t)| dt.

Př́ıklad 2.67: Vypočtěte objem tělesa, které vznikne rotaćı oblasti ohraničené křivkami
y = x2, y = 2− x2 kolem osy x.

Řešeńı: Objem budeme poč́ıtat podobně, jako když poč́ıtáme obsah plochy vymezené
dvěma křivkami. Přesněji řečeno: vypočteme objem rotačńıho tělesa, které vznikne rotaćı
funkce y = 2 − x2 kolem osy x, a od něj odečteme objem tělesa, které vznikne rotaćı
funkce y = x2 kolem osy x. Jelikož obě funkce splňuj́ı předpoklady poznámky 2.27, můžeme
k výpočtu objemu použ́ıt uvedený vztah. V systému Maple lze jednak vykreslit zadanou
oblast, která má rotovat kolem osy x, dále můžeme využ́ıt př́ıkazu plot3d pro vykres-
lováńı trojrozměrných graf̊u, př́ıkazu animate pro vytvořeńı animace a v neposledńı řadě
také př́ıkazu VolumeOfRevolution z baĺıku Student[Calculus1]. Nastaveńım parametru
coords=cylindrical vytvoř́ıme rotačńı těleso vzniklé rotaćı kolem jedné z os. Dále nastavu-
jeme parametry jako úhel, o nějž má zadaná (resp. zadané) funkce rotovat, a interval oblasti
– obrázky 2.73 a 2.74.
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Obrázek 2.73: Řešeńı př́ıkladu 2.67.

Obrázek 2.74: Řešeńı př́ıkladu 2.67.

Poznámka 2.29: Mějme funkci zadanou parametricky rovnicemi x = f(t), y = g(t), z =
h(t), t ∈ [α, β]. Pak těleso vzniklé rotaćı této funkce kolem osy x je popsáno parametricky
rovnicemi x = f(t), y =

√
g(t)2 + h(t)2 · cos(s), z =

√
g(t)2 + h(t)2 · sin(s), t ∈ [α, β], s ∈

[0, 2 · π].
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Př́ıklad 2.68: Vypočtěte objem tělesa, které vznikne rotaćı plochy vymezené křivkou za-
danou parametricky rovnicemi x = t− sin(t), y = 1− cos(t), t ∈ [0, 2 · π] a osou x kolem této
osy.

Řešeńı: Zadaná křivka splňuje předpoklady poznámky 2.28. Výpočet objemu tedy pro-
vedeme dosazeńım do př́ıslušného vzorce. V systému Maple opět vykresĺıme zadanou ob-
last, která má rotovat kolem osy x, a poté i źıskané těleso pomoćı př́ıkazu plot3d. Přitom
využijeme poznámky 2.29 – obrázek 2.75.

Obrázek 2.75: Řešeńı př́ıkladu 2.68.

Př́ıklad 2.69: Určete objem tělesa vzniklého rotaćı plochy ohraničené zadanými křivkami
kolem osy x:

(a) y2 = x, y = x2,

(b) y = 0, x = 0, y = sin(x), x = π,

(c) y = x, y = 1
x
, y = 2,

(d) x2 + y2 = 4, x+ y = 2.

Př́ıklad 2.70: Určete objem tělesa, které vznikne rotaćı plochy ohraničené křivkou zada-
nou parametricky a osou x kolem této osy:

(a) x = t2, y = t− t3

3
, t ∈ [0,

√
3],

(b) x = 3 · sin3(t), y = 3 · cos3(t), t ∈ [−π
2
, π

2
],

(c) x = sin2(t), y = 1− cos(t), t ∈ [0, π],

(d) x = 2 + sin(t), y = 2 + cos(t), t ∈ [0, 2 · π].

Př́ıklad 2.71: Odvod’te vzorec pro objem koule o poloměru r.
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Př́ıklad 2.72: Odvod’te vzorec pro objem válce o poloměru podstavy r a výšce válce v.

Př́ıklad 2.73: Odvod’te vzorec pro objem kužele o poloměru podstavy r a výšce kužele v.

Obsah pláště rotačńıho tělesa

Poznámka 2.30: Necht’ je funkce f(x) spojitá a nezáporná na intervalu [a, b] a má zde
spojitou derivaci. Pak pro obsah S rotačńı plochy vzniklé rotaćı křivky y = f(x) kolem osy
x plat́ı:

S = 2 · π ·
b∫

a

f(x) ·
√

1 + (f ′(x))2 dx.

Poznámka 2.31: Necht’ je funkce f zadána parametricky rovnicemi x = ϕ(t), y = ψ(t), t ∈
[α, β], přičemž funkce ϕ(t) a ψ(t) maj́ı spojité derivace pro t ∈ [α, β] a funkce ψ(t) je
nezáporná pro t ∈ [α, β]. Pak pro obsah S rotačńı plochy vzniklé rotaćı grafu funkce f kolem
osy x plat́ı:

S = 2 · π ·
β∫
α

ψ(t) ·
√

(ϕ′(t))2 + (ψ′(t))2 dt.

Př́ıklad 2.74: Vypočtěte obsah pláště rotačńıho kužele, který vznikne rotaćı funkce y = x
pro x ∈ [0, 3] kolem osy x.

Řešeńı: Jelikož plat́ı všechny předpoklady poznámky 2.30, stač́ı dosadit do uvedeného
vzorce. K dispozici máme také př́ıkaz SurfaceOfRevolution z baĺıku Student[Calculus1]

(obrázek 2.76).

Př́ıklad 2.75: Vypočtěte obsah pláště tělesa, které vznikne rotaćı křivky zadanou para-
metricky rovnicemi x = cos3(t), y = sin3(t), t ∈ [0, π] kolem osy x.

Řešeńı: Zadaná křivka splňuje všechny předpoklady poznámky 2.31. Použijeme proto
př́ıslušný vztah pro výpočet obsahu pláště (obrázek 2.77).

Př́ıklad 2.76: Určete obsah pláště tělesa vzniklého rotaćı plochy ohraničené zadanými
křivkami kolem osy x:

(a) y2 = x, y = x2,

(b) y = 0, x = 0, y = sin(x), x = π,

(c) y = x, y = 1
x
, y = 2,

(d) x2 + y2 = 4, x+ y = 2.
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Obrázek 2.76: Řešeńı př́ıkladu 2.74.

Obrázek 2.77: Řešeńı př́ıkladu 2.75.
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Př́ıklad 2.77: Určete obsah pláště tělesa, které vznikne rotaćı plochy ohraničené křivkou
zadanou parametricky a osou x kolem této osy:

(a) x = t2, y = t− t3

3
, t ∈ [0,

√
3],

(b) x = 3 · sin3(t), y = 3 · cos3(t), t ∈ [−π
2
, π

2
],

(c) x = sin2(t), y = 1− cos(t), t ∈ [0, π],

(d) x = 2 + sin(t), y = 2 + cos(t), t ∈ [0, 2 · π].

Př́ıklad 2.78: Odvod’te vzorec pro povrch koule o poloměru r.

Př́ıklad 2.79: Odvod’te vzorec pro povrch válce o poloměru podstavy r a výšce válce v.

Dř́ıve uvedené př́ıkazy baĺıku Student[Calculus1], tedy př́ıkazy ArcLength, VolumeOfRevolution
a SurfaceOfRevolution, jsou k dispozici i ve formě maplet̊u, jež najdeme v hlavńım menu
(Tools > Tutors > Calculus − Single Variable).

2.7.6 Nevlastńı integrál

Definice 2.24: Necht’ je funkce f(x) integrovatelná v každém intervalu [a, t], kde a < t < b,

a necht’ je f(x) neohraničená v levém okoĺı bodu b. Existuje-li vlastńı limita lim
t→b−

t∫
a

f(x) dx,

pak řekneme, že integrál
b∫
a

f(x) dx konverguje, a klademe

b∫
a

f(x) dx = lim
t→b−

t∫
a

f(x) dx.

Pokud zmı́něná limita neexistuje nebo je nevlastńı, ř́ıkáme, že integrál
b∫
a

f(x) dx diverguje.

Poznámka 2.32: V př́ıpadě neohraničenosti funkce f(x) na intervalu [a, b] v pravém okoĺı

bodu a definujeme integrál
b∫
a

f(x) dx analogicky.

Př́ıklad 2.80: Určete
1∫
0

1√
1−x2 dx.

Řešeńı: V systému Maple obdrž́ıme řešeńı automaticky pouhým zadáńım integrálu a pro-

vedeńım př́ıkazu. Muśıme si však uvědomit, že zadaná funkce
(

1√
1−x2

)
neńı v bodě 1 spojitá

a na intervalu [0, 1] ohraničená! Správně bychom se tedy měli o źıskaném výsledku přesvědčit
určeńım limity z definice 2.24.

Př́ıklad 2.81: Určete
1∫
0

x · ln(x) dx.
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Obrázek 2.78: Řešeńı př́ıkladu 2.80.

Poznámka 2.33: Pokud je funkce f(x) neohraničená na intervalu [a, b] v pravém okoĺı
bodu a i v levém okoĺı bodu b, rozděĺıme interval [a, b] libovolným bodem c ∈ (a, b), č́ımž
přejdeme k př́ıpad̊um popsaným v definici 2.24 a poznámce 2.32.

Definice 2.25: Necht’ je funkce f(x) integrovatelná v každém intervalu [a, b], kde a < b.

Existuje-li vlastńı limita lim
b→∞

b∫
a

f(x) dx, pak řekneme, že integrál
∞∫
a

f(x) dx konverguje,

a klademe
∞∫
a

f(x) dx = lim
b→∞

b∫
a

f(x) dx.

Neexistuje-li zmı́něná vlastńı limita, ř́ıkáme, že integrál
∞∫
a

f(x) dx diverguje.

Poznámka 2.34: Analogicky definujeme nevlastńı integrál
b∫
−∞

f(x) dx. Je-li funkce f inte-

grovatelná na každém omezeném intervalu, pak řekneme že integrál
∞∫
−∞

f(x) dx konverguje,

jestliže pro nějaké a ∈ R konverguj́ı oba nevlastńı integrály
a∫
−∞

f(x) dx,
∞∫
a

f(x) dx a klademe

∞∫
−∞

f(x) dx =

a∫
−∞

f(x) dx+

∞∫
a

f(x) dx.

Př́ıklad 2.82: Určete
∞∫
2

1
x2
dx.

Řešeńı: V systému Maple obdrž́ıme řešeńı opět automaticky pouhým zadáńım integrálu
a provedeńım př́ıkazu. Jako v předchoźım př́ıpadě bychom si však měli uvědomit, zda existuje

vlastńı limita lim
b→∞

b∫
2

1
x2
dx. Při výpočtu limity Maple zahláśı, že neumı́ určit, jestli b < 0.

Je možné mu
”
pomoci“ zavedeńım předpokladu, že b > 0, pomoćı př́ıkazu assume (obrázek

2.79).
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Obrázek 2.79: Řešeńı př́ıkladu 2.82.

Př́ıklad 2.83: Určete následuj́ıćı integrály:

(a)
∞∫
1

1√
x
dx,

(b)
∞∫
−∞

1
1+x2

dx,

(c)
∞∫
1

sin(x2) dx,

(d)
∞∫
0

x2+1
x3+1

dx.

Doposud jsme se setkali pouze s př́ıklady, kdy Maple umı́ nalézt symbolické řešeńı (při
použit́ı

”
standardńıch“ funkćı). Jsou však př́ıpady, kdy Maple zavád́ı funkce nové či symbo-

lické řešeńı nenalezne. Pokud Maple zahrne do výsledku novou funkci, najdeme jej́ı předpis
v nápovědě. Např́ıklad na obrázku 2.80 je v řešeńı zahrnuta tzv. chybová funkce erf(x)

s předpisem

erf(x) =

2 ·
(

x∫
0

e−t
2
dt

)
√
π

.

Jestliže Maple nenalezne symbolické řešeńı, vyṕı̌se námi zadaný př́ıkaz jako výsledek.
V př́ıpadě určitého integrálu můžeme hledat numerické řešeńı, a to bud’ přidáńım nepo-
vinného parametru numeric př́ıkazu int, nebo použit́ım př́ıkazu evalf na integrál zadaný
př́ıkazem Int14. Numerických metod pro výpočet určitého integrálu nab́ıźı Maple několik.
Mezi nimi je možné volit specifikaćı parametru method (v́ıce v nápovědě systému).

14Upozorněme na rozd́ıl v zadáńı evalf(Int(..)) a evalf(int(...)). Prvńı možnost vede na nume-
rické řešeńı zadaného integrálu, v druhém př́ıpadě je nejprve vyhodnocen integrál symbolicky př́ıkazem int

a následně výsledek převeden na numerickou hodnotu př́ıkazem evalf.
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Obrázek 2.80: Symbolická a numerická integrace.
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3 Matematická analýza s Maple v Rn

Ačkoli v sobě název kapitoly obsahuje prostor Rn, často se budeme omezovat na funkce dvou
proměnných, tedy prostor R2, pro nějž máme v systému Maple grafickou podporu.

3.1 Funkce v́ıce proměnných

3.1.1 Definice funkce v́ıce proměnných

Funkci v́ıce proměnných definujeme v systému Maple zcela analogicky k funkci jedné proměnné
(viz 2.2.1). V prostřed́ı Standard Worksheet použ́ıváme tytéž postupy, pouze

”
přidáváme“

proměnné - obrázky a .

Obrázek 3.1: Definice funkce dvou proměnných.

3.1.2 Vykresleńı funkce dvou proměnných

V závěru předchoźı kapitoly jsme se již setkali s př́ıkazem plot3d pro vykreslováńı troj-
rozměrných graf̊u. V systému Maple máme tedy možnost vykreslovat funkce dvou proměnných,
a to opět podobnými postupy jako v př́ıpadě funkce jedné proměnné. Prvńı zp̊usob nab́ıźı
kliknut́ı pravým tlač́ıtkem na funkci (resp. výraz) dvou proměnných v dokumentu a zvoleńı
Plots > 3-D Plot se specifikaćı proměnných. Daľśı možnost poskytuje pomocńık zvaný
PlotBuilder a nakonec máme k dispozici již zmı́něný př́ıkaz plot3d.

Narozd́ıl od vykreslováńı funkćı jedné proměnné Maple nyńı v grafu standardně nezobra-
zuje souřadnicové osy. Pokud je chceme zobrazit (a na výběr máme z několika typ̊u: normal,
boxed, framed), je třeba při tvorbě grafu specifikovat parametr axes. Graf je možné upra-
vovat i po jeho vytvořeńı kliknut́ım pravého tlač́ıtka myši a voleńım požadovaných parametr̊u
grafu z kontextové nab́ıdky. Kliknut́ım na graf a přidržeńım levého tlač́ıtka myši můžeme
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Obrázek 3.2: Definice funkce v́ıce proměnných.

s grafem funkce otáčet podle pohyb̊u myši, př́ıpadně provádět daľśı úpravy, které si předem
vybereme v kontextové lǐstě, resp. kontextovém menu.

Rozd́ıl mezi př́ıkazy plot a plot3d je také v povinnosti specifikovat rozsah nezávisle
proměnných. Zat́ımco u př́ıkazu plot se použije standardńı interval [−10, 10] při nezadáńı
rozsahu, př́ıkaz plot3d zadáńı rozsahu vyžaduje pro obě nezávisle proměnné, jinak se nepro-
vede a vyṕı̌se chybové hlášeńı.

Stejně jako v př́ıpadě funkce jedné proměnné muśıme i zde myslet na to, jak má graf
funkce vypadat a př́ıpadně vyzkoušet r̊uzná nastaveńı parametr̊u (tj. např. rozsah̊u nezávisle
proměnných), abychom dostali názorný graf. Některá zobrazeńı mohou velmi zkreslovat
(resp. zobrazovat graf funkce chybně).

Systém Maple kv̊uli efektivitě (rychlosti) vykreslováńı poč́ıtá funkčńı hodnoty1 jen v několika
bodech. Graf bývá zpravidla rozdělen na čtvercovou śıt’ bod̊u, v nichž je spoč́ıtána od-
pov́ıdaj́ıćı (funkčńı) hodnota. Parametry śıtě se pro r̊uzné typy graf̊u lǐśı, např́ıklad v Maple
16 je pro př́ıkaz plot3d standardně použita śıt’ 25x25 bod̊u, pro př́ıkaz implicitplot śıt’

26x26 bod̊u atp. Zbylé body grafu jsou źıskané lineárńı (rovinnou) interpolaćı.

Pokud chceme po systému přesněǰśı zobrazeńı, máme několik možnost́ı. Prvńı je omezeńı
rozsah̊u nezávisle proměnných (viz obrázek 3.4). Můžeme také nastavit parametr numpoints
určuj́ıćı, v kolika bodech bude vypoč́ıtána (funkčńı) hodnota. Daľśı možnost́ı je nastavit ex-
plicitně śıt’ poč́ıtaných bod̊u pomoćı parametru grid. Ten specifikujeme dvojićı v hranatých
závorkách: [počet bod̊u na ose x, počet bod̊u na ose y]2.

1Ve skutečnosti nemuśı j́ıt jen o funkčńı hodnoty, vykreslovat můžeme např́ıklad i hodnoty vyhovuj́ıćı
nějaké rovnosti (nerovnosti).

2Př́ıkazu implicitplot je možné nav́ıc nastavit parametr gridrefine, který
”
zjemňuje“ śıt’ poč́ıtaných

bod̊u. Standardńı nastaveńı je 0. Nastaveńı na hodnotu 1 (zjednodušeně) znamená, že mı́sto jedné (funkčńı)
hodnoty v daném mı́stě śıtě budou určeny dvě funkčńı hodnoty. Při daľśım zvyšováńı hodnoty parametru
gridrefine se vždy rekurzivně poč́ıtaj́ı dvě nové (funkčńı) hodnoty mı́sto jedné předcházej́ıćı. Vı́ce informaćı
nalezneme v nápovědě k př́ıkazu implicitplot.
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Obrázek 3.3: Vykresleńı funkce dvou proměnných pomoćı př́ıkazu plot3d.

Obrázek 3.4: Ukázka r̊uzných nastaveńı př́ıkazu plot3d.

3.1.3 Definičńı obor funkce dvou proměnných

Systém Maple nám dává možnosti, jak zakreslit do grafu dvourozměrnou (př́ıpadně i tř́ırozměrnou)
oblast. K zakresleńı dvourozměrné oblasti zadané implicitně (rovnost́ı či nerovnost́ı) slouž́ı
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Obrázek 3.5: Ukázka daľśıch nastaveńı př́ıkazu plot3d pro přesněǰśı vykresleńı.

př́ıkaz implicitplot z baĺıku plots. Pokud chceme zadanou oblast vyplnit, nastav́ıme pa-
rametr filled na hodnotu true.

Pro vykresleńı oblast́ı vymezených v́ıce nerovnostmi (resp. rovnostmi) je někdy nutné
použ́ıt jiný postup. Pokud je oblast vymezená lineárńımi nerovnostmi, je možné použ́ıt př́ıkaz
inequal z baĺıku plots.

Př́ıklad 3.1: Nakreslete oblast A = {(x, y) ∈ R2 : x2 + y2 < 1}.
Řešeńı: Použijeme př́ıkaz implicitplot, kterému nav́ıc specifikujeme i parametr view

pro rozsah souřadných os3 (obrázek 3.6).

Př́ıklad 3.2: Nakreslete oblast A = {(x, y) ∈ R2 : |x|+ |y| ≤ 1}.
Řešeńı: Právě v tomto př́ıpadě se projev́ı nedostatečný počet generovaých bod̊u pro

vykresleńı zadané oblasti. Využijeme proto parametru gridrefine, který poskytuje př́ıkaz
implicitplot (obrázek 3.7).

Př́ıklad 3.3: Nakreslete oblast A = {(x, y) ∈ R2 : x ≥ 0, y ≥ 0, x+ y < 1}.
Řešeńı: Požadovaná oblast je zadána třemi nerovnostmi, přičemž všechny jsou lineárńı.

Využijeme proto př́ıkazu inequal. Př́ıkaz má několik nepovinných parametr̊u, v nichž můžeme
např́ıklad specifikovat barvu, kterou budou vykreslovány body patř́ıćı (resp. nepatř́ıćı) do
zadané množiny (oblasti) nebo hraničńı body (obrázek 3.8).

3Neplést s nastaveńım rozsahu nezávisle proměnných!
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Obrázek 3.6: Řešeńı př́ıkladu 3.1.

Obrázek 3.7: Řešeńı př́ıkladu 3.2.
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Obrázek 3.8: Řešeńı př́ıkladu 3.3.

Př́ıklad 3.4: Nakreslete oblast:

(a) A = {(x, y) ∈ R2 : |x · y| ≤ 1},

(b) A = {(x, y) ∈ R2 : 0 ≤ x ≤ y ≤ 1},

(c) A = {(x, y) ∈ R2 : (x− 2)2 + y2 ≥ 1},

(d) A = {(x, y) ∈ R2 : 1 ≤ |x|+ |y| < 2},

(e) A = {(x, y) ∈ R2 : x < x2 + y2 ≤ 1}.

Vykreslováńı dvourozměrných oblast́ı využijeme při určováńı definičńıho oboru funkce
dvou proměnných. Systém Maple nemá žádný nástroj pro nalezeńı definičńıho oboru funkce,
nic nám však nebráńı využ́ıt jej při podúlohách vedoućıch k hledanému řešeńı.

Př́ıklad 3.5: Určete definičńı obor funkce f(x, y) =

√(
x2 + (y−2)2

4
− 1
)
· (x2 + y2 − 6 · x)

a zakreslete jej v rovině.
Řešeńı: Výraz pod odmocninou muśı být nezáporný, tj.(

x2 +
(y − 2)2

4
− 1

)
·
(
x2 + y2 − 6 · x

)
≥ 0.
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Předchoźı nerovnost se nám rozpadne na 2 př́ıpady, které bychom dále upravovali. V tuto
chv́ıli však již můžeme využ́ıt př́ıkazu implicitplot a př́ıslušnou oblast – definičńı obor
funkce f(x, y) – rovnou vykreslit. Opět je nutné specifikovat některý z parametr̊u

”
kvality“

zobrazeńı, použijeme proto např́ıklad znovu parametr gridrefine (obrázek 3.9).

Obrázek 3.9: Řešeńı př́ıkladu 3.5.

Př́ıklad 3.6: U následuj́ıćıch funkćı určete jejich definičńı obor a zobrazte jej v rovině:

(a) f(x, y) =
√

1− x2 − 4 · y2,

(b) f(x, y) =
√

sin(x2 + y2),

(c) f(x, y) = ln(x+ y),

(d) f(x, y) = arccos( x
x+y

),

(e) f(x, y) =
√

1− x2 +
√

1− y2,

(f) f(x, y) = ln (x · ln(y − x)).

V systému Maple je možné vykreslovat též vrstevnice funkćı dvou proměnných, tj. množiny
bod̊u se stejnou funkčńı hodnotou. Slouž́ı k tomu př́ıkaz contourplot, př́ıpadně je možné
vrstevnice zakreslit do grafu funkce nastaveńım parametru style př́ıkazu plot3d na hodnotu
patchcontour (lze nastavit i dodatečně v kontextové lǐstě či kontextovém menu).

Př́ıkaz̊um contourplot a plot3d můžeme dále zadat parametr contours určuj́ıćı, kolik
vrstevnic se zobraźı4, př́ıpadně jaké vrstevnice (tj. vrstevnice jakých funkčńıch hodnot)5 -
obrázek 3.10.

4zadáme přirozené č́ıslo
5zadáme seznam funkčńıch hodnot
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Obrázek 3.10: Zobrazeńı vrstevnic funkce dvou proměnných.

Př́ıklad 3.7: Zobrazte vrstevnice následuj́ıćıch funkćı:

(a) f(x, y) = x2 − y2,

(b) f(x, y) = 1
x2+y2

,

(c) f(x, y) = x
y
,

(d) f(x, y) = x · y.

3.2 Limita a spojitost funkce v́ıce proměnných

3.2.1 Limita funkce

Definice 3.1: Řekneme, že funkce f(x, y) má v bodě [x0, y0] ∈ R2 limitu L ∈ R, jestliže
ke každému ε > 0 existuje δ > 0 tak, že pro všechny [x, y] splňuj́ıćı |x− x0| < δ, |y− y0| < δ
a [x, y] 6= [x0, y0] plat́ı |f(x, y)− L| < ε, a ṕı̌seme

lim
(x,y)→(x0,y0)

f(x, y) = L.

Poznámka 3.1: Analogicky k vlastńım a nevlastńım bod̊um a limitám definujeme tyto
body i v prostoru R2. Limita se nazývá nevlastńı, jestliže je rovna ∞ nebo −∞. V opačném
př́ıpadě se nazývá vlastńı. Nevlastńı bod je bod s alespoň jednou souřadnićı rovnou∞ nebo
−∞, tj. bod typu [a,±∞] nebo [±∞, a], kde a ∈ R ∪ {−∞,∞}.

Poznámka 3.2: Taktéž analogicky definujeme př́ıslušné pojmy v prostoru dimenze větš́ı
než 2.
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Poznámka 3.3: Zásadńı rozd́ıl mezi limitou funkce jedné proměnné a limitou funkce dvou
proměnných spoč́ıvá v okoĺı limitńıho bodu a tedy směru přibližováńı k limitńımu bodu.
U funkce jedné proměnné se bĺıž́ıme pouze po jedné př́ımce (a to zleva nebo zprava). Naproti
tomu u funkce dvou (a v́ıce) proměnných se k limitńımu bodu bĺıž́ıme po r̊uzných př́ımkách,
parabolách či jiných množinách. Pokud v daném bodě limita existuje, nesmı́ záležet na cestě,
po jaké se k tomuto bodu přibližujeme.

V systému Maple máme možnost poč́ıtat limity funkćı dvou (i v́ıce) proměnných. Nemáme
k tomu však již symbol v paletě Expression, a tak muśıme použ́ıt př́ıkaz limit. Př́ıkaz
použ́ıváme jediný, limitńı bod zaṕı̌seme do složených závorek. Pokud bychom použili př́ıkaz
dvakrát za sebou vždy pro jednu proměnnou, tj. např. limit(limit(f(x,y),x=a),y=b),
nepoč́ıtali bychom dř́ıve definovanou limitu. K limitńımu bodu bychom se totiž v tomto
př́ıpadě bĺıžili pouze ve dvou směrech (nejprve po ose x a následně po ose y).

Obrázek 3.11: Výpočet limity funkce v́ıce proměnných.

Systém Maple limitu v mnohých př́ıpadech neumı́ určit, i když limita existuje. Často je
proto vhodněǰśı použ́ıt

”
klasický“ zp̊usob určeńı limity a Maple použ́ıt jako pomocńıka při

d́ılč́ıch výpočtech a pro vykresleńı funkce (výrazu) v bĺızkosti limitńıho bodu (pro vysloveńı
hypotézy o existenci limity a jej́ı hodnotě). Pokud je možné do výrazu, jehož limitu poč́ıtáme,
dosadit, řešeńı je triviálńı. Pokud při dosazeńı dostáváme neurčitý výraz typu

”
0
0
“ nebo

”
∞
∞“,

upravujeme p̊uvodńı výraz, abychom do něj mohli
”
dosadit“. Nejběžněǰśımi úpravami jsou

rozš́ı̌reńı zlomk̊u, použit́ı (součtových) vzorc̊u či substituce.
Kĺıčová je otázka, zda limita v̊ubec existuje. Pokud očekáváme, že zadaný výraz nemá

limitu, je možné využ́ıt přibližováńı k limitńımu bodu z r̊uzných směr̊u (tj. např. po r̊uzných
př́ımkách, po př́ımkách a po parabolách, ...). Pokud dostaneme r̊uzné výsledky (limity), li-
mita neexistuje. Často je využ́ıvána transformace do polárńıch souřadnic a následné přibližo-
váńı se k limitńımu bodu po kružnićıch. V tomto př́ıpadě je nutné mı́t na paměti, že výsledná
limita nesmı́ záviset na úhlu (ϕ) a že přibližováńı se po kružnici je opět pouze jeden z možných
zp̊usob̊u přibližováńı se k limitńımu bodu! Nicméně existuje tvrzeńı, které nám za jistých
předpoklad̊u dovoĺı určit limitu funkce (výrazu) použit́ım jen této metody.

Poznámka 3.4: Plat́ı-li pro funkci f(x, y) po transformaci do polárńıch souřadnic

lim
(x,y)→(x0,y0)

f(x, y) = lim
r→0+

h(r) · g(ϕ),

přičemž
lim
r→0+

h(r) = 0 a g(ϕ) je ohraničená pro ϕ ∈ [0, 2 · π),
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pak
lim

(x,y)→(x0,y0)
f(x, y) = 0.

Př́ıklad 3.8: Určete lim
(x,y)→(0,0)

1
x2+y2

.

Řešeńı: Právě v tomto př́ıpadě od systému Maple obdrž́ıme chybné řešeńı.

Obrázek 3.12: Pokus o źıskáńı řešeńı př́ıkladu 3.8 v Maple.

Již prvńı pohled nám napov́ıdá, že by limita měla existovat a měla být rovna∞. K určeńı
limity muśıme vyj́ıt z definice nevlastńı limity. Potřebujeme ukázat, že pro libovolně velké
M ∈ R existuje δ > 0 tak, že pro všechna [x, y] splňuj́ıćı |x| < δ, |y| < δ a [x, y] 6= [0, 0] plat́ı
f(x, y) > M .

Mějme proto libovolné, ale pevné M ∈ R. Položme δ = 1√
2·|M |

. Pro [x, y] splňuj́ıćı

|x| < δ, |y| < δ a [x, y] 6= [0, 0] nyńı plat́ı: x2 + y2 < 2 · δ2 = 1
|M | . Z toho už vid́ıme, že

skutečně f(x, y) > M pro tato [x, y], a tedy

lim
(x,y)→(0,0)

1

x2 + y2
=∞.

Př́ıklad 3.9: Určete lim
(x,y)→(0,0)

x2·y2
x2+y2

.

Řešeńı: Od systému Maple neźıskáme řešeńı. Nejprve muśıme
”
odhadnout“, zda limita

existuje a pokud ano, čemu je rovna. Z toho vyvod́ıme postup, jakým vyslovenou hypotézu
dokázat. Dı́ky tvaru zadáńı nemuśıme uvažovat nad změnami znamének, funkčńı hodnoty
jsou vždy nezáporné. Když se budou x a y bĺıžit k nule, budou

”
velmi malá“. Přitom pro

|x| < 1 a |y| < 1 plat́ı x2 + y2 > x2 · y2 a pod́ıl čitatele a jmenovatele bude t́ım menš́ı, č́ım
menš́ı (v absolutńı hodnotě) budou x a y. To nás přivád́ı na myšlenku, že limita existuje a je
rovná nule.

Nyńı bychom mohli opět postupovat podle definice. Vzali bychom libovolné, ale pevné ε
a k němu bychom

”
vytvořili“ δ tak, abychom splnili předpoklady definice 3.1 pro L = 0.
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Zkusme však k výpočtu limity použ́ıt transformaci do polárńıch souřadnic, tzn. provést
substituci: [x, y] = [r · cos(ϕ), r · sin(ϕ)].

Źıskali jsme (viz obrázek 3.13) výsledek tvaru r2 ·cos2(ϕ) ·sin2(ϕ). Aplikaćı poznámky 3.4
dostáváme h(r) = r2 a g(ϕ) = cos2(ϕ) · sin2(ϕ). Plat́ı, že lim

r→0+
h(r) = 0 a g(ϕ) je ohraničená

pro ϕ ∈ [0, 2 · π). Tedy

lim
(x,y)→(0,0)

x2 · y2

x2 + y2
= 0.

Př́ıklad 3.10: Určete lim
(x,y)→(0,0)

x2·y2
x2+y2

př́ımo z definice limity.

Obrázek 3.13: Řešeńı př́ıkladu 3.9.

Př́ıklad 3.11: Určete:

(a) lim
(x,y)→(0,0)

x−2·y
3·x+y

,

(b) lim
(x,y)→(0,0)

x3·y
x4+y4

,

(c) lim
(x,y)→(0,0)

x·y
x2+y2

,

(d) lim
(x,y)→(1,1)

x·y√
x2+y2

,

(e) lim
(x,y)→(0,0)

x·y√
x2+y2

,

(f) lim
(x,y)→(0,2)

sin(x·y)
x

,

(g) lim
(x,y)→(0,0)

√
x2+y2+1−1

x2+y2
.
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3.2.2 Spojitost funkce

Definice 3.2: Řekneme, že funkce f(x, y) je spojitá v bodě [x0, y0] ∈ R2, jestliže má
v tomto bodě vlastńı limitu a plat́ı

lim
(x,y)→(0,0)

f(x, y) = f(x0, y0).

V systému Maple máme pro hledáńı bod̊u nespojitosti funkce jedné proměnné př́ıkaz
discont. Ten však

”
funguje“ jen pro funkce jedné proměnné. Pro funkce v́ıce proměnných

můžeme využ́ıt př́ıkazu singular hledaj́ıćıho tzv. singularity. Jeho použit́ım pak můžeme
odhalit některé body nespojitosti. Př́ıkaz singular má však několik

”
nedostatk̊u“ (resp.

”
omezeńı“), takže je vhodněǰśı hledat nespojitosti

”
klasicky“ a Maple využ́ıvat k d́ılč́ım

úkol̊um.

Př́ıklad 3.12: Je funkce

f(x, y) =

{
x3·y
x4+y4

. . . [x, y] 6= [0, 0]

0 . . . [x, y] = [0, 0]

spojitá na celém R2?

Řešeńı: V př́ıkladu 3.11.(b) pilný čtenář zjistil, že funkce f(x, y) nemá v bodě [0, 0] limitu.
Podle definice 3.2 proto f(x, y) neńı v tomto bodě spojitá.

Př́ıklad 3.13: Určete body nespojitosti u následuj́ıćıch funkćı:

(a) f(x, y) = 1√
x2+y2

,

(b) f(x, y) = sin
(

1
x·y

)
,

(c) f(x, y) = arccos
(
x
y

)
,

(d) f(x, y) = ln |1− x2 − y2|,

(e) f(x, y) =

{
x2·y2
x2+y2

. . . [x, y] 6= [0, 0]

0 . . . [x, y] = [0, 0]
.

Př́ıklad 3.14: Určete C ∈ R tak, aby byla následuj́ıćı funkce spojitá v bodě [0, 0]:

(a) f(x, y) =

{√
x2+y2+1−1

x2+y2
. . . [x, y] 6= [0, 0]

C . . . [x, y] = [0, 0]
,

(b) f(x, y) =

{
x·y

x2+y2
. . . [x, y] 6= [0, 0]

C . . . [x, y] = [0, 0]
.
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3.3 Parciálńı derivace funkce v́ıce proměnných

Definice 3.3: Necht’ je funkce f(x, y) definována v bodě [x0, y0] a nějakém jeho okoĺı.
Položme ϕ(x) = f(x, y0). Existuje-li derivace funkce ϕ(x) v bodě x0, nazýváme tuto derivaci
parciálńı derivaćı funkce f(x, y) podle proměnné x v bodě [x0, y0] a znač́ıme f ′x(x0, y0)

(
resp.

∂f(x0,y0)
∂x

)
.

Poznámka 3.5: Předchoźı definici můžeme zapsat následovně:

f ′x(x0, y0) = lim
x→x0

f(x, y0)− f(x0, y0)

x− x0

.

Poznámka 3.6: Analogicky definujeme f ′y(x0, y0)
(

resp. ∂f(x0,y0)
∂y

)
či parciálńı derivace funkćı

v́ıce proměnných.

V systému Maple máme několik možnost́ı, jak určovat parciálńı derivace funkćı (výraz̊u).
Jednak máme v paletě Expression již předdefinované symboly pro derivaci ( d

dx
f , ∂

∂x
f),

využ́ıt můžeme též př́ıkaz diff funguj́ıćı pro výrazy libovolného počtu proměnných. Můžeme
též zapsat výraz (funkci) do dokumentu, kliknout pravým tlač́ıtkem myši a z kontextové
nab́ıdky zvolit Differentiate a proměnnou, podle ńıž chceme derivovat. Oproti derivaci
funkce jedné proměnné neńı možné nyńı použ́ıvat apostrof jako symbol pro derivaci. Re-
spektive to možné je, ale apostrof má význam parciálńı derivace podle proměnné x, takže
můžeme t́ımto zp̊usobem derivovat pouze podle této proměnné.

Stále muśıme mı́t na paměti rozd́ıl mezi funkćı a výrazem (jak to
”
vńımá“ Maple, který

většinou pracuje s výrazem). Pro derivováńı funkćı z pohledu systému Maple (tj. funkčńıch
operátor̊u) máme př́ıkaz D (s ńımž jsme se setkali již v př́ıpadě funkćı jedné proměnné, viz
sekce 2.5). Na obrázku 3.14 vid́ıme, že výsledek použit́ı př́ıkazu D může být poněkud matoućı
(viz výsledek př́ıkazu D[2](g), kde by bylo vhodněǰśı obdržet (x,y)->1). Př́ıkaz D totiž vždy
vraćı opět funkci (funkčńı operátor).

Poznámka 3.7: Podobně jako v př́ıpadě derivace funkce jedné proměnné má sv̊uj geome-
trický význam i parciálńı derivace funkce dvou proměnných. Také parciálńı derivace funkce
f(x, y) v bodě [x0, y0] je směrnićı tečny k funkci f(x, y), a to v bodě [x0, y0, f(x0, y0)]. Ta-
kových tečen je však nekonečně mnoho. Konkrétně parciálńı derivace funkce f(x, y) podle
proměnné x je směrnićı tečny ke křivce vzniklé jako pr̊useč́ık grafu funkce f(x, y) a ro-
viny y = y0. Podobně parciálńı derivace funkce f(x, y) podle proměnné y je směrnićı tečny
ke křivce vzniklé jako pr̊useč́ık grafu funkce f(x, y) a roviny x = x0.

Tvrzeńı poznámky 3.7 nyńı zobraźıme graficky. Na pomoc si vezmeme funkci f(x, y) =
x2 + y2 a budeme poč́ıtat jej́ı parciálńı derivaci v bodě [−1, 1] podle proměnné x. Podle
zmı́něné poznámky je tato parciálńı derivace směrnićı tečny v bodě [−1, 1, 2] ke křivce vzniklé
jako pr̊useč́ık funkce f(x, y) a roviny y = 1. Pro vykresleńı funkce f(x, y) použijeme již známý
př́ıkaz plot3d. Pro vykresleńı roviny y = 1 použijeme př́ıkaz implicitplot3d k vykreslováńı
objekt̊u v tř́ırozměrném prostoru zadaných implicitně. Následně vykresĺıme tečnu k funkci
f(x, y) (jej́ıž směrnici určuje parciálńı derivace) př́ıkazem spacecurve pro vykreslováńı pro-
storových křivek zadaných parametricky.

Rovnice tečny je dána rovnićı z = k ·x+ q, přičemž hodnota k je právě parciálńı derivace
funkce f(x, y) v bodě [−1, 1] a je tedy rovna −2. Bod q již dopoč́ıtáme dosazeńım bodu

106



Obrázek 3.14: Výpočet parciálńı derivace v Maple.

dotyku ([−1, 1, 2]) tečny k funkci f(x, y). Nakonec do grafu ještě pro názornost zaneseme bod
dotyku pomoćı př́ıkazu pointplot3d. Vše vykresĺıme najednou př́ıkazem display a źıskáme
obrázek 3.156.

Obrázek 3.15: Geometrický význam parciálńı derivace.

6Všechny použité př́ıkazy kromě př́ıkazu plot3d nálež́ı baĺıku plots, který je potřeba nač́ıst před jejich
použit́ım (př́ıpadně použ́ıvat spolu s voláńım př́ıslušného baĺıku).
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Definice 3.4: Necht’ bod [x0, y0] patř́ı do definičńıho oboru parciálńı derivace funkce
f(x, y). Existuje-li parciálńı derivace funkce f ′x(x0, y0) podle proměnné x v bodě [x0, y0],
nazýváme tuto derivaci parciálńı derivaćı 2. řádu funkce f(x, y) v bodě [x0, y0] podle proměnné
x a znač́ıme

f ′′xx(x0, y0)

(
resp.

∂2f(x0, y0)

∂x2

)
.

Existuje-li parciálńı derivace funkce f ′x(x0, y0) podle proměnné y v bodě [x0, y0], nazýváme
tuto derivaci smı́̌senou parciálńı derivaćı 2. řádu funkce f(x, y) v bodě [x0, y0] a znač́ıme

f ′′xy(x0, y0)

(
resp.

∂2f(x0, y0)

∂x∂y

)
.

Poznámka 3.8: Analogicky definujeme
”
zbylé“ parciálńı derivace 2. řádu a parciálńı de-

rivace vyšš́ıch řád̊u.

V systému Maple postupujeme při zadáváńı parciálńıch derivaćı vyšš́ıch řád̊u podobně,
jak tomu bylo u derivaćı vyšš́ıch řád̊u v př́ıpadě funkce jedné proměnné.

Obrázek 3.16: Parciálńı derivace vyšš́ıch řád̊u funkćı v́ıce proměnných.

Poznámka 3.9: (Schwarzova věta) Necht’ má funkce f(x, y) spojité smı́̌sené parciálńı de-
rivace f ′′xy a f ′′yx v bodě [x0, y0]. Pak plat́ı:

f ′′xy(x0, y0) = f ′′yx(x0, y0).
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Př́ıklad 3.15: Určete všechny parciálńı derivace 1. a 2. řádu u následuj́ıćıch funkćı:

(a) f(x, y) = x2 · y + ln
(
x
y

)
,

(b) f(x, y) = (x2 · y + y)
4
,

(c) f(x, y) = xy,

(d) f(x, y) = x · y · ln (x+ y).

Př́ıklad 3.16: Určete všechny parciálńı derivace 1. řádu funkce f(x, y) v bodě A:

(a) f(x, y) = ln
(
x+

√
x2 + y2

)
, A = [1, 2],

(b) f(x, y) =
(
1 + logy(x)

)3
, A = [e, e],

(c) f(x, y) = ln
(
x+ y

2·x

)
, A = [1, 2].

3.3.1 Směrové derivace

Definice 3.5: Necht’ f je funkce n proměnných, X = [x1, x2, ..., xn] vnitřńı bod D(f)
a u = (u1, u2, ..., un) vektor. Necht’ ϕ(t) = f (X + t · u). Má-li funkce ϕ(t) derivaci v bodě
t = 0, nazýváme ji derivaćı funkce f v bodě X ve směru vektoru u nebo také směrovou
derivaćı funkce f a označujeme ji f ′u(X). Tedy:

f ′u(X) = lim
t→0

ϕ(t)− ϕ(0)

t
= lim

t→0

f (X + t · u)− f (X)

t
.

Směrové derivace můžeme poč́ıtat bud’ rovnou z definice nebo využijeme př́ıkaz baĺıku
Student[MultivariateCalculus] s názvem DirectionalDerivative.

Př́ıklad 3.17: Vypočtěte směrovou derivaci funkce f(x, y) = x2 + y2 v bodě [−2, 2] ve
směru vektoru u = (3, 5).

Řešeńı: Využijeme př́ıkazu DirectionalDerivative, který má 3 povinné parametry –
výraz, bod, v němž hledáme směrovou derivaci, a př́ıslušný směr (obrázek 3.17).

Obrázek 3.17: Řešeńı př́ıkladu 3.17.

Systém Maple nab́ıźı dále maplet s názvem Directional Derivative, který můžeme
spustit z hlavńı nab́ıdky: Tools > Tutors > Calculus - Multi-Variable > Directional
Derivatives.... Maplet pro zadanou funkci, bod a směr vypoč́ıtá směrovou derivaci a zobraźı
ji graficky spolu s funkćı a tečnou rovinou v daném bodě. V mapletu je dále možné zobra-
zit animaci sestávaj́ıćı ze směrových derivaćı v r̊uzných směrech ve stejném bodě (ukázku
poskytuje obrázek 3.18).
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Obrázek 3.18: Maplet zobrazuj́ıćı směrové derivace.

Př́ıklad 3.18: Určete směrovou derivaci funkce

(a) f(x, y) = arctan(x · y) v bodě [1, 1] ve směru vektoru u = (
√

2
2
,
√

2
2

),

(b) f(x, y) = ln (ex + ey) v bodě [0, 0] ve směru vektoru u = (cos(α), sin(α)).

3.3.2 Diferenciál

Definice 3.6: Řekneme, že funkce f(x, y) je diferencovatelná v bodě [x0, y0], jestliže existuj́ı
reálná č́ısla A, B tak, že

lim
(h,k)→(0,0)

f(x0 + h, y0 + k)− f(x0, y0)− (A · h+B · k)√
h2 + k2

= 0.

Lineárńı funkce A · h+ B · k proměnných h, k se nazývá (totálńı) diferenciál funkce v bodě
[x0, y0] a znač́ı se df(x0, y0)(h, k), resp. df(x0, y0).

Poznámka 3.10: Je-li funkce f(x, y) diferencovatelná v bodě [x0, y0], pak má v tomto
bodě parciálńı derivace a plat́ı A = f ′x(x0, y0), B = f ′y(x0, y0), tj.

df(x0, y0) = f ′x(x0, y0) · h+ f ′y(x0, y0) · k.
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Poznámka 3.11: Tečná rovina k funkci f(x, y) v bodě T = [x0, y0, f(x0, y0)] má tvar

z = f(x0, y0) + f ′x(x0, y0) · (x− x0) + f ′y(x0, y0) · (y − y0).

Podobně jako v př́ıpadě funkce jedné proměnné využ́ıváme diferenciál k výpočt̊um od-
had̊u funkčńıch hodnot v okoĺı bodu, v němž funkčńı hodnotu známe. I tady pochopitelně
plat́ı, že samotný systém Maple urč́ı funkčńı hodnotu přesněji. Přesto jej můžeme využ́ıt
k d́ılč́ım výpočt̊um a kontrole přesnosti źıskaných aproximaćı.

Př́ıklad 3.19: Určete přibližně:
√

1.023 + 1.973.
Řešeńı: Budeme uvažovat funkci f(x, y) =

√
x3 + y3. Aproximaci źıskáme podle vztahu:

f(x0 +h, y0 +k) ≈ f(x0, y0)+df(x0, y0) = f(x0, y0)+f ′x(x0, y0) · (x−x0)+f ′y(x0, y0) · (y−y0).

V našem př́ıpadě: [x0, y0] = [1, 2], [x, y] = [1.02, 1.97]. Systém Maple využijeme k výpočtu
parciálńıch derivaćı v př́ıslušných bodech a celkovému součtu vypočtených hodnot (obrázek
3.19).

Obrázek 3.19: Řešeńı př́ıkladu 3.19.
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Př́ıklad 3.20: Určete přibližně:

(a) 3.050.99,

(b)
√

3.05 · cos(62◦),

(c) arctan(1.02
0.95

),

(d) log4(4.01 · 0.972).

Př́ıklad 3.21: Určete rovnici tečné roviny k funkci f(x, y) =
√

1− x2 − y2

v bodě [ 1√
3
, 1√

3
, 1√

3
] a rovinu i s funkćı vykreslete.

Řešeńı: Vyjdeme z poznámky 3.11. V Maple vykresĺıme funkci f(x, y) i tečnou rovinu po-
moćı př́ıkazu plot3d (v němž nastav́ıme parametr pr̊uhlednosti – transparency – pro větš́ı
přehlednost), nav́ıc doplńıme i bod dotyku (červeně) tečné roviny př́ıkazem pointplot3d

z baĺıku plots (obrázek 3.20).

Obrázek 3.20: Řešeńı př́ıkladu 3.21.

Př́ıklad 3.22: Určete rovnici tečné roviny a rovinu i s funkćı vykreslete pro:

(a) funkci f(x, y) = x2 + y2 v bodě [2,−1, 5],

(b) funkci f(x, y) = x4 + 2 · x2 · y − x · y + x v bodě [1, 0, 2],

(c) funkci f(x, y) = ln(x2 + y2) v bodě [2, 1, ln(5)],

(d) funkci f(x, y) = ex
2+y2 v bodě [0, 0, 1].
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3.3.3 Taylor̊uv polynom

Definice 3.7: Necht’ n ∈ N ∪ {0} a f(x, y) funkce maj́ıćı v bodě [x0, y0] ∈ R2 a nějakém
jeho okoĺı spojité parciálńı derivace až do řádu n. Polynom

T fn (x, y) = f(x0, y0) +
∂f

∂x
(x0, y0) · (x− x0) +

∂f

∂y
(x0, y0) · (y − y0)

+
1

2!
·
(
∂2f

∂x2
(x0, y0) · (x− x0)2 + 2 · ∂

2f

∂x∂y
(x0, y0) · (x− x0) · (y − y0) +

∂2f

∂y2
(x0, y0) · (y − y0)2

)
+...+

1

n!
·

n∑
j=0

(
n

r

)
∂nf

∂xn−j∂yj
(x0, y0) · (x− x0)n−j · (y − y0)j

se nazývá Taylor̊uv polynom stupně n funkce f(x, y) v bodě [x0, y0]. Funkci

Rf
n(x, y) = T fn (x, y)− f(x, y)

ř́ıkáme Taylor̊uv zbytek a celý výraz

T fn (x, y) +Rf
n(x, y)

nazýváme Taylorovým vzorcem.
Podobně jako v jednorozměrném př́ıpadě existuje i nyńı

”
předpis“ proRf

n(x, y), který nám
řekne,

”
jak dobrou“ aproximaćı dané funkce f(x, y) je polynom T fn (x, y). My jej potřebovat

nebudeme, a proto čtenáře pouze odkážeme na daľśı literaturu (např. [2]).
V systému Maple slouž́ı k źıskáńı Taylorova polynomu funkce v́ıce proměnných př́ıkaz

mtaylor. Př́ıkaz má 2 povinné parametry, a to výraz (funkčńı předpis) a seznam proměnných
s př́ıpadnou specifikaćı bodu, v němž má být polynom rozvinut. Pokud bod nespecifikujeme,
bude použit nulový bod. Můžeme si dále všimnout, že narozd́ıl od př́ıkazu taylor v jedno-
rozměrném př́ıpadě nyńı źıskáme

”
pouze“ Taylor̊uv polynom (bez chybového členu). Stejně

jako dř́ıve využ́ıváme k nastaveńı řádu chybového členu systémovou proměnnou Order,
př́ıpadně třet́ı (nepovinný) parametr př́ıkazu mtaylor (viz obrázek 3.21).

Př́ıklad 3.23: Určete Taylor̊uv polynom pro

(a) funkci f(x, y) = x
y

v bodě [1, 1],

(b) funkci f(x, y) = cos(x)
sin(y)

v bodě [0, π
2
],

(c) funkci f(x, y) = sin(x+ y) v bodě [0, 0] tak, aby byl chybový člen řádu 9,

(d) funkci f(x, y, z) = (cos(x+ y)) · z v bodě [0, 0, 0].

Př́ıklad 3.24: Pomoćı Taylorova polynomu určete přibližně:

(a)
√

1.023 + 1.973,

(b)
√

3.05 · cos(62◦),

(c) arctan(1.02
0.95

),

(d) log4(4.01 · 0.972).
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Obrázek 3.21: Výpis Taylorova polynomu funkce dvou proměnných.

3.4 Extrémy funkce v́ıce proměnných

3.4.1 Lokálńı extrémy

Definice 3.8: Necht’ ρ : Rn × Rn → R je funkce, pro niž pro libovolná X, Y, Z ∈ Rn plat́ı:

(a) ρ(X, Y ) ≥ 0,

(b) ρ(X, Y ) = 0⇔ X = Y ,

(c) ρ(X, Y ) = ρ(Y,X),

(d) ρ(X,Z) ≤ ρ(X, Y ) + ρ(Y, Z).

Takovou funkci nazýváme metrikou (resp. vzdálenost́ı) v Rn. Pomoćı metriky definujeme ε-
okoĺı bodu X ∈ Rn jako množinu Oε(X) = {Y ∈ Rn | ρ(X, Y ) < ε}. V př́ıpadě, že hodnota
ε neńı podstatná, mluv́ıme pouze o okoĺı bodu X.

Definice 3.9: Řekneme, že funkce f : Rn → R nabývá v bodě X∗ ∈ Rn lokálńıho maxima,
jestliže existuje okoĺı bodu X∗ takové, že pro všechna X z tohoto okoĺı plat́ı: f(X) ≤ f(X∗).
Je-li uvedená nerovnost ostrá, mluv́ıme o ostrém lokálńım maximu.

Poznámka 3.12: Zcela analogicky definujeme (ostré) lokálńı minimum. Minima a maxima
souhrnně nazýváme extrémy.

Př́ıklad 3.25: Napǐste definici lokálńıho minima.

Definice 3.10: Mějme funkci f : Rn → R. Bod X∗ ∈ Rn nazveme stacionárńım bodem
funkce f , jestliže v bodě X∗ existuj́ı všechny parciálńı derivace funkce f a plat́ı:

∂f

∂xi
(X∗) = 0 pro i = 1, ..., n.
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Poznámka 3.13: Funkce f : Rn → R může mı́t lokálńı extrém pouze ve svém stacionárńım
bodě nebo v bodě, kde alespoň jedna z parciálńıch derivaćı neexistuje [2].

Poznámka 3.14: Nyńı se omeźıme pouze na funkce dvou proměnných. Necht’ má funkce
f(x, y) v okoĺı bodu [x0, y0] spojité parciálńı derivace druhého řádu. Označme

H1 = f ′′xx(x0, y0), H2 =

∣∣∣∣∣∣
f ′′xx(x0, y0) f ′′xy(x0, y0)

f ′′yx(x0, y0) f ′′yy(x0, y0)

∣∣∣∣∣∣ .
Pak:

• Když H2 > 0, má funkce f(x, y) v bodě [x0, y0] ostrý lokálńı extrém.

(a) Pokud nav́ıc H1 > 0, pak je v bodě [x0, y0] lokálńı minimum.

(b) Pokud nav́ıc H1 < 0, pak je v bodě [x0, y0] lokálńı maximum.

• Když H2 < 0, nemá funkce f(x, y) v bodě [x0, y0] lokálńı extrém.

• Když H2 = 0, neumı́me o existenci extrému t́ımto zp̊usobem rozhodnout.

Matici druhých derivaćı funkce f(x, y), jej́ıž determinant jsme označili H2, nazýváme Hes-
sovou matićı, jej́ı determinant, H2, označujeme jako hessián.

V systému Maple je opět několik cest, po nichž můžeme dospět k lokálńım extrémům
zadané funkce. K dispozici máme několik př́ıkaz̊u, které nám mohou pomoci př́ı d́ılč́ım
výpočtu, př́ıpadně i nalezeńı některého z extrémů, žádný př́ıkaz však obecně nedokáže naj́ıt
všechny lokálńı extrémy. Nejuniverzálněǰśı cesta je proj́ıt výše popsaný postup, který známe
z přednášky. Systém Maple přitom můžeme využ́ıt k vykresleńı zadané funkce, výpočtu
parciálńıch derivaćı (př́ıpadně rovnou k výpočtu stacionárńıch bod̊u pomoćı př́ıkazu extrema),
výpočtu Hessovy matice či jej́ıho determinantu. K výpočtu Hessovy matice slouž́ı př́ıkaz
Hessian z baĺıku VectorCalculus. Pro výpočet determinantu je určen př́ıkaz Determinant

z baĺıku LinearAlgebra.

Př́ıklad 3.26: Najděte lokálńı extrémy funkce f(x, y) = (x− 2)2 + (y − 3)2 + 5.
Řešeńı: Využijeme př́ıkaz extrema k nalezeńı stacionárńıch bod̊u. Následně vypoč́ıtáme

Hessovu matici př́ıkazem Hessian a jej́ı determinant př́ıkazem Determinant. Na základě
poznámky 3.14 pak rozhodneme o lokálńıch extrémech (obrázek 3.22).

Př́ıklad 3.27: Najděte lokálńı extrémy funkce f(x, y) = (y − 3)2 − (x− 2)2 + 5.
Řešeńı: Postupujeme zcela analogicky k předchoźımu př́ıkladu. Využijeme opět př́ıkaz

extrema k nalezeńı stacionárńıch bod̊u, př́ıkaz Hessian k výpočtu Hessovy matice a př́ıkaz
Determinant k určeńı jej́ıho determinantu. Na základě poznámky 3.14 pak rozhodneme
o lokálńıch extrémech (obrázek 3.23).

Př́ıklad 3.28: Najděte lokálńı extrémy funkce f(x, y) = x · y · e−x
2+y2

2 .
Řešeńı: Postupujeme opět stejně. Nyńı źıskáváme v́ıc stacionárńıch bod̊u, pro něž muśıme

vyhodnotit Hessovu matici a jej́ı determinant. Při tom si
”
pomůžeme“ př́ıkazem eval a na-

rozd́ıl od předchoźıch př́ıklad̊u načteme př́ıkazem with potřebné baĺıky pro př́ıkazy Hessian

a Determinant (obrázek 3.24).
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Obrázek 3.22: Řešeńı př́ıkladu 3.26.

Obrázek 3.23: Řešeńı př́ıkladu 3.27.
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Obrázek 3.24: Řešeńı př́ıkladu 3.28.

Jak jsme zmı́nili dř́ıve, v systému Maple jsou i některé př́ıkazy hledaj́ıćı extrémy funkćı.
Jedná se předevš́ım o př́ıkazy minimize a maximize pro nalezeńı globálńıho minima či
maxima (symbolicky). Stejné př́ıkazy, ovšem s velkými počátečńımi ṕısmeny, tj. Minimize
a Maximize z baĺıku Optimization, hledaj́ı globálńı extrémy numericky. Všem zmı́něným
př́ıkaz̊um je možné nastavit omezuj́ıćı podmı́nky, a hledat tak absolutńı extrémy na dané
množině (v́ıce v daľśı části kapitoly). Můžeme také využ́ıt mapletu s názvem Optimization,
který vyvoláme např́ıklad z hlavńıho menu zvoleńım Tools > Assistants > Optimi-
zation.... Na výběr máme několik metod, kterými je extrém hledán, tlač́ıtkem Solve vyṕı̌seme
řešeńı, tlač́ıtkem Plot jej zobraźıme graficky. Jeho ukázku s nalezeńım globálńıho minima
funkce f(x, y) = x2 + y2 poskytuje obrázek 3.25.

Př́ıklad 3.29: Najděte lokálńı extrémy funkce f(x, y) =
√
x2 + y2.

Řešeńı: Postupujeme stále stejně. V tomto př́ıpadě však nenalezneme žádné stacionárńı
body. Již z grafu funkce je na prvńı pohled vidět, že funkce má lokálńı minimum v bodě [0, 0],
v němž neexistuje parciálńı derivace. Existenci minima můžeme ověřit vyšetřeńım lokálńıho
chováńı funkce v okoĺı tohoto bodu nebo využit́ım př́ıkazu minimize. Př́ıkaz volaný s jedńım
parametrem vyṕı̌se pouze hodnotu minima. Abychom źıskali i jeho polohu, přidáme druhý
nepovinný parametr location (obrázek 3.26).
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Obrázek 3.25: Optimization maplet.

Obrázek 3.26: Řešeńı př́ıkladu 3.29.

Př́ıklad 3.30: Najděte lokálńı extrémy funkce:

(a) f(x, y) = x3 + y3 − 3 · x · y,

(b) f(x, y) = x4 − 3 · x2 · y + 3 · y − y3,

(c) f(x, y) = x · y · ln(x2 + y2),

(d) f(x, y) = (x2 + y2) · e−x2−y2 ,

(e) f(x, y) = 3 · x2− 2 · x · √y+ y− 8 · x+ 12,

(f) f(x, y) = y ·
√

1 + x+ x ·
√
y + 1,

(g) f(x, y) = 3−
√
x2 + y2 + 2 ·

√
(x− 2)2 + (y − 3)2.
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3.4.2 Absolutńı extrémy

Definice 3.11: Mějme funkci f : Rn → R a množinu M ⊂ D(f). Řekneme, že bod X∗ ∈M
je bodem absolutńıho maxima funkce f na množině M , jestliže pro všechna X z množiny M
plat́ı: f(X) ≤ f(X∗). Je-li uvedená nerovnost ostrá pro všechna X 6= X∗, mluv́ıme o ostrém
absolutńım maximu.

Poznámka 3.15: Zcela analogicky definujeme (ostré) absolutńı minimum. Mı́sto pojmu
absolutńı minimum (maximum, extrém) použ́ıváme někdy termı́n globálńı minimum (maxi-
mum, extrém).

Př́ıklad 3.31: Napǐste definici absolutńıho minima.

Definice 3.12: Bod X ∈ Rn nazveme bodem uzávěru množiny M ⊆ Rn, jestliže pro
libovolné ε plat́ı: Oε(X) ∩ M 6= ∅. Množina všech bod̊u uzávěru množiny M se nazývá
uzávěr množiny M a znač́ı se M . Množinu M nazveme uzavřenou, jestliže M = M .

Poznámka 3.16: Necht’ je množina M uzavřená a ohraničená a funkce f na množině M
spojitá. Pak f nabývá absolutńıch extrémů na množině M bud’ v bodech lokálńıch extrémů
patř́ıćıch do množiny M nebo v některém hraničńım bodě množiny M .

Při hledáńı absolutńıch extrémů můžeme v systému Maple využ́ıvat tytéž př́ıkazy jako při
hledáńı extrémů lokálńıch, přičemž specifikujeme nav́ıc i množinu, na ńıž extrémy hledáme.
Má to však svá omezeńı. Př́ıkazu extrema můžeme zadat omezuj́ıćı podmı́nky pouze ve tvaru
rovnost́ı. Př́ıkaz̊um minimize a maximize je možné zadat omezeńı ve tvaru rozsah̊u (inter-
val̊u) jednotlivých proměnných. Vı́ce možnost́ı nám nab́ıźı př́ıkazy Minimize a Maximize

z baĺıku Optimization hledaj́ıćı extrémy numericky a maplet Optimization (viz obrázek
3.25), u nichž můžeme zadávat omezeńı i ve tvaru neostrých nerovnost́ı.

Př́ıklad 3.32: Najděte absolutńı extrémy funkce f(x, y) = x2 − y2 + 4 na množině
M : x2 + y2 ≤ 1.

Řešeńı: Nejprve vykresĺıme zadanou funkci i s vyznačeńım hranice množiny M , které
provedeme př́ıkazem spacecurve. Následně prověř́ıme lokálńı extrémy př́ıkazem extrema

s následným vyhodnoceńım determinantu Hessovy matice. Týmž př́ıkazem najdeme extrémy
funkce na hranici množiny M (obrázek 3.27).

Př́ıklad 3.33: Najděte absolutńı extrémy funkce f(x, y) = x2 + y2 + 4 na množině
M : x2 + y2 ≤ 1.

Řešeńı: Postupujeme stejným zp̊usobem jako v předchoźım př́ıkladu. Zadaná funkce má
jeden lokálńı extrém, který je současně i jej́ım globálńım minimem na množině M . Abso-
lutńıch maxim je nekonečně mnoho a jsou tvořeny hranićı množiny M (obrázek 3.28).

Př́ıklad 3.34: Najděte absolutńı extrémy funkce f(x, y) = x2 + 2 · x · y − 4 · x − 8 · y na
množině M určené př́ımkami x = 0, x = 1, y = 0, y = 2.

Řešeńı: K zakresleńı hranice množiny M do zadané funkce potřebujeme nyńı použ́ıt
4× př́ıkaz spacecurve (pro každou př́ımku – resp. úsečku, zvlášt’). Následně nalezneme
stacionárńı bod funkce př́ıkazem extrema. Tento stacionárńı bod lež́ı mimo množinu M ,
zadaná funkce je v každém bodě diferencovatelná, absolutńı extrémy tedy lež́ı na hranici
množiny M . Dı́ky tvaru M (jedná se o obdélńık) ji můžeme jednoduše vyjádřit pomoćı dvou
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Obrázek 3.27: Řešeńı př́ıkladu 3.32.

Obrázek 3.28: Řešeńı př́ıkladu 3.33.
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Obrázek 3.29: Řešeńı př́ıkladu 3.34.

interval̊u (rozsah̊u pro proměnné x a y). Přesně toto omezeńı je možné zadávat př́ıkaz̊um
minimize a maximize, takže je využijeme7 (obrázek 3.29).

Př́ıklad 3.35: Určete absolutńı extrémy funkce f(x, y) na množině M :

(a) f(x, y) = x2 + y2,M : x2 + y2 ≤ 1,

(b) f(x, y) = x+ y,M : |x| ≤ 1, |y| ≤ 1,

(c) f(x, y) = |x|+ |y|,M : x2 + y2 ≤ 1,

(d) f(x, y) = x · y − x2 − y2 + x+ y,M je ohraničená př́ımkami x = 0, y = 0, y = 4− x,

(e) f(x, y) = x2 +2 ·x ·y+2 ·y2−3 ·x−5 ·y,M je trojúhelńıková oblast s vrcholy v bodech
A = [0, 2], B = [3, 0], C = [0,−1],

(f) f(x, y) = sin(x) · sin(y) · sin(x+ y),M : x > 0, y ≤ π.

Př́ıklad 3.36: Najděte kladná č́ısla x, y, z taková, že x+y+z = 18 a x ·y ·z je maximálńı.
Řešeńı: Chceme maximimalizovat funkci f(x, y, z) = x · y · z. Přitom má platit, že x +

y + z = 18. Tuto rovnost můžeme zahrnout rovnou do předpisu funkce, a źıskat tak funkci
pouze dvou proměnných: x ·y ·(18−y−x). Nově vzniklou funkci přitom maximalizujeme pro
x ∈ (0, 18), y ∈ (0, 18), x + y < 18. T́ımto zápisem jsme zadanou úlohu převedli na klasické

7Př́ıkazy minimize a maximize v tomto př́ıpadě neprocháźı jen hranici množiny M , ale celou množinu
(což nám ale nevad́ı). Pro jiný tvar množiny M , např. trojúhelńık, často muśıme procházet jednotlivé části
jej́ı hranice, tj. např. jednotlivé úsečky (a hledat na nich extrém).
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hledáńı absolutńıho maxima funkce, jak jsme jej řešili v předchoźıch př́ıkladech. Tentokrát
dokonce nemuśıme ani vyšetřovat funkčńı hodnoty na hranici

”
omezuj́ıćı“ množiny, nebot’

omezuj́ıćı podmı́nky jsou ostré nerovnosti. Celkem źıskáváme, že požadovaná kladná č́ısla
jsou: x = y = z = 6 (obrázek 3.30).

Obrázek 3.30: Řešeńı př́ıkladu 3.36.

Př́ıklad 3.37: Najděte kladná č́ısla x, y, z taková, že x ·y ·z = 64 a x+y+z je minimálńı.

Př́ıklad 3.38: Jakého nejmenš́ıho č́ısla může nabýt součet tř́ı kladných č́ısel x, y, z, jestliže
pro ně plat́ı: x · y · z2 = 2500?

Př́ıklad 3.39: Najděte bod plochy z = x · y − 1, který je nejbĺıže bodu [0, 0, 0].

Př́ıklad 3.40: Určete rovnici př́ımky, pro niž plat́ı, že má od bod̊u [0, 2], [1, 3] a [2, 5]
nejmenš́ı součet čtverc̊u (druhých mocnin) jejich vertikálńıch vzdálenost́ı (tj. ve směru osy
y) – tzv. metoda nejmenš́ıch čtverc̊u.
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3.5 Vı́cerozměrný integrál

Poznámka 3.17: Mějme spojitou funkci f(x, y) na obdélńıku [a, b]×[c, d]. Pak jsou spojité
i funkce ϕ(x) a ψ(y) dané integrály:

ϕ(x) =

d∫
c

f(x, y) dy a ψ(y) =

b∫
a

f(x, y) dx.

Funkce ϕ(x) a ψ(y) tak můžeme integrovat znovu a źıskat:

b∫
a

ϕ(x) dx =

b∫
a

d∫
c

f(x, y) dy dx,

d∫
c

ψ(y) dy =

d∫
c

b∫
a

f(x, y) dx dy.

Předešlé integrály nazýváme dvojnásobnými integrály.

Definice 3.13: Necht’ T = [a, b] × [c, d] ⊂ R2 a necht’ je funkce f(x, y) spojitá na T .
Dvojným integrálem funkce f(x, y) přes množinu T pak rozumı́me:

∫∫
T

f(x, y) dx dy =

b∫
a

d∫
c

f(x, y) dy dx =

d∫
c

b∫
a

f(x, y) dx dy.

Definice 3.14: Uvažujme nyńı oblast, j́ıž budeme ř́ıkat oblast základńı, definovanou jako
T = {(x, y) ∈ R2 | x ∈ [a1, a2], y ∈ [s1(x), s2(x)]}, resp. T = {(x, y) ∈ R2 | y ∈ [b1, b2], x ∈
[p1(y), p2(y)]}, přičemž funkce s1(x), s2(x), p1(y), p2(y) jsou spojité na intervalech [a1, a2],
resp. [b1, b2]. Základńı oblast ilustruje pro lepš́ı představu obrázek 3.31.

Obrázek 3.31: Zobrazeńı základńı oblasti (převzato z [4]).

Analogicky jako v předchoźı definici nyńı definujeme dvojný integrál funkce f(x, y) přes
množinu T jako:
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∫∫
T

f(x, y) dx dy =

a2∫
a1

s2(x)∫
s1(x)

f(x, y) dy dx,

resp.

∫∫
T

f(x, y) dx dy =

b2∫
b1

p2(y)∫
p1(y)

f(x, y) dx dy.

Poznámka 3.18: Sjednoceńım konečně mnoha základńıch oblast́ı můžeme źıskat tzv. ele-
mentárńı oblast (množinu) K (viz obrázek 3.32).

Obrázek 3.32: Zobrazeńı elementárńı oblasti (převzato z [8]).

Poznámka 3.19: Častým krokem při výpočtu integrál̊u je prohozeńı pořad́ı integrace.
Muśıme mı́t na paměti, že vněǰśı integrál muśı být vždy ten, který neobsahuje proměnnou
ve svých meźıch.

Definice 3.15: Uvažujme nyńı základńı oblast T = {(x, y) ∈ R2 | x ∈ [a1, a2], y ∈
[s1(x), s2(x)]}, přičemž funkce s1(x), s2(x) jsou spojité na intervalu [a1, a2]. Definujme základńı
těleso P = {(x, y, z) ∈ R3 | (x, y) ∈ T, z ∈ [h1(x, y), h2(x, y)]}.

Trojným integrálem funkce f(x, y, z) přes množinu P nazýváme:

∫∫∫
P

f(x, y, z) dx dy dz =

∫∫
T

 h2(x,y)∫
h1(x,y)

f(x, y, z) dz

 =

a2∫
a1

s2(x)∫
s1(x)

h2(x,y)∫
h1(x,y)

f(x, y, z) dz dy dx.

V systému Maple zadáváme v́ıcenásobné integrály opakovaným použit́ım integračńıho
symbolu z palety Expression, př́ıkazu int či vyvoláńım kontextové nab́ıdky dokumentu
(po kliknut́ı pravým tlač́ıtkem myši na předpis funkce) a zvoleńım položky Integrate spolu
se specifikaćı integračńı proměnné (pouze pro neurčitý integrál).

Pokud chceme do dokumentu zapsat v́ıcenásobný integrál symbolicky (a nevyhodnocovat
jej), použijeme př́ıkaz Int. Daľśı možnost, jak zadat (určitý) v́ıcenásobný integrál (dvojný
nebo trojný), poskytuje př́ıkaz MultiInt z baĺıku Student[MultivariateCalculus].
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Obrázek 3.33: Vı́cenásobné integrály.

Př́ıkaz MultiInt nab́ıźı možnost výpisu integrálu jako symbolu i jako integrálu, který
bude

”
rovnou“ vyhodnocen. Nav́ıc je možné nechat vypsat kroky výpočtu integrálu nasta-

veńım nepovinného parametru output na hodnotu steps. Daľśım nepovinným parametrem,
který můžeme specifikovat, je parametr coordinates určuj́ıćı, v jakých souřadnićıch je in-
tegrál uveden. Na výběr máme podle dimenze integrálu souřadnice kartézské (cartesian[x,y]
nebo cartesian[x,y,z]), polárńı (polar[r,theta]), sférické (spherical[r,phi,theta])
či cylindrické (cylindrical[r,theta,z]), viz obrázek 3.34.

K převod̊um mezi r̊uznými souřadnicovými systémy můžeme využ́ıt př́ıkaz changecoords,
který převede zadaný výraz z kartézského systému souřadnic do námi zvoleného. Pro dvojné
a trojné integrály je k dispozici př́ıkaz baĺıku Student[MultivariateCalculus] s názvem
ChangeOfVariables převáděj́ıćı proměnné mezi dř́ıve vyjmenovanými souřadnicovými systémy.
Př́ıkaz má jednu

”
slabinu“, a to, že zpravidla nepřevede integračńı meze do nových proměnných,

což muśıme tedy udělat sami (obrázek 3.35).

Př́ıklad 3.41: Stanovte meze dvojnásobného integrálu

I =

∫∫
Ω

f(x, y) dx dy.

Integrál následně zapǐste i s těmito mezemi pro integračńı oblast:

(a) Ω : 0 ≤ x ≤ y ≤ 1,

(b) Ω : x < x2 + y2 ≤ 1,

(c) Ω : 1 ≤ |x|+ |y| < 2,

(d) Ω je 4 s vrcholy [1, 0], [1, 1], [0, 0].

Řešeńı: Při stanovováńı meźı nám může velmi pomoci obrázek. Nejprve si tedy zadanou
množinu Ω vždy vykresĺıme a následně odvod́ıme meze jednotlivých integrál̊u. Využijeme
přitom př́ıkaz̊u inequal z baĺıku plots, transform z baĺıku plottools a implicitplot
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Obrázek 3.34: Vı́cenásobné integrály s př́ıkazy MultiInt a Int.

Obrázek 3.35: Transformace mezi souřadnicovými systémy.
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z baĺıku plots, s nimiž jsme se již setkali při vykreslováńı oblast́ı a definičńıch obor̊u funkćı
v sekci 3.1.3.

(a)

Obrázek 3.36: Zobrazeńı oblasti Ω z př́ıkladu 3.41.(a)

Z obrázku 3.36 můžeme vyvodit 2 r̊uzné (ekvivalentńı) zápisy integračńıch meźı:

1. 0 ≤ y ≤ 1, 0 ≤ x ≤ y,

2. 0 ≤ x ≤ 1, x ≤ y ≤ 1.

Celkem tak źıskáváme:

I =

∫∫
Ω

f(x, y) dx dy =

1∫
0

y∫
0

f(x, y) dx dy =

1∫
0

1∫
x

f(x, y) dy dx.

(b)

Z obrázku 3.37 můžeme vyvodit opět 2 r̊uzné (ekvivalentńı) zápisy integračńıch meźı.
Dostáváme však výrazně komplikovaněǰśı zápis než v předchoźım př́ıpadě, a tak zapǐsme
pouze jednu možnost (která je jednodušš́ı):

1. −1 ≤ x ≤ 0,−
√

1− x2 ≤ y ≤
√

1− x2,

0 ≤ x ≤ 1,−
√

1− x2 ≤ y < −
√

1
4
−
(
x− 1

2

)2 ∪
√

1
4
−
(
x− 1

2

)2
< y ≤

√
1− x2.

Celkem tak źıskáváme:

I =

∫∫
Ω

f(x, y) dx dy =

0∫
−1

√
1−x2∫

−
√

1−x2

f(x, y) dy dx +

1∫
0

−
√

1
4
−(x− 1

2)
2∫

−
√

1−x2

f(x, y) dy dx +
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Obrázek 3.37: Zobrazeńı oblasti Ω z př́ıkladu 3.41.(b)

+

1∫
0

√
1−x2∫

√
1
4
−(x− 1

2)
2

f(x, y) dy dx.

(c)

Obrázek 3.38: Zobrazeńı oblasti Ω z př́ıkladu 3.41.(c)

I v tomto př́ıpadě máme dvě (základńı) možnosti, jak zapsat integračńı meze. Pro
komplikovanost zápisu ukažme opět pouze jednu z možnost́ı. Doplňme, že v př́ıpadech,
kdy je oblast Ω symetrická (kolem počátku či kolem některé z os) a podobně i zadaná
funkce (vzhledem k ose z), poč́ıtáme zpravidla integrál pouze pro část oblasti (tj.
např. jen pro jeden kvadrant) a výsledek vynásob́ıme počtem odpov́ıdaj́ıćıch si část́ı.
V tomto př́ıkladu bychom tak mohli poč́ıtat integrál pouze pro oblast nálež́ıćı prvńımu
kvadrantu a výsledek vynásobit čtyřmi (pokud by funkce f(x, y) byla symetrická kolem
osy z).
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1. −2 ≤ x ≤ −1,−x− 2 < y < x+ 2,
−1 ≤ x ≤ 0,−x− 2 < y ≤ −x− 1 ∪ x+ 1 ≤ y < x+ 2,
0 ≤ x ≤ 1, x− 2 < y ≤ x− 1 ∪ −x+ 1 ≤ y < −x+ 2,
1 ≤ x ≤ 2, x− 2 < y < −x+ 2.

Celkem tak źıskáváme:

I =

∫∫
Ω

f(x, y) dx dy =

−1∫
−2

x+2∫
−x−2

f(x, y) dy dx +

0∫
−1

−x−1∫
−x−2

f(x, y) dy dx +

+

0∫
−1

x+2∫
x+1

f(x, y) dy dx +

1∫
0

x−1∫
x−2

f(x, y) dy dx +

1∫
0

−x+2∫
−x+1

f(x, y) dy dx +

+

2∫
1

−x+2∫
x−2

f(x, y) dy dx.

(d)

Obrázek 3.39: Zobrazeńı oblasti Ω z př́ıkladu 3.41.(d)

Z obrázku 3.39 vid́ıme, že situace je velmi podobná př́ıpadu (a). Můžeme opět vyvodit
2 r̊uzné (ekvivalentńı) zápisy integračńıch meźı:

1. 0 ≤ x ≤ 1, 0 ≤ y ≤ x,

2. 0 ≤ y ≤ 1, y ≤ x ≤ 1.
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Celkem tak źıskáváme:

I =

∫∫
Ω

f(x, y) dx dy =

1∫
0

x∫
0

f(x, y) dy dx =

1∫
0

1∫
y

f(x, y) dx dy.

Př́ıklad 3.42: Stanovte meze dvojnásobného integrálu

I =

∫∫
Ω

f(x, y) dx dy.

Integrál následně zapǐste i s těmito mezemi pro integračńı oblast:

(a) Ω : 0 ≤ x+ y ≤ 1 ∧ x ≥ 0 ∧ y ≥ 0,

(b) Ω : x2 + y2 ≤ 1 ∧ x ≥ 0,

(c) Ω : |x|+ |y| < 3,

(d) Ω je 4 s vrcholy [2, 1], [−2, 1], [0, 0].

Př́ıklad 3.43: Vyjádřete zadané integrály v obráceném pořad́ı integrace.

(a)
4∫
0

2∫
x
2

f(x, y) dy dx,

(b)
2∫
0

2·x∫
x

f(x, y) dy dx,

(c)
2∫
0

x2∫
0

f(x, y) dy dx,

(d)
1∫
0

x2∫
x3
f(x, y) dy dx.

3.5.1 Geometrická aplikace dvojného integrálu

Obsah rovinné oblasti

Poznámka 3.20: Necht’ Ω ⊂ R2 je rovinná oblast. Plocha S oblasti Ω je dána vztahem

S =

∫∫
Ω

dx dy.

Př́ıklad 3.44: Určete obsah oblasti Ω.

(a) Ω je ohraničená křivkami y = 1
x

a y = 3− 2 · x,

(b) Ω je ohraničená př́ımkami y = x, y = x− 3, y = 2 a y = 4.

Řešeńı:
V zadáńı neńı specifikováno, jak máme obsah zadané oblasti hledat. Mohli bychom si

proto vzpomenout na aplikace určitého integrálu funkce jedné proměnné a poč́ıtat obsah
oblasti t́ımto zp̊usobem. U některých oblast́ı je nav́ıc jednodušš́ı i jiný zp̊usob než poč́ıtat
integrály (jednoduché či dvojné). My si ukážeme výpočet jak pomoćı jednoduchého, tak
pomoćı dvojného integrálu.

130



Obrázek 3.40: Zobrazeńı oblasti Ω z př́ıkladu 3.44. Vlevo př́ıpad (a), vpravo př́ıpad (b).

(a) Pomoćı jednoduchého integrálu zvoĺıme jednu proměnnou, u ńıž známe č́ıselné meze,
a

”
odeč́ıtáme od sebe“ dvě funkce vymezuj́ıćı zadanou oblast. U dvojného integrálu

zaṕı̌seme zadanou oblast pouze v integračńıch meźıch. Pozor na to, že při výpočtu
dvojnásobného integrálu v systému Maple muśıme zadat funkci, která bude inte-
grována. V př́ıpadě poč́ıtáńı obsah̊u rovinných oblast́ı podle poznámky 3.20 se v in-
tegrálu žádná funkce nevyskytuje, i když ve skutečnosti integrujeme konstantńı funkci
f(x, y) = 1, kterou také zadáme do integrálu v systému Maple.

Obrázek 3.41: Výpočet obsahu oblasti Ω z př́ıkladu 3.44.(a)

(b)

Obrázek 3.42: Výpočet obsahu oblasti Ω z př́ıkladu 3.44.(b)
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Př́ıklad 3.45: Určete obsahy oblast́ı Ω z př́ıkladu 3.42 a obsahy oblast́ı tvořených inte-
gračńımi mezemi v př́ıkladu 3.43. U př́ıkladu 3.43 výpočtem obsahu př́ıslušné oblasti nav́ıc
ověřte rovnost integrál̊u v zadáńı a v řešeńı.

Př́ıklad 3.46: Pomoćı dvojného integrálu určete obsah kruhu o poloměru r.

Př́ıklad 3.47: Pomoćı dvojného integrálu určete obsah oblasti ohraničené elipsou o délce
hlavńı poloosy a a délce vedleǰśı poloosy b.

Objem tělesa

Poznámka 3.21: Necht’ f(x, y) je spojitá funkce na množině Ω ⊂ R2 a necht’ f(x, y) ≥ 0
pro všechna (x, y) ∈ Ω. Objem (kolmého) tělesa T ⊂ R3 ohraničeného zdola množinou Ω
a shora část́ı grafu funkce f(x, y) je dán vztahem

V =

∫∫
Ω

f(x, y) dx dy.

Př́ıklad 3.48: Určete objem kolmého tělesa ohraničeného:

(a) funkćı f(x, y) = x2 + y2 a množinou Ω : |x|+ |y| ≤ 1,

(b) funkćı f(x, y) = 64− x2 a rovinami 3 · x+ 4 · y = 24, x = 0, y = 0 a z = 0.

Řešeńı:

(a) Nejprve v systému Maple zobraźıme těleso, jehož objem poč́ıtáme (obrázek 3.43), a jeho
podstavu (množinu Ω), abychom źıskali představu a snáze odvodili meze dvojného
integrálu.

Obrázek 3.43: Řešeńı př́ıkladu 3.48.(a) - vykresleńı tělesa.

S množinou Ω (resp. jej́ımi variantami) jsme se už několikrát setkali, takže by nám
nemělo činit problémy přepsat ji do meźı pro proměnné x a y. Když si však uvědomı́me,
že množina Ω je středově souměrná podle počátku souřadné soustavy (bodu [0, 0, 0])
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a že zadaná funkce f(x, y) je symetrická podle osy z, můžeme poč́ıtat objem pouze
části tělesa vyskytuj́ıćı se v prvńım oktantu (tj. pro x, y, z ≥ 0) a výsledek vynásobit
čtyřmi (abychom źıskali objem celého tělesa rozprost́ıraj́ıćıho se přes čtyři oktanty, pro
něž z ≥ 0).

Pro meze odpov́ıdaj́ıćı prvńımu oktantu plat́ı:
0 ≤ x ≤ 1, 0 ≤ y ≤ 1− x.

Obrázek 3.44: Řešeńı př́ıkladu 3.48.(a)

Obrázek 3.45: Řešeńı př́ıkladu 3.48.(b)

(b) Postupujeme zcela analogicky k předchoźımu př́ıkladu. Pro meze integrálu plat́ı:
0 ≤ x ≤ 8, 0 ≤ y ≤ 24−3·x

4
.
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Př́ıklad 3.49: Určete objem kolmého tělesa ohraničeného:

(a) funkćı f(x, y) = 6− 2 · x− 3 · y a rovinami x = 0, y = 0 a z = 0,

(b) funkćı f(x, y) = x+ 2 · y a podstavou vymezenou grafy funkćı y = 2− x2 a y = |x|,

(c) funkćı f(x, y) = ex
2+y2 a kruhovou podstavou popsanou nerovnićı x2 + y2 ≤ 4,

(d) funkćı f(x, y) = 5 ·x2−2 ·x ·y a trojúhelńıkovou podstavou vymezenou body [2, 0], [0, 1]
a [0, 0].

(e) funkćı f(x, y) =
(
x
y

)2

a podstavou vymezenou grafy funkćı y = x, y = 1
x

a př́ımkou

x = 2.

Př́ıklad 3.50: Pomoćı dvojného integrálu určete objem kvádru o rozměrech a, b, c.

Př́ıklad 3.51: Pomoćı dvojného integrálu určete objem koule o poloměru r.

Př́ıklad 3.52: Pomoćı dvojného integrálu určete objem válce o poloměru podstavy r
a výšce v.

Obsah plochy

Poznámka 3.22: Necht’ jsou funkce f(x, y), f ′x(x, y), f ′y(x, y) spojité na množině Ω ⊂ R2.
Obsah plochy tvořené grafem funkce f(x, y) nad množinou Ω je dán vztahem

S =

∫∫
Ω

√
1 + (f ′x(x, y))2 +

(
f ′y(x, y)

)2
dx dy.

Př́ıklad 3.53: Určete obsah plochy tvořené grafem funkce f(x, y) nad množinou Ω z př́ıkladu
3.48 v př́ıpadě (a) i (b).

Řešeńı:

V obou př́ıpadech využijeme poznámky 3.22, již dř́ıve vypoč́ıtaných integračńıch meźı
a předpisu ohraničuj́ıćı funkce, viz obrázek 3.46.

Př́ıklad 3.54: Určete obsah plochy tvořené grafem funkce f(x, y) nad podstavou tělesa
z př́ıkladu 3.49.

Př́ıklad 3.55: Určete obsah povrchu koule o poloměru r.

Př́ıklad 3.56: Určete obsah části plochy koule o rovnici x2 + y2 + z2 = 25 vymezené
rovinami z = 2 a z = 4.
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Obrázek 3.46: Řešeńı př́ıkladu 3.53.(a) vlevo, řešeńı př́ıkladu 3.53.(b) vpravo.

Integrálńı součet

Jak již v́ıme, geometrickým významem dvojného integrálu z funkce f(x, y) přes množinu Ω
je objem tělesa ohraničeného množinou Ω, funkćı f(x, y) a

”
svislými plochami“. Tento objem

můžeme poč́ıtat přibližně pomoćı dolńıch (resp. horńıch, ...) integrálńıch součt̊u podobně,
jako tomu bylo v př́ıpadě jedné proměnné v sekci 2.7.4. Tentokrát přitom aproximujeme
objem součtem objemů kvádr̊u se

”
zjemňuj́ıćı se“ čtvercovou základnou a výškou spočtenou

např. z funkčńı hodnoty ve středu čtverce – základny nebo v jednom z vrchol̊u. K tomu
nám poslouž́ı př́ıkaz ApproximateInt z baĺıku Student[MultivariateCalculus]. Použit́ı
př́ıkazu ApproximateInt je takřka totožné s př́ıkazem RiemannSum, s ńımž jsme se dř́ıve
setkali. Př́ıkazu opět povinně zadáváme předpis funkce, již chceme integrovat, a meze inte-
grace. I v tomto př́ıpadě můžeme zadávat nepovinné parametry specifikuj́ıćı typ integrálńıho
součtu, typ výstupu, rozděleńı integračńıch interval̊u a daľśı. Ukázku použit́ı můžeme vidět
na obrázku 3.47.

Tak jako v př́ıpadě funkćı jedné proměnné, kde můžeme mı́sto př́ıkazu RiemannSum využ́ıt
nástroje Approximate Integration spouštěném např́ıklad z hlavńıho menu, máme k dis-
pozici analogický nástroj i nyńı. Opět má název Approximate Integration a tentokrát jej
spust́ıme např́ıklad zvoleńım Tools > Tutors > Calculus – Multi-Variable > Appro-
ximate Integration... v hlavńım menu (obrázek 3.48).

3.5.2 Geometrická aplikace trojného integrálu

Objem tělesa

Poznámka 3.23: Necht’ P je množina z definice 3.15 (obecně stač́ı tzv. měřitelná množina).
Pro objem V této množiny plat́ı vztah

V =

∫∫∫
P

dx dy dz.
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Obrázek 3.47: Aproximace dvojného integrálu pomoćı integrálńıch součt̊u.

Obrázek 3.48: Aproximace dvojného integrálu – maplet.

Př́ıklad 3.57: Určete objem trojosého elipsoidu daného rovnićı(x
a

)2

+
(y
b

)2

+
(z
c

)2

= 1.
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Řešeńı: Nejprve si elipsoid vykresĺıme pro nějaké konkrétńı hodnoty a, b, c. Na obrázku
3.49 jsou použity hodnoty a = 13, b = 8, c = 6. Následně muśıme odvodit jednotlivé meze
v trojném integrálu. Za

”
počátečńı“ proměnnou vezměme x, pro niž tak plat́ı: x ∈ [−a, a].

Proměnnou y vyjádř́ıme pomoćı proměnné x jako: y ∈
[
−
√

1−
(
x
a

)2
,
√

1−
(
x
a

)2
]

a nakonec

proměnnou z pomoćı zbylých proměnných jako: z ∈
[
−
√

1−
(
x
a

)2 −
(
y
b

)2
,
√

1−
(
x
a

)2 −
(
y
b

)2
]
.

Obrázek 3.49: Řešeńı př́ıkladu 3.57.

Př́ıklad 3.58: Pomoćı trojného integrálu určete objem tělesa z př́ıkladu 3.48.

Př́ıklad 3.59: Pomoćı trojného integrálu určete objem kvádru o rozměrech a, b, c.

Př́ıklad 3.60: Pomoćı trojného integrálu určete objem koule o poloměru r.

Př́ıklad 3.61: Pomoćı trojného integrálu určete objem válce o poloměru podstavy r
a výšce v.
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3.5.3 Transformace souřadnic ve dvojném a trojném integrálu

U skupiny integrál̊u, kde pracujeme s kruhovými, kulovými či válcovými plochami, bývá
výhodná transformace do polárńıch, sférických či cylindrických souřadnic.

Poznámka 3.24: (Transformace do polárńıch souřadnic) Uvažujme dvojný integrál∫∫
Ω1

f(x, y) dx dy.

Pro transformaci tohoto integrálu do polárńıch souřadnic daných vztahy

x = r · cos(θ), y = r · sin(θ)

plat́ı: ∫∫
Ω1

f(x, y) dx dy =

∫∫
Ω2

f(r · cos(θ), r · sin(θ)) · r dr dθ,

kde r ∈ [0,∞), θ ∈ [0, 2 · π].

Poznámka 3.25: (Transformace do sférických souřadnic) Uvažujme trojný integrál∫∫∫
Ω1

f(x, y, z) dx dy dz.

Pro transformaci tohoto integrálu do sférických souřadnic daných vztahy

x = r · cos(φ) · sin(θ), y = r · sin(φ) · sin(θ), z = r · cos(θ)

plat́ı: ∫∫∫
Ω1

f(x, y, z) dx dy dz =

=

∫∫∫
Ω2

f(r · cos(φ) · sin(θ), r · sin(φ) · sin(θ), r · cos(θ)) · sin(θ) · r2 dr dφ dθ,

kde r ∈ [0,∞), φ ∈ [0, 2 · π], θ ∈ [0, 2 · π].

Poznámka 3.26: (Transformace do cylindrických souřadnic) Uvažujme trojný in-
tegrál ∫∫∫

Ω1

f(x, y, z) dx dy dz.

Pro transformaci tohoto integrálu do cylindrických souřadnic daných vztahy

x = r · cos(θ), y = r · sin(θ), z = z

plat́ı: ∫∫∫
Ω1

f(x, y, z) dx dy dz =

∫∫∫
Ω2

f(r · cos(θ), r · sin(θ), z) · r dr dθ dz,

kde r ∈ [0,∞), θ ∈ [0, 2 · π], z ∈ R.
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Př́ıklad 3.62: Použit́ım transformace do polárńıch souřadnic určete objem kolmého tělesa
ohraničeného funkćı f(x, y) = ex

2+y2 a kruhovou podstavou popsanou nerovnićı x2 + y2 ≤ 4.

Řešeńı: Můžeme využ́ıt poznámky 3.24 nebo zapsat dvojný integrál pro kartézské souřadnice,
který jsme již vytvořili v př́ıkladu 3.49.(c), a pro transformaci do souřadnic polárńıch využ́ıt
př́ıkaz ChangeOfVariables (či př́ıkaz changecoords). Využijme zmı́něný př́ıkaz.

Integračńı meze Maple nepřevede, muśıme je tak vytvořit sami. Podstavou tělesa je kruh
o poloměru r = 2, což vede na následuj́ıćı meze: r ∈ [0, 2], θ ∈ [0, 2 · π].

Obrázek 3.50: Řešeńı př́ıkladu 3.62.

Př́ıklad 3.63: Použit́ım transformace do polárńıch souřadnic určete objem kolmého tělesa
ohraničeného funkćı f(x, y) =

√
1− x2 − y2 a kruhovou podstavou popsanou nerovnićı

x2 + y2 ≤ 1.

Př́ıklad 3.64: Vrat’te se k př́ıklad̊um 3.46, 3.51, 3.52, 3.60 a 3.61. Př́ıslušné výpočty nyńı
proved’te i v jiném systému souřadnic (tj. např. polárńıch, sférických, ...) a výsledky porov-
nejte s p̊uvodně źıskanými.

3.6 Nekonečné řady

Definice 3.16: Mějme funkci f : R → R. Jestliže D(f) = N, nazýváme tuto funkci
posloupnost́ı reálných č́ısel a znač́ıme {an}∞n=1.

Definice 3.17: Necht’ {an}∞n=1 je posloupnost reálných č́ısel. Symbol

∞∑
n=1

an nebo a1 + a2 + ...+ an + ...
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nazýváme nekonečnou (č́ıselnou) řadou. Posloupnost {sn}∞n=1 definovanou předpisem

s1 = a1, s2 = a1 + a2, ... sn = a1 + a2 + ...+ an, ...

nazýváme posloupnost́ı částečných součt̊u této řady.

Definice 3.18: Existuje-li vlastńı limita lim
n→∞

sn = s, řekneme, že řada
∞∑
n=1

an konverguje

a má součet s.

Neexistuje-li vlastńı limita lim
n→∞

sn, řekneme, že řada
∞∑
n=1

an diverguje.

Poznámka 3.27: Divergenci řady můžeme ještě rozlǐsit na tři př́ıpady:

• je-li lim
n→∞

sn =∞, ř́ıkáme, že řada diverguje k ∞,

• je-li lim
n→∞

sn = −∞, ř́ıkáme, že řada diverguje k −∞,

• pokud lim
n→∞

sn neexistuje, ř́ıkáme, že řada osciluje.

V systému Maple zadáváme posloupnosti pomoćı př́ıkazu seq nebo pomoćı kontextové
nab́ıdky dokumentu. Př́ıkaz seq je možné použ́ıt několika r̊uznými zp̊usoby s ohledem na to,
jaké mu zadáváme parametry. S výjimkou jediného př́ıpadu mu vždy zadáváme jako prvńı
parametr n-tý člen posloupnosti a daľśım parametrem (daľśımi parametry) specifikujeme,
které členy posloupnosti chceme vypsat (což můžeme učinit zadáńım intervalu, zápisem
jediné hodnoty – pro jediný člen nebo výpisem člen̊u posloupnosti v seznamu).

V př́ıpadě použit́ı kontextové nab́ıdky zadáme do dokumentu n-tý člen posloupnosti,
klikneme na něj pravým tlač́ıtkem a zvoĺıme položku Sequence spolu s iteračńı proměnnou.
V následně zobrazeném okénku navoĺıme, které členy posloupnosti chceme vypsat do doku-
mentu. Použit́ı kontextové nab́ıdky má však oproti př́ıkazu seq mnohá omezeńı.

Obrázek 3.51: Různé možnosti vypsáńı člen̊u posloupnosti.

Posloupnosti {an} můžeme též vykreslovat do graf̊u. Potřebujeme k tomu vytvořit dvo-
jice [n, an], které následně zobraźıme jako body př́ıkazem plot. Pro vytvořeńı dvojic [n, an]
můžeme pochopitelně použ́ıt př́ıkaz seq, vykresleńı bod̊u je třeba specifikovat parametrem
style nastaveným na hodnotu point (v př́ıkazu plot).
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Obrázek 3.52: Vykresleńı člen̊u posloupnosti.

Obrázek 3.53: Různé možnosti zápisu nekonečných (i konečných) řad.

Nekonečné řady (i konečné součty) zadáváme v Maple několika zp̊usoby. Jednak paleta
Expression nab́ıźı předdefinovaný symbol velkého řeckého ṕısmene sigma, k dispozici je
také př́ıkaz sum a využ́ıt můžeme opět i kontextové nab́ıdky dokumentu (i když trochu

”
komplikovaně“). Př́ıkaz sum má dva parametry (n-tý člen řady a

”
součtové“ meze). Po

provedeńı př́ıkaz vyṕı̌se součet řady (pokud jej umı́ určit). Systém Maple nab́ıźı též př́ıkaz
Sum s velkým počátečńım ṕısmenem, jenž slouž́ı pro matematický zápis řady s použit́ım
řeckého ṕısmene sigma. A právě takový zápis je možné źıskat i pomoćı kontextové nab́ıdky,
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když do dokumetu zaṕı̌seme n-tý člen řady, klikneme na něj pravým tlač́ıtkem myši a zvoĺıme
položku Constructions > Sum > n. Daľśım kliknut́ım pravého tlač́ıtka myši (tentokrát na
matematický zápis řady) a zvoleńım Evaluate (from inert) źıskáme součet řady (pokud
jej Maple umı́ určit) – obrázek 3.53.

S t́ım, co již známe, nám nic nebráńı ve vypsáńı posloupnosti částečných součt̊u. Tuto
posloupnost nav́ıc můžeme vykreslit, např́ıklad společně se součtem řady – viz obrázek 3.54.

Obrázek 3.54: Vykresleńı posloupnosti částečných součt̊u a součtu řady.

Existuj́ı nekonečné řady, jejichž součet Maple neumı́ určit. V takových př́ıpadech ani
nevyṕı̌se, zda řada součet má (tj. zda konverguje) či zda řada diverguje. V těchto situaćıch
muśıme konvergenci řady vyšetřit

”
sami“ jinými postupy, přičemž si samozřejmě můžeme

”
pomáhat systémem Maple“ při d́ılč́ıch kroćıch.

Př́ıklad 3.65: Určete součty následuj́ıćıch řad:

(a)
∞∑
n=1

1
n·(n+1)

, (b)
∞∑
n=1

1
n2 , (c)

∞∑
n=1

1
n
.

Př́ıklad 3.66: Určete součty následuj́ıćıch řad:

(a)
∞∑
n=1

(√
n+ 2− 2 ·

√
n+ 1 +

√
n
)
, (b)

∞∑
n=1

arctan
(

1
2·n2

)
.

Řešeńı:

(a) Systém Maple zadanou řadu seč́ıst neumı́. Urč́ıme tedy částečný součet řady sk pro
libovolné (pevné) k a následně prověř́ıme existenci limity tohoto částečného součtu
pro k → ∞. Částečný součet sk přitom odvod́ıme na základě několika částečných
součt̊u pro r̊uzné konkrétńı numerické hodnoty. Zcela správně bychom měli (např́ıklad
matematickou indukćı) dokázat, že pravidlo, které vypozorujeme z některých (nejlépe
několika prvńıch) částečných součt̊u plat́ı skutečně pro libovolné k.

142



Naznačme proto takový d̊ukaz aspoň nyńı. Dı́ky Maple v́ıme, že

10∑
n=1

(√
n+ 2− 2 ·

√
n+ 1 +

√
n
)

= 1−
√

2−
√

11 +
√

12,

11∑
n=1

(√
n+ 2− 2 ·

√
n+ 1 +

√
n
)

= 1−
√

2−
√

12 +
√

13,

12∑
n=1

(√
n+ 2− 2 ·

√
n+ 1 +

√
n
)

= 1−
√

2−
√

13 +
√

14.

Předpokládejme nyńı, že pro libovolné k ≥ 10 plat́ı:

k∑
n=1

(√
n+ 2− 2 ·

√
n+ 1 +

√
n
)

= 1−
√

2−
√
k + 1 +

√
k + 2.

Pak plat́ı:

k+3∑
n=1

(√
n+ 2− 2 ·

√
n+ 1 +

√
n
)

= 1−
√

2−
√
k + 1 +

√
k + 2

+
(√

k + 3− 2 ·
√
k + 2 +

√
k + 1

)
+

(√
k + 4− 2 ·

√
k + 3 +

√
k + 2

)
+

(√
k + 5− 2 ·

√
k + 4 +

√
k + 3

)
= 1−

√
2−
√
k + 4 +

√
k + 5.

Zjistili jsme tedy, že pokud naše hypotéza plat́ı pro libovolné k ≥ 10, plat́ı i pro k+ 3.
Jelikož v́ıme, že vypozorovaný vztah plat́ı pro k ∈ {10, 11, 12}, pak muśı nutně platit
pro zcela libovolné k ≥ 10.

(b) Systém Maple zadanou řadu seč́ıst opět neumı́. Postupujeme totožným zp̊usobem jako
v předchoźım př́ıkladu. Opět je třeba dokázat, že vypozorovaný vztah skutečně plat́ı
pro libovolné k. V tomto př́ıpadě to necháváme na čtenáři (obrázek 3.55).

Pokud nedokážeme určit součet řady ani my, zpravidla bychom chtěli alespoň odpověd’

na otázku, zda řada konverguje či diverguje. Zabývat se nyńı budeme řadami s nezápornými
členy, u nichž plat́ı, že bud’ konverguj́ı (k nějaké konečné reálné hodnotě) nebo diverguj́ı
k nekonečnu. Pro zjǐstěńı, zda řada konverguje či diverguje, máme několik rozhodovaćıch
kritéríı.

Poznámka 3.28: (Srovnávaćı kritérium) Mějme řady
∞∑
n=1

an,
∞∑
n=1

bn s nezápornými členy

a necht’ an ≤ bn pro všechna n ∈ N. Pak plat́ı:

• konverguje-li řada
∞∑
n=1

bn, konverguje i řada
∞∑
n=1

an,

• diverguje-li řada
∞∑
n=1

an, diverguje i řada
∞∑
n=1

bn.
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Obrázek 3.55: Řešeńı př́ıkladu 3.66. Část (a) vlevo, část (b) vpravo.

Poznámka 3.29: (Limitńı srovnávaćı kritérium) Mějme řady
∞∑
n=1

an,
∞∑
n=1

bn s nezápornými

členy a necht’ existuje

lim
n→∞

an
bn

= L.

Pak plat́ı:

• je-li L <∞ a konverguje-li řada
∞∑
n=1

bn, konverguje i řada
∞∑
n=1

an,

• je-li L > 0 a diverguje-li řada
∞∑
n=1

bn, diverguje i řada
∞∑
n=1

an.

Poznámka 3.30: (Odmocninové kritérium) Necht’
∞∑
n=1

an je řada s nezápornými členy.

• Plat́ı-li pro všechna n ∈ N: n
√
an ≤ q < 1, pak řada konverguje,
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• existuje-li
lim
n→∞

n
√
an = q, kde q ∈ R ∪ {−∞,∞},

pak pro q < 1 řada konverguje, pro q > 1 řada diverguje.

Poznámka 3.31: (Pod́ılové kritérium) Necht’
∞∑
n=1

an je řada s nezápornými členy.

• Plat́ı-li pro všechna n ∈ N: an+1

an
≤ q < 1, pak řada konverguje, plat́ı-li pro všechna

n ∈ N: an+1

an
≥ 1, pak řada diverguje,

• existuje-li

lim
n→∞

an+1

an
= q, kde q ∈ R ∪ {−∞,∞},

pak pro q < 1 řada konverguje, pro q > 1 řada diverguje.

Poznámka 3.32: (Limitńı Raabeovo kritérium) Necht’
∞∑
n=1

an je řada s nezápornými

členy a necht’ existuje

lim
n→∞

n ·
(

1− an+1

an

)
= q, kde q ∈ R ∪ {−∞,∞},

pak pro q > 1 řada konverguje, pro q < 1 řada diverguje.

Poznámka 3.33: (Integrálńı kritérium) Necht’ je funkce f definovaná na intervalu
[1,∞), která je na tomto intervalu nezáporná a nerostoućı. Necht’ f(n) = an pro n ∈ N.

Pak řada
∞∑
n=1

an konverguje právě tehdy, když konverguje nevlastńı integrál

∞∫
1

f(x) dx.

Př́ıklad 3.67: Rozhodněte o konvergenci následuj́ıćıch řad:

(a)
∞∑
n=2

1
ln(n)

,

(b)
∞∑
n=1

sin
(
π
n

)
,

(c)
∞∑
n=1

n

(3+ 1
n)

n ,

(d)
∞∑
n=1

nn

n!
,

(e)
∞∑
n=2

1
n·ln(n)

.

Řešeńı:

(a) Využijeme srovnávaćıho kritéria a toho, že řada
∞∑
n=2

1
n

diverguje. Jelikož pro všechna

n ∈ N \ {1} plat́ı: 1
n
< 1

ln(n)
, podle srovnávaćıho kritéria řada

∞∑
n=2

1
ln(n)

diverguje.
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Obrázek 3.56: Pomocné výpočty k řešeńı př́ıkladu 3.67.

(b) Nyńı využijeme limitńıho srovnávaćıho kritéria a znovu řady
∞∑
n=2

1
n
, která diverguje.

Jelikož lim
n→∞

sin(πn)
1
n

= π, řada
∞∑
n=1

sin
(
π
n

)
diverguje.

(c) Opět budeme poč́ıtat limitu, tentokrát v odmocninovém kritériu.
Jelikož lim

n→∞
n

√
n

(3+ 1
n)

n = 1
3
, zadaná řada konverguje.

146



(d) V tomto př́ıpadě využijeme pod́ılového kritéria, resp. opět jeho limitńı varianty.

Jelikož lim
n→∞

(n+1)n+1

(n+1)!
nn

n!

= e, zadaná řada diverguje.

(e) V posledńım př́ıpadě použijeme integrálńı kritérium. Funkce f(x) = 1
x·ln(x)

je na inter-

valu [2,∞) nezáporná a klesaj́ıćı (předpoklady integrálńıho kritéria). Jelikož

∞∫
2

f(x) dx =∞,

řada
∞∑
n=2

1
n·ln(n)

diverguje. Pomocné výpočty v Maple k tomuto př́ıkladu ilustruje obrázek

3.56.

Př́ıklad 3.68: Rozhodněte o konvergenci následuj́ıćıch řad:

(a)
∞∑
n=1

(√
n−
√
n− 1

)
,

(b)
∞∑
n=1

1√
n2+2·n ,

(c)
∞∑
n=1

√
n√

n4+1
,

(d)
∞∑
n=1

ln
(
1 + 1

n2

)
,

(e)
∞∑
n=1

sin
(
π
2n

)
,

(f)
∞∑
n=1

2n

n4 ,

(g)
∞∑
n=1

2n

nn
,

(h)
∞∑
n=1

2n·n!
nn

,

(i)
∞∑
n=1

1
n3 .

3.6.1 Absolutńı konvergence řad

Definice 3.19: Nekonečná řada
∞∑
n=1

an se nazývá alternuj́ıćı, jestliže pro všechna n ∈ N

plat́ı: signum(an+1) = −signum(an).

Poznámka 3.34: (Leibnizovo kritérium) Necht’ an je nerostoućı posloupnost kladných

č́ısel. Pak alternuj́ıćı řada
∞∑
n=1

(−1)n−1 · an konverguje právě tehdy, když plat́ı lim
n→∞

an = 0.

Alternuj́ıćı řady zadáváme systému stejným zp̊usobem jako veškeré nekonečné řady. Jak
uvid́ıme, systém Maple umı́ poč́ıtat součty alternuj́ıćıch řad. V př́ıpadech, kdy součet řady
určit nedokáže, nám velmi pomůže výše zmı́něné Leibnizovo kritérium konvergence.

Př́ıklad 3.69: Rozhodněte o konvergenci následuj́ıćıch řad:

(a)
∞∑
n=1

1
n
· (−1)n−1, (b)

∞∑
n=1

1
n√n · (−1)n−1.

Řešeńı:

(a) Systém Maple urč́ı součet zadané řady.

(b) V tomto př́ıpadě Maple součet neurč́ı. Využijeme proto Leibnizova kritéria, d́ıky němuž
zjist́ıme, že zadaná řada diverguje.
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Obrázek 3.57: Pomocné výpočty k řešeńı př́ıkladu 3.69.

Definice 3.20: Řekneme, že nekonečná řada
∞∑
n=1

an konverguje absolutně, jestliže konver-

guje řada
∞∑
n=1

|an|. Jestliže řada
∞∑
n=1

an konverguje a řada
∞∑
n=1

|an| diverguje, ř́ıkáme, že řada

∞∑
n=1

an konverguje neabsolutně.

Poznámka 3.35: Konverguje-li řada
∞∑
n=1

|an|, konverguje i řada
∞∑
n=1

an. Diverguje-li řada

∞∑
n=1

an, pak diverguje také řada
∞∑
n=1

|an|.

Př́ıklad 3.70: Rozhodněte o konvergenci a absolutńı konvergenci následuj́ıćıch řad:

(a)
∞∑
n=1

ln
(
1 + 1

n

)
· (−1)n−1, (b)

∞∑
n=2

1
n·ln(n)

· (−1)n.

Řešeńı:

(a) Systém Maple součet zadané řady neurč́ı. Využijeme proto Leibnizova kritéria, d́ıky
němuž zjist́ıme, že zadaná řada konverguje. K posouzeńı absolutńı konvergence již
můžeme využ́ıt systému Maple. Závěr tedy je, že zadaná řada konverguje neabsolutně.

(b) Systém Maple neurč́ı součet ani jedné z řad. Pro posouzeńı konvergence zadané řady
využijeme Leibnizova kritéria, d́ıky němuž zjist́ıme, že zadaná řada konverguje. Kon-
vergenci (resp. divergenci) řady absolutńıch hodnot můžeme ověřit např. integrálńım
kritériem, což jsme prováděli již v př́ıkladu 3.67.(e), kde jsme zjistili, že tato řada
diverguje. Závěr tedy je, že zadaná řada konverguje neabsolutně.
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Obrázek 3.58: Pomocné výpočty k řešeńı př́ıkladu 3.70.

Př́ıklad 3.71: Rozhodněte o konvergenci a absolutńı konvergenci následuj́ıćıch řad:

(a)
∞∑
n=1

1
(2·n+1)!

· (−1)n−1,

(b)
∞∑
n=1

1
3·n−1

· (−1)n−1,

(c)
∞∑
n=1

1
ln(n+1)

· (−1)n−1,

(d)
∞∑
n=1

1
(n−ln(n)

· (−1)n,

(e)
∞∑
n=1

1
(ln(n))n

· (−1)n,

(f)
∞∑
n=1

n

(3+ 1
n)

n · (−1)n−1.

149



4 Lineárńı algebra s Maple v Cn.

Oproti kapitolám věnovaným matematické analýze nyńı přejdeme od prostoru reálných č́ısel
R k obecněǰśımu prostoru č́ısel komplexńıch C.

4.1 Vektorové prostory

4.1.1 Vektory

Definice 4.1: Necht’ n ∈ N. Vektorem v prostoru Cn rozumı́me uspořádanou n-tici kom-
plexńıch č́ısel. Sč́ıtáńı vektor̊u definujeme po složkách, při násobeńı vektoru skalárem (tj.
komplexńım č́ıslem) vynásob́ıme skalárem každou složku vektoru.

Poznámka 4.1: Vektorem zpravidla přesněji rozumı́me uspořádanou n-tici zapsanou jako
sloupec hodnot.

V systému Maple můžeme vektor vytvořit dvěma hlavńımi zp̊usoby1. Prvńım je zapsat
složky vektoru do lomených závorek, druhý zp̊usob představuje použit́ı př́ıkazu Vector.
Př́ıkaz nemá žádný povinný parametr, nicméně jeho provedeńı bez parametru vytvoř́ı 0-
dimenzionálńı vektor. V nepovinných parametrech můžeme př́ıkazu předevš́ım ř́ıct, jakou
má mı́t výsledný vektor dimenzi a z jakých hodnot se má skládat.

Obrázek 4.1: Definice vektoru v Maple.

1V sekci 4.1.2 si ukážeme ještě jeden významný zp̊usob vytvořeńı vektoru pomoćı palet.

150



Obrázek 4.2: Možnosti při definováńı vektoru.

Maple standardně vytvoř́ı vektor jako sloupec hodnot. Pokud chceme mı́t řádek hodnot,
použijeme př́ıkaz ve tvaru Vector[row]. Vı́ce je patrné z obrázk̊u 4.1 a 4.2. Na obrázku 4.2
Maple při prvńım pokusu o vytvořeńı vektoru vyṕı̌se chybovou zprávu Error, recursive
assignment. Tato zpráva se objevuje vždy, když se snaž́ıme definovat proměnnou pomoćı
sebe sama. Muśıme mı́t na paměti, že v Maple neńı možné použ́ıt značeńı, na něž jsme zvykĺı
z přednášek, tj. např. u = (u1, u2, u3).

K jednotlivým složkám vektoru můžeme přistupovat přes indexy. Ty je možné zapisovat
do kulatých nebo hranatých závorek, přičemž hranaté závorky jsou ekvivalentńı dolńımu
indexu, tj. u[i] = ui. Funkcionalita kulatých a hranatých závorek v indexováńı vektor̊u sice
neńı naprosto totožná, ale pro naše potřeby prakticky bude, a je tak možné použ́ıvat oboj́ı
značeńı2. Indexem může být jediné č́ıslo (i), seznam hodnot ([i1, i2, ..., in]) nebo interval
(i1..i2). Použit́ı ilustruje obrázek 4.3.

Poznámka 4.2: Vektory v prostorech R2 a R3 si představujeme jako orientované úsečky,
tj. úsečky, jejichž jeden krajńı bod považujeme za počátečńı a druhý za koncový – ten
je označený šipkou. Přitom dvě stejně dlouhé, rovnobežné a souhlasně orientované úsečky
představuj́ı tentýž vektor. Ř́ıkáme, že takové úsečky jsou r̊uznými umı́stěńımi téhož vektoru.

Poznámku 4.2 můžeme ilustrovat pomoćı př́ıkazu PlotVector z baĺıku VectorCalculus

– obrázek 4.4.

2Vı́ce o indexováńı vektor̊u, matic a obecných poĺı najdeme např. v nápovědě: http://www.maplesoft.
com/support/help/Maple/view.aspx?path=rtable_indexing
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Obrázek 4.3: Indexováńı vektoru.

Obrázek 4.4: Vykresleńı vektoru.

Sč́ıtáńı vektor̊u můžeme v Maple znázornit např́ıklad pomoćı matematické aplikace do-
stupné od verze Maple 16. Spuštěńım Tools > Math Apps a zvoleńım Vector Addition
z části Vectors umı́st́ıme do dokumentu interaktivńı graf s dvěma vektory a jejich součtem.
Vektory je přitom možné pomoćı myši libovolně měnit. Podobu interaktivńıho grafu posky-
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tuje obrázek 4.5 vlevo. Kromě aplikace znázorňuj́ıćı sč́ıtáńı vektor̊u nab́ıźı Maple též aplikaci
pro odč́ıtáńı vektor̊u (Vector Subtraction) – obrázek 4.5 vpravo.

Obrázek 4.5: Interaktivńı graf znázořnuj́ıćı sč́ıtáńı vektor̊u (vlevo) a odč́ıtáńı vektor̊u (vpravo).

Definice 4.2: Necht’ n ∈ N. Řekneme, že V ⊆ Cn spolu s výše definovanými operacemi
sč́ıtáńı vektor̊u a násobeńı vektoru skalárem je vektorový (resp. lineárńı) prostor nad polem
K ∈ {R,C}, jestliže

1. nulový vektor, tj. (0, 0, ..., 0), patř́ı do V ,

2. ∀u, v ∈ V, ∀k, l ∈ K : k · u+ l · v ∈ V .

Poznámka 4.3: Vektorový prostor nad obecným polem skalár̊u spolu s operacemi sč́ıtáńı
vektor̊u a násobeńı vektoru skalárem (ne nutně definovanými stejně jako v tomto textu) bývá
standardně definován pomoćı osmi axiomů. Ty zajǐst’uj́ı např. komutativitu a asociativitu
sč́ıtáńı vektor̊u, existenci nulového a jednotkového prvku a daľśı. Ponecháváme na čtenáři,
aby ověřil, že výše definovaný vektorový prostor vyhovuje i standardńı definici.

Poznámka 4.4: Standardńı definici vektorového prostoru odpov́ıdá daleko v́ıce množin
s operacemi sč́ıtáńı vektor̊u a násobeńı vektoru skalárem. My jsme se pro jednoduchost
omezili pouze na ty vektorové prostory, s nimiž budeme dále v textu pracovat.

Definice 4.3: Necht’ n ∈ N, V je vektorový prostor nad K ∈ {R,C}. Výraz
n∑
i=1

ki · ui

pro u1, u2, ..., un ∈ V, k1, k2, ..., kn ∈ K nazýváme lineárńı kombinaćı vektor̊u u1, u2, ..., un
s koeficienty k1, k2, ..., kn. Vektory u1, u2, ..., un nazveme lineárně závislými, jestliže existuj́ı
č́ısla k1, k2, ..., kn ∈ K tak, že alespoň jedno z nich je nenulové, a plat́ı

n∑
i=1

ki · ui = 0.

Pokud taková netriviálńı lineárńı kombinace neexistuje, nazýváme vektory u1, u2, ..., un lineár-
ně nezávislými.
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Definice 4.4: Necht’ V je vektorový prostor nad K ∈ {R,C}. Řekneme, že neprázdná
množina U ⊆ V je vektorový podprostor prostoru V nad K, jestliže vyhovuje definici 4.2.
Mějme dále množinu M ⊂ V . Pr̊unik všech vektorových podprostor̊u prostoru V , které
obsahuj́ı množinu M , se nazývá lineárńım obalem množiny M . Báźı vektorového prostoru V
nad K je množina lineárně nezávislých vektor̊u, jejichž lineárńı obal je roven celému prostoru
V . Koeficienty lineárńı kombinace vyjadřuj́ıćı vektor u ∈ V ve zvolené bázi {u1, u2, ..., un}
se nazývaj́ı souřadnice vektoru u v této bázi.

Obrázek 4.6: Určeńı báze vektorového prostoru v Maple.

Pro nalezeńı báze vektorového prostoru poskytuje Maple př́ıkaz Basis z baĺıku
LinearAlgebra. Jeho parametrem je seznam (nebo množina) vektor̊u, z nichž chceme určit
bázi prostoru, který generuj́ı.

Definice 4.5: Bázi εn = {e1, e2, ..., en}, n ∈ N vektorového prostoru V = Kn nad K ∈
{R,C}, kde

ei(j) = 1 pro i = j, ei(j) = 0 pro i 6= j, i, j = 1, 2, ..., n

nazýváme kanonickou (resp. standardńı) báźı tohoto prostoru.

Poznámka 4.5: Pokud nebude uvedeno jinak, budou v daľśım textu souřadnice vektor̊u
udávány vždy ve standardńı bázi. Podobně vektorový prostor V = Kn,K ∈ {R,C}, n ∈ N
bude vždy nad př́ıslušným polem K.

Př́ıklad 4.1: Necht’ V = C3 se standardńı báźı. Určete souřadnice vektoru u = (3, 5,−2)
ve standardńı bázi.

Řešeńı: Odpověd’ je triviálńı. Př́ıklad slouž́ı k zamyšleńı se nad výše definovanými pojmy.
Souřadnice vektoru u ve standardńı bázi jsou právě (3, 5,−2), nebot’

3 · e1 + 5 · e2 − 2 · e3 = 3 · (1, 0, 0) + 5 · (0, 1, 0)− 2 · (0, 0, 1) = (3, 5,−2).

Př́ıklad 4.2: Necht’ V = C3. Uvažujme bázi α = {(3, 0, 0), (0, 2, 0), (0, 0, 1)}. Určete
souřadnice vektor̊u standardńı báze v bázi α.

Př́ıklad 4.3: Jsou vektory u1 = (1,−2, 3), u2 = (2,−1, 0), u3 = (1, 1,−3) lineárně nezávislé?

Př́ıklad 4.4: Generuj́ı vektory u1 = (1,−2, 3), u2 = (2,−1, 0), u3 = (1, 1,−3), u4 =
(1, 0,−1)} vektorový prostor R3?
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4.1.2 Matice

Definice 4.6: Necht’ m,n ∈ N. Matićı typu m × n nad množinou komplexńıch č́ısel C
rozumı́me obdélńıkové schéma 

a11 a12 . . . a1n

a21 a22 . . . a2n
...

...
...

am1 am2 . . . amn

 ,

kde aij ∈ C pro všechna i ∈ {1, 2, ...,m}, j ∈ {1, 2, ..., n} se nazývaj́ı prvky matice. Jestliže
m = n, mluv́ıme o čtvercové matici řádu n.

Poznámka 4.6: Jelikož vektorem můžeme chápat matici typu m× 1, lze vektory v Maple
zadávat stejným zp̊usobem jako matice.

Matice v Maple vytvář́ıme předevš́ım následuj́ıćımi třemi zp̊usoby:

• použit́ım lomených závorek se svislou čarou odděluj́ıćı jednotlivé sloupce matice,

• použit́ım př́ıkazu Matrix

• nebo použit́ım palety Matrix.

Konkrétńı př́ıklady jsou uvedeny na obrázćıch 4.7 a 4.8.

Obrázek 4.7: Př́ıklady vytvořeńı matice v Maple.

Zcela analogicky, jako jsme přistupovali k jednotlivým prvk̊um vektoru, specifikujeme též
prvky matice. Opět využ́ıváme zápisu index̊u do kulatých nebo hranatých závorek. Ovšem
pozor, v př́ıpadě matic již naraźıme na některé odlǐsnosti těchto dvou zápis̊u. Při použit́ı
jediného indexu (resp. indexu pro jednu dimenzi), který vyjadřuje označeńı řádku matice, je
u kulatých závorek automaticky brán pouze prvńı sloupec, u hranatých závorek celý řádek
matice. Vı́ce je patrné z př́ıklad̊u na obrázku 4.9.
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Obrázek 4.8: Daľśı možnosti při vytvářeńı matice v Maple.

Obrázek 4.9: Indexováńı matice.

Poznámka 4.7: Matice znač́ıme velkými ṕısmeny, jejich prvky ṕısmeny malými. To zna-
mená, že např. prvky matice A budeme v textu značit aij (pro vhodná i, j). Systém Maple
rozlǐsuje velikosti ṕısmen, takže v něm se muśıme držet zavedeného označeńı (tj. použ́ıvat
stále stejné ṕısmeno včetně jeho velikosti). Ṕısmenem E budeme značit jednotkovou čtvercovou
matici řádu n ∈ N, tj. matici, pro niž plat́ı: ∀i, j ∈ {1, 2, ..., n} : eij = 1 pro i = j, eij = 0
jinak.

156



Definice 4.7: Nad maticemi definujeme následuj́ıćı operace:

• součet matic: A+ B = C, jestliže A,B,C jsou matice typu m× n (m,n ∈ N) a plat́ı:
∀i ∈ {1, 2, ...,m}, j ∈ {1, 2, ..., n} : cij = aij + bij,

• násobeńı matice skalárem: k ·A = B, jestliže A,B jsou matice typu m×n (m,n ∈ N),
k ∈ C a plat́ı: ∀i ∈ {1, 2, ...,m}, j ∈ {1, 2, ..., n} : bij = k · aij,

• násobeńı matic: A · B = C, jestliže A je matice typu m × n, B je matice typu n × q,
C je matice typu m× q (m,n, q ∈ N) a plat́ı:

∀i ∈ {1, 2, ...,m}, k ∈ {1, 2, ..., q} : cik =
n∑
j=1

aij · bjk.

Definice 4.8: Necht’ A je matice typu m× n (m,n ∈ N). Matici AT typu n×m nazveme
transponovanou matićı matice A, jestliže pro jej́ı prvky plat́ı: aTij = aji pro všechna i ∈
{1, 2, ...,m}, j ∈ {1, 2, ..., n}. Čtvercovou matici A řádu n ∈ N nazýváme symetrickou, jestliže
plat́ı AT = A.

Definice 4.9: Necht’ A,B jsou čtvercové matice řádu n ∈ N splňuj́ıćı A · B = B · A = E.
Pak se matice B nazývá inverzńı matićı k matici A a znač́ı se A−1. Matici, k ńıž existuje
matice inverzńı, nazýváme invertibilńı matićı.

Obrázek 4.10: Maticové operace v Maple.
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Obrázek 4.10 ilustruje pojmy předcházej́ıćıch definic v Maple. Sč́ıtáńı matic a násobeńı
matice skalárem je stejné jak v psaném textu. Totéž plat́ı pro zápis inverzńı matice. Pro
násobeńı matic je určena tečka (tj. tatáž tečka na spodńım okraji řádku, kterou např́ıklad
ukončujeme větu). Zápis transponované matice se lǐśı od klasického matematického zápisu
přidáńım symbolu % do exponentu matice. Pro výpočet inverzńı a transponované matice
poskytuje nav́ıc Maple př́ıkazy MatrixInverse a Transpose, které však oba nálež́ı do
baĺıku LinearAlgebra, jenž je proto potřeba před jejich použit́ım nač́ıst. Pokud se po-
kuśıme vypoč́ıtat inverzi k neinvertibilńı (tj. singulárńı) matici, vyṕı̌se systém Maple chy-
bovou zprávu Error, (in rtable/Power) singular matrix.

Matici můžeme systému Maple zadávat i blokově. Na obrázku 4.11 vid́ıme, jak k tomu
použ́ıt př́ıkaz Matrix.

Obrázek 4.11: Maticové operace v Maple.

Př́ıklad 4.5: Necht’

A =

(
cos(α) − sin(α)
sin(α) cos(α)

)
.

Určete A2, A3, ....

Řešeńı: V Maple źıskáme př́ıslušné matice jednoduše, a to pouhým přepisem maticových
výraz̊u. Nicméně obdržený výsledek neńı v nejjednodušš́ım tvaru, což naprav́ıme použit́ım
př́ıkazu combine (viz část 2.1.1). Při provedńı indukčńıho kroku (k d̊ukazu správnosti předpo-
kladu o obecném tvaru Ak) je možné pro

”
lepš́ı“ vzhled použ́ıt př́ıkaz factor, jenž je třeba

aplikovat na každý prvek matice. K takové aplikaci slouž́ı př́ıkaz map. Řešeńı v systému Maple
znázorňuje obrázek 4.12.

Př́ıklad 4.6: Necht’

A =

 1 0
2 1
−1 2

 , B =
(
−1 0 2

)
, C =

(
1 0 0 −1
0 2 0 5

)
,
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Obrázek 4.12: Maticové operace v Maple.

F =

 1 2 0
−2 0 −3
0 3 5

 , G =

1 0 0
0 1 −4
1 0 1

 , H =


1
−3
0
7

 .

Určete G2 − 3 · F, A− F, A−G · F · A, B · A · C ·H −B · F ·BT .

Př́ıklad 4.7: K matićım

A =

(
1 0
2 4

)
, B =

(
1 + I 1− I

2 I

)
, C =

(
a b
c d

)
, F =

 1 1 1
2 3 3
−1 −3 −2


určete matice inverzńı.

Př́ıklad 4.8: Vytvořte matici A typu 4× 4 tak, aby:

a) aij = i+ j,

b) aij = ij−1,

c) aij =

{
1 ... pokud |i− j| > 1

−1 ... pokud |i− j| ≤ 1.

pro i, j ∈ {1, 2, 3, 4}.
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Př́ıklad 4.9: Necht’ 0 je nulová matice typu 2× 2. Existuje nenulová matice A typu 2× 2
tak, že:

a) A · A = 0 ?

b) A · A = A ?

Př́ıklad 4.10: Ukažte, že matice

A =

(
cos(α) − sin(α)
sin(α) cos(α)

)
reprezentuje otočeńı v rovině o úhel α. Tj. jestliže matićı A vynásob́ıme (sloupcový) vektor,
źıskáme vektor pootočený o úhel α. Ilustrujte graficky.

4.1.3 Soustavy lineárńıch rovnic

Poznámka 4.8: Soustavy lineárńıch rovnic můžeme přehledně zapisovat pomoćı matic.
Uvažujme systém

a11 · x1 + a12 · x2 + · · ·+ a1n · xn = y1,

a21 · x1 + a22 · x2 + · · ·+ a2n · xn = y2,
...

am1 · x1 + am2 · x2 + · · ·+ amn · xn = ym.

Jestliže označ́ıme A = (aij), x = (x1, x2, ..., xn)T , y = (y1, y2, ..., ym)T , můžeme uvedený
systém přepsat do tvaru

A · x = y.

Baĺık LinearAlgebra nab́ıźı pro řešeńı soustav lineárńıch rovnic př́ıkaz LinearSolve.
Př́ıkaz má dva základńı parametry, a to matici A a vektor y, který neńı nutné uvádět
v př́ıpadě, že je nulový. Dále máme k dispozici ještě několik nepovinných parametr̊u, z nichž
uved’me parametr free, v němž můžeme specifikovat symbol pro volnou proměnou (tj. pa-
rametr použitý při zápisu výsledku s nekonečně mnoha řešeńımi). Ukázku použit́ı nab́ıźı
obrázek 4.13.

Mezi pomocnými nástroji zvanými Tutors (spustitelnými např́ıklad z položky Tools
hlavńıho menu) najdeme pro lineárńı algebru mj. nástroj ilustruj́ıćı soustavu lineárńıch rov-
nic graficky – Linear System Plot. Tento maplet je možné použ́ıt v oborech R2 a R3,
v nichž dané rovnice představuj́ı př́ımky nebo roviny. Názorně tak můžeme vidět, zda
má zadaná soustava rovnic řešeńı a kolik jich je. Maplet je možné spustit př́ımo z doku-
mentu př́ıkazem LinearSystemPlotTutor z baĺıku Student[LinearAlgebra]. Jeho podobu
znázorňuje obrázek 4.14.

Pomoćı př́ıkazu LinearSolve můžeme též jednoduše zjistit souřadnice vektoru v zadané
bázi – viz př́ıklad 4.11.

Př́ıklad 4.11: Uvažujme bázi α = {u1, u2, u3} vektorového prostoru V , kde u1 = (2,−1, 0)T ,
u2 = (−4, 1, 2)T , u3 = (3, 0,−1)T . Určete souřadnice vektoru z = (−2,−1, 2)T v bázi α.

Řešeńı: Souřadnice zn v bázi α jsou řešeńım rovnice A · zn = z, kde matice A je tvořena
právě báźı α. Postup výpočtu ilustruje obrázek 4.15.
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Obrázek 4.13: Řešeńı soustav lineárńıch rovnic př́ıkazem LinearSolve.

Obrázek 4.14: Grafické zobrazeńı soustavy lineárńıch rovnic.

Př́ıklad 4.12: Uvažujme soustavu lineárńıch rovnic s neznámými x, y, z a parametry c, d ∈
C:

x+ c · y − c · z = −3,

x+ (c− 1) · y − (c+ 3) · z = −5,

x+ (c+ 1) · y + 2 · z = d− 1.

Určete, pro která c, d má soustava žádné, jedno, resp. nekonečně mnoho řešeńı.
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Obrázek 4.15: Řešeńı př́ıkladu 4.11.

Řešeńı: Zaṕı̌seme zadanou soustavu maticově a využijeme př́ıazu LinearSolve. Źıskáme
řešeńı vyjádřené pomoćı parametr̊u c, d. Počet řešeńı soustavy je závislý předevš́ım na hod-
notě jmenovatele. Pokud je nenulový (c 6= 1), soustava má jediné řešeńı. Pokud je jmenovatel
nulový (c = 1), je nutné rozlǐsit př́ıpady, kdy je nulový i čitatel (d = 0, nekonečně mnoho
řešeńı) a kdy je čitatel r̊uzný od nuly (d 6= 0, tj. kdy zlomek nemá smysl, a tedy ani soustava
řešeńı). Postup výpočtu je uveden na obrázku 4.16. Při řešeńı bylo využito (nově) př́ıkaz̊u
numer pro źıskáńı čitatele zlomku a op k źıskáńı operand̊u ze zadaného výrazu (v tomto
př́ıpadě ze seznamu).

Obrázek 4.16: Řešeńı př́ıkladu 4.12.
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Př́ıklad 4.13: Uvažujme bázi α = {u1, u2, u3} vektorového prostoru V , kde u1 = (1, 1, 0)T ,
u2 = (1, 0, 1)T , u3 = (0, 1, 1)T . Určete souřadnice vektoru v = (1, 2, 3)T v bázi α.

Př́ıklad 4.14: Který z vektor̊u u1, u2, u3, u4 doplňuje množinu α na bázi prostoru R4?:

a) α = {(1,−2, 1,−1)T , (1, 0,−1,−1)T , (1, 1,−2, 0)T},
u1 = (−1, 2,−1, 1)T , u2 = (3,−1,−2,−1)T , u3 = (2, 1, 0,−2)T , u4 = (2, 1,−3,−2)T .

b) α = {(1, 3, 0,−1)T , (1, 0, 0,−1)T , (0, 2, 1, 0)T},
u1 = (−1, 1,−1, 1)T , u2 = (3,−1, 0,−3)T , u3 = (2, 1, 0,−2)T , u4 = (1,−2, 0,−1)T .

Př́ıklad 4.15: Prostory Rn[x] a Cn[x] všech polynomů s reálnými, resp. komplexńımi,
koeficienty spolu se standardně definovaným součtem polynomů a skalárńım násobkem po-
lynomu tvoř́ı také vektorový prostor (pozn. dokažte). Zjistěte, zda jsou následuj́ıćı polynomy
v uvedených prostorech lineárně závislé nebo ne:

a) R3[x] : 1− x, x− x2, x2 − x3, x3 − 1,

b) R3[x] : 1 + x, x+ x2, x2 + x3, x3 + 1,

c) R2[x] : 2− x+ 4 · x2, 3 + 6 · x+ 2 · x2, 2 + 10 · x− 4 · x2,

d) R2[x] : 1 + 3 · x+ 3 · x2, x+ x2, 5 + 6 · x+ 3 · x2, 7 + 2 · x− x2.

Př́ıklad 4.16: Uvažujme soustavu lineárńıch rovnic s neznámými x, y, z a parametry a, b ∈
R:

a)

a · x+ y − 2 · z = 1,

x− y + z = 0,

(1 + a) · y − z = b.

b)

x− a · y − 2 · z = b,

x+ (1− a) · y = b− 3,

x+ (1 + a) · y + a · z = 2 · b− 1.

Určete, pro která a, b má soustava žádné, jedno, resp. nekonečně mnoho řešeńı.

Př́ıklad 4.17: Uvažujme soustavu lineárńıch rovnic s neznámými x1, x2, x3 a parametry
a, b, c ∈ C:

x1 + x2 + x3 = 3,

x1 + a · x2 + x3 = 2,

b · x1 + 2 · x2 + 2 · x3 = c.

Určete, pro která a, b, c má soustava žádné, jedno, resp. nekonečně mnoho řešeńı.
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4.1.4 Gaussova eliminace

Poznámka 4.9: (Gaussova eliminace) Nenulovou matici A typu m×n nad C lze konečně
mnoha elementárńımi řádkovými operacemi převést na tzv. (řádkově) schodovitý tvar. Tento
tvar můžeme zapsat následuj́ıćımi podmı́nkami:

• je-li ∀i : 1 ≤ i ≤ k < m, j ∈ {1, 2, ..., n} : aij = 0, pak také ∀i > k : aij = 0,

• je-li pro 1 ≤ i < m, j ∈ {1, 2, ..., n} : aij prvńı nenulový prvek na i-tém řádku,
pak a(i+1)j = 0.

Elementárńı řádkovou operaćı přitom rozumı́me jednu z následuj́ıćıch transformaćı:

1. výměnu dvou řádk̊u matice A,

2. vynásobeńı některého řádku matice A nenulovým komplexńım č́ıslem,

3. přičteńı skalárńıho násobku některého řádku matice A k jinému jej́ımu řádku.

Pro převod matice na schodovitý tvar poskytuje Maple př́ıkaz GaussianElimination,
opět z baĺıku LinearAlgebra. Jeho jediným povinným parametrem je matice, již chceme
na schodovitý tvar převést. Jedńım z volitelných parametr̊u je parametr method, který při
nastaveńı na FractionFree uprav́ı matici na schodovitý tvar tak, aby všechna č́ısla matice
byla celá – obrázek 4.17.

Obrázek 4.17: Gaussova eliminace v Maple.

Př́ıkazem GaussianElimination źıskáme rovnou výsledek. Pokud nás zaj́ımá postup
výpočtu, můžeme využ́ıt pomocńıka GaussianEliminationTutor z baĺıku Student[Linear-

Algebra] dostupného též z hlavńıho menu (Tools > Tutors > LinearAlgebra > Gaus-
sian Elimination...). Podobně jako u jiných pomocných maplet̊u můžeme sami provádět
zvolené úpravy se zadanou matićı nebo nechat systém Maple, aby nám sám ukázal následuj́ıćı
krok výpočtu, př́ıpadně celé odvozeńı až k výsledku. Grafická podoba mapletu je uvedena
na obrázku 4.18 vlevo.

Pomoćı Gaussovy eliminace můžeme řešit systémy lineárńıch rovnic. K tomu Maple nab́ıźı
daľśıho pomocńıka – př́ıkaz LinearSolveTutor z baĺıku Student[LinearAlgebra], taktéž
dostupného z hlavńıho menu (Tools > Tutors > LinearAlgebra > Linear System Sol-
ving...). Podoba tohoto pomocńıka (obrázek 4.18 vpravo) je takřka shodná s mapletem pro
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Obrázek 4.18: Pomocńık při výpočtu Gaussovy eliminace.

Gaussovu eliminaci. V tomto př́ıpadě však můžeme postupovat dále k výpočtu řešeńı (po-
moćı tlač́ıtka Solve System). Při spouštěńı pomocńıka jsme dotázáńı, jestli chceme použ́ıt
Gaussovu eliminaci nebo Gaussovu-Jordanovu eliminaci, která uprav́ı matici až do jednot-
kového tvaru.

Jelikož pro invertibilńı čtvercovou matici A plat́ı: A ·A−1 = A−1 ·A = E, kde E je jednot-
ková matice, je možné využ́ıt Gaussovy eliminace i při výpočtu inverzńı matice. Pro tento po-
stup nab́ıźı Maple daľśıho pomocńıka podobného dvěma předchoźım: př́ıkaz3 InverseTutor

z baĺıku Student[LinearAlgebra], i v tomto př́ıpadě dostupného z hlavńıho menu (Tools
> Tutors > LinearAlgebra > Matrix Inverse...).

Př́ıklad 4.18: Řeště soustavu lineárńıch rovnic v R užit́ım Gaussovy eliminace:

2 · x1 − 3 · x2 + 17 · x3 − 29 · x4 − 36 · x5 = 22,

2 · x1 − 3 · x2 + 18 · x3 − 27 · x4 + 33 · x5 = 21,

12 · x1 − 18 · x2 + 102 · x3 − 174 · x4 − 216 · x5 = 132,

2 · x1 − 3 · x2 + 21 · x3 − 24 · x4 − 30 · x5 = 20,

2 · x1 − 3 · x2 + 24 · x3 − 21 · x4 − 27 · x5 = 19.

Řešeńı: Zadanou soustavu je možné řešit pomocńıkem LinearSolveTutor. Lze však
použ́ıt i př́ıkaz GaussianElimination, což provedeme i my. Soustavu zaṕı̌seme maticově
ve tvaru A · x = y, př́ıkaz GaussianElimination použijeme na matici A doplněnou o slou-
pec y. V tomto př́ıpadě nemáme k dispozici svislou čáru odděluj́ıćı matici A od vektoru y,
což muśıme mı́t na paměti.

Po aplikaci Gaussovy eliminace źıskáme matici ve schodovitém tvaru, z ńıž na prvńı
pohled poznáme, že soustava má nekonečně mnoho řešeńı závislých na parametru, který
přǐrad́ıme bud’ k neznámé x1 nebo x2. Poté zbývá už pouze dopoč́ıtat hodnoty zbylých
neznámých, k čemuž použijeme př́ıkaz solve. Jeho prvńım parametrem je množina rovnic
vyplývaj́ıćı ze źıskané matice ve schodovitém tvaru. Proměnná res obsahuje vektor řešeńı,
tj. (x1, x2, ..., x5)T .

3Pozor! Neplést se stejnojmenným př́ıkazem z baĺıku Student[Calculus1] pro vykresleńı inverzńı funkce.
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Obrázek 4.19: Řešeńı př́ıkladu 4.18.

Př́ıklad 4.19: Řeště soustavu lineárńıch rovnic v C užit́ım Gaussovy eliminace:

a)

x+ 2 · I · y = 5 + 4 · I,
(3− I) · y + (6− 2 · I) · z = 10,

2 · x− z = 5 + 3 · I,
x+ y − z = 5 + 2 · I,

b)

(1 + I) · x+ 3 · I · y = −I,
(1 + 2 · I) · x+ (1− I) · y = 6 + I,

c)

(1 + I) · x+ (1− I) · y = 6 + 4 · I,
I · x+ (1 + 2 · I) · y = −3 + 5 · I.
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Př́ıklad 4.20: Řeště soustavu lineárńıch rovnic v R užit́ım Gaussovy eliminace:

x1 + 3 · x2 − 2 · x3 + 2 · x5 = 0,

2 · x1 + 6 · x2 − 5 · x3 − 2 · x4 + 4 · x5 − 3 · x6 = −1,

5 · x3 + 10 · x4 + 15 · x6 = 5,

2 · x1 + 6 · x2 + 8 · x4 + 4 · x5 + 18 · x6 = 6.

Př́ıklad 4.21: Určete hodnoty parametr̊u a, b, c ∈ C tak, aby měl následuj́ıćı systém právě
jedno řešeńı:

a · x+ b · y = c,

c · x+ a · z = b,

c · y + b · z = a.

Př́ıklad 4.22: K matici:

A =

(
I −2
1 I

)
nalezněte matici inverzńı a ověřte, že A · A−1 = E, kde E je jednotková matice.

Řešeńı: Jednak můžeme využ́ıt pomocńıka pro hledáńı inverzńı matice, jednak můžeme
použ́ıt př́ıbuzný př́ıkaz k př́ıkazu GaussianElimination, a to ReducedRowEchelonForm

prováděj́ıćı Gaussovu-Jordanovu eliminaci, jelikož potřebujeme zadanou matici upravovat
až na jednotkovou. Postup výpočtu je uveden na obrázku 4.20.

Obrázek 4.20: Řešeńı př́ıkladu 4.22.

Př́ıklad 4.23: Pomoćı Gaussovy eliminace najděte inverzńı matice k následuj́ıćım matićım:

A =

(
8 5
11 7

)
, B =

(
1 3
1 4

)
, C =

1 2 3
0 1 2
0 0 1

 , F =

 1 −4 −3
0 −5 −3
−1 6 4

 .

U nalezených matic ověřte, že součinem matice a jej́ı inverze vznikne jednotková matice.
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Př́ıklad 4.24: Pomoćı Gaussovy eliminace najděte inverzńı matice k následuj́ıćım matićım:

A =

(
1 + I 1− I

2 I

)
, B =

(
2 I
1 0

)
, C =

 1 −I 1 + I
−I 1 0

1− I 0 I

 ,

F =

 2 + I 1 + I 1 + 2 · I
1− I 3− 2 · I 1− I

2− 3 · I 1 + I 1 + 2 · I

 .

U nalezených matic ověřte, že součinem matice a jej́ı inverze vznikne jednotková matice.

4.1.5 Determinant

Definice 4.10: Permutaćı množiny X nazveme bijektivńı zobrazeńı σ : X → X. Permutaci
σ(X) nazýváme transpozićı, jestliže existuj́ı r̊uzná x, y ∈ X tak, že σ(x) = y ∧ σ(y) = x,
a přitom ∀z ∈ X \ {x, y} : σ(z) = z. Dvojice prvk̊u a, b ∈ X = {1, 2, ..., n}, n ∈ N tvoř́ı
inverzi v permutaci σ, je-li a < b ∧ σ(a) > σ(b). Paritu permutace σ definujeme vztahem
(−1)počet inverźı a znač́ıme sgn(σ).

Definice 4.11: Necht’ A s prvky aij je čtvercová matice řádu n ∈ N. Determinant matice
A definujeme vztahem

|A| =
∑
σ∈Sn

sgn(σ) · a1σ(1) · a2σ(2) · . . . · anσ(n),

kde Sn je množina všech permutaćı na množině {1, 2, ..., n}.

Poznámka 4.10: Vyjádřeńım determinantu z předchoźı definice pro n = 3 źıskáme tzv.
Saarusovo pravidlo:

|A| =

∣∣∣∣∣∣
a11 a12 a13

a21 a22 a23

a31 a32 a33

∣∣∣∣∣∣ = +a11 · a22 · a33 + a21 · a32 · a13 + a31 · a12 · a23

−a31 · a22 · a13 − a21 · a12 · a33 − a11 · a32 · a23.

V systému Maple slouž́ı k výpočtu determinantu matice př́ıkaz Determinant z baĺıku
LinearAlgebra. Mı́sto něj je možné použ́ıt svislých závorek (jak jsme zvykĺı z psaného
textu), př́ıpadně i kontextového menu po kliknut́ı pravým tlač́ıtkem myši na matici. Obě
tyto možnosti nevyžaduj́ı načteńı zmı́něného baĺıku. Ukázku výpočtu poskytuje obrázek
4.21.

Př́ıklad 4.25: Uvažujme matice z př́ıklad̊u 4.23 a 4.24. Ověřte, že pro X ∈ {A,B,C, F}
plat́ı:

a) |X| = |XT |, b) |X−1| = 1
|X| .

Př́ıklad 4.26: Uvažujme matice z př́ıkladu 4.24. Ověřte, že plat́ı:

|A ·B| = |A| · |B|, |C · F | = |C| · |F |.
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Obrázek 4.21: Výpočet determinantu v Maple.

Laplace̊uv rozvoj determinantu

Poznámka 4.11: K výpočtu determinantu matic větš́ıch rozměr̊u než 3×3 (bez poč́ıtače)
se obvykle použ́ıvá Gaussova eliminačńı metoda a Laplace̊uv rozvoj determinantu. Laplace̊uv
rozvoj determinantu nám ř́ıká, že pro čtvercovou matici A řádu n s prvky aij a přirozená
č́ısla k, l taková, že 1 ≤ k, l ≤ n plat́ı:

|A| =
n∑
j=1

(−1)k+j · akj · |Akj| =
n∑
i=1

(−1)i+l · ail · |Ail|,

kde Akj je matice A bez svého k-tého řádku a j-tého sloupce, tzv. submatice matice A.
Systém Maple nenab́ıźı nástroj, který by uměl názorně provést Laplace̊uv rozvoj. Nic

nám však nebráńı v jeho vytvořeńı. Zavedeme proto př́ıkaz laplace jako proceduru se třemi
povinnými parametry – čtvercovou matićı, přirozeným č́ıslem od 1 do n udávaj́ıćı, podle
kolikátého řádku či sloupce má být rozvoj proveden, a ṕısmenem r nebo s v uvozovkách
znač́ıćım, jestli se rozvoj povede podle řádku či sloupce.

Smyslem textu neńı naučit programovat v Maple, a proto uved’me jen několik poznámek
ke zdrojovému kódu umı́stěném ńıže v rámečku. Procedura má tři parametry (čtvercovou
matici, přirozené č́ıslo a znak). Pokud neuvedeme parametry v tomto pořad́ı a zmı́něných
typ̊u, vyṕı̌se Maple chybovou zprávu Error, invalid input.

l a p l a c e := proc (A : : ( Matrix ( square ) ) , i : : pos int , c : : cha rac t e r )
l o c a l k , n ;
uses LinearAlgebra ;
n := RowDimension (A) ;
i f n < i then p r i n t f (”Druhy parametr musi byt c e l e c i s l o

od 1 do %d . ” , n ) ; r e turn ; end i f ;

i f c = ” r ” then
add ((−1)ˆ( i+k )∗A[ i , k ]∗ det ( DeleteRow ( DeleteColumn (A, k ) , i ) ) , k =1. . n )

e l i f c = ” s ” then
add ((−1)ˆ( i+k )∗A[ k , i ]∗ det ( DeleteRow ( DeleteColumn (A, i ) , k ) ) , k =1. . n )

else p r i n t f (” Tre t i parametr musi byt pismeno r nebo pismeno s . ” ) ; r e turn ;
end i f ;

end proc :

V proceduře je použito několik př́ıkaz̊u z baĺıku LinearAlgebra, který je na začátku

”
načten“ (pouze pro potřeby procedury!). Těmito př́ıkazy jsou RowDimension pro zjǐstěńı
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počtu řádk̊u (dimenze) zadané matice, DeleteRow a DeleteColumn pro odstraněńı řádku,
resp. sloupce, zadané matice. Daľśımi použitými př́ıkazy (tentokrát již z hlavńı knihovny Ma-
plu) jsou add pro součet prvk̊u (zejména numerické) posloupnosti a printf pro formátovaný
výpis.

Aby nedošlo k úplnému vyhodnoceńı a byl vidět Laplace̊uv rozvoj, je pro determinant
použit neexistuj́ıćı

”
př́ıkaz“ det. Vyhodnotit źıskaný výsledek a źıskat tak konečnou hodnotu

determinantu lze např. posloupnost́ı př́ıkaz̊u eval pro vyhodnoceńı a subs, j́ımž nahrad́ıme
řetězec det př́ıkazem pro výpočet determinantu, tj. např. použ́ıt:

eval(subs(det = LinearAlgebra[Determinant], %));

následně po źıskaném rozvoji determinantu. Název baĺıku LinearAlgebra je pochopitelně
možné vynechat, pokud jsme baĺık dř́ıve načetli (př́ıkazem with). Ukázku použit́ı př́ıkazu
laplace nab́ıźı obrázek 4.22.

Obrázek 4.22: Laplace̊uv rozvoj determinantu v Maple.

Poznámka 4.12: Při
”
ručńım“ výpočtu determinantu matice je třeba znát následuj́ıćı

pravidla:

• determinant trojúhelńıkové matice se rovná součinu jej́ıch diagonálńıch prvk̊u,

• výměnou pořad́ı dvou řádk̊u nebo sloupc̊u matice se změńı znaménko determinantu na
opačné,

• vynásobeńım nějakého řádku nebo sloupce matice nenulovým skalárem k ∈ C, se jej́ı
determinant změńı na k-násobek p̊uvodńı hodnoty,

• připočteńım skalárńıho násobku nějakého řádku matice k jej́ımu jinému řádku, resp.
násobku nějakého jej́ıho sloupce k jinému sloupci se hodnota jej́ıho determinantu
nezměńı.

Př́ıklad 4.27: Určete hodnotu determinantu matice A pomoćı Laplaceova rozvoje, kde

A =


7 2 3 2
6 6 6 7
8 10 9 10
5 7 3 3

 .

Řešeńı: Ukážeme dva r̊uzné postupy.
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Obrázek 4.23: Prvńı řešeńı př́ıkladu 4.27.

Obrázek 4.24: Druhé řešeńı př́ıkladu 4.27.

Prvńı postup, prezentovaný na obrázku 4.23, má za ćıl napodobit pr̊uběh
”
ručńıho“

výpočtu. Když se pozorně pod́ıváme na matici A, všimneme si, že ve třet́ım sloupci jsou
všechna č́ısla násobky tř́ı. Tj. vhodnými řádkovými úpravami doćıĺıme tř́ı nul v tomto sloupci,
aniž by se změnila hodnota determinantu matice (viz poznámka 4.12). Před úpravami si
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vytvoř́ıme kopii B matice A př́ıkazem copy, abychom nepřepisovali prvky p̊uvodńı matice.
Hledaný determinant označ́ıme ṕısmenem d. V Laplaceově rozvoji

”
z̊ustane“ determinant

jediné matice typu 3 × 3, již označ́ıme ṕısmenem C. Ačkoli determinant matice řádu 3 už
dokážeme spoč́ıtat př́ımo, je možné opakovat tentýž postup co pro p̊uvodńı matici A, źıskat
upravenou matici F a jej́ım Laplaceovým rozvojem dospět k determinantu jediné matice
řádu 2. Při řešeńı často využ́ıváme př́ıkazu op, abychom źıskali žádané operandy předchoźıch
výraz̊u automaticky a nemuseli je ručně koṕırovat.

V druhém př́ıpadě – obrázek 4.24 – využijeme toho, že systému Maple neńı nutné př́ıklad
zjednodušovat

”
vytvářeńım nul“ v matici a necháme vše na něm.

Př́ıklad 4.28: Určete hodnotu determinantu zadaných matic pomoćı Laplaceova rozvoje:

A =


1 0 1 −1
2 0 1 −2
3 3 −1 1
0 1 1 1

 , B =


1 2 −1 0
2 2 1 1
−1 1 2 3
2 1 1 −1

 , C =


2 1 −2 −1
1 −1 −1 1
4 2 2 1
8 1 1 2

 .

Konjugovaná matice

Definice 4.12: Matici A nazveme konjugovanou matićı (resp. komplexně sdruženou ma-
tićı) k matici A s prvky aij, jestliže matice A obsahuje prvky aij pro všechna i, j, tj. jej́ıž
prvky jsou komplexně sdružené k prvk̊um matice A.

Systém Maple nemá př́ımo př́ıkaz pro výpočet konjugované matice, lze však využ́ıt př́ıkaz̊u
conjugate pro zisk komplexně sdruženého komplexńıho č́ısla a map, j́ımž aplikujeme př́ıkaz
conjugate na každý prvek matice. Zmı́něné lze provést též pomoćı kontextové nab́ıdky, která
se objev́ı po kliknut́ı prvým tlač́ıtkem myši na matici – obrázek 4.25.

Obrázek 4.25: Výpočet konjugované matice v Maple.

Pro komplexńı matici dále zavád́ıme tzv. hermitovskou transpozici. Hermitovsky trans-
ponovaná matice je transponovaná konjugovaná matice. Pro tuto operaci poskytuje Maple
př́ıkaz HermitianTranspose z baĺıku LinearAlgebra. Operaci je však možné provést též
pomoćı kontextové nab́ıdky po kliknut́ı pravým tlač́ıtkem myši na matici, př́ıpadně zápisem
A%H , kde A je daná matice. Ukázku použit́ı a rozd́ılu mezi obyčejnou a hermitovskou trans-
pozićı poskytuje obrázek 4.26. Jelikož (AT )T = A pro matici A, lze využ́ıt také hermitovské
transpozice pro zisk konjugované matice.
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Obrázek 4.26: Hermitovská transpozice matice v Maple.

Př́ıklad 4.29: Uvažujme matice z př́ıklad̊u 4.23 a 4.24. Ověřte, že plat́ı proX ∈ {A,B,C, F}:∣∣X∣∣ = |X|.

4.2 Lineárńı zobrazeńı

4.3 Afinńı geometrie
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5 Chyby

V této kapitole si ukážeme nejčastěǰśı chyby při práci se systémem Maple.

5.1 Chybové zprávy (Error Messages)

5.1.1 Math mode / Text mode

Jednou z prvńıch chyb, kterých se uživatelé často dopouštěj́ı, je nevěnováńı dostatečné po-
zornosti př́ıkazovému (matematickému) a textovému režimu. Př́ıkazový (matematický) režim
(Math mode) slouž́ı k zápisu př́ıkaz̊u. Po kliknut́ı na klávesu Enter dojde k jeho vyhodnoceńı.
Textový režim slouž́ı k zápisu obyčejného textu. Po kliknut́ı na klávesu Enter se

”
pouze“

přesuneme na nový řádek. Častá a někdy těžko odhalitelná chyba je
”
smı́cháńı“ těchto dvou

režimů při zápisu př́ıkazu, kdy zpravidla źıskáváme chybné výsledky. To, jestli je celý př́ıkaz
zapsaný v př́ıkazovém (matematickém) režimu, můžeme poznat z fontu ṕısma (ale nemuśı
tomu tak nutně být). Nejjistěji to poznáme umı́stěńım kurzoru na př́ıkaz, kdy se objev́ı
(naneštěšt́ı slabě viditelný) šedý obdélńık tvořený přerušovanou čárou vymezuj́ıćı znaky za-
psané v př́ıkazovém (matematickém) režimu – viz obrázek 5.1. U př́ıkaz̊u na druhém řádku
je vždy umı́stěn kurzor před č́ıslićı 2. Můžeme si tedy všimnout zmı́něného přerušovaného
obdélńıku, který v prvńım př́ıpadě (vlevo) zahrnuje pouze č́ıslici 2. Př́ıkazy na prvńım řádku
byly vytvořeny obdobně.

Obrázek 5.1: Chyby v použit́ı matematického a textového režimu.

5.1.2 Chybné argumenty př́ıkaz̊u

Daľśı velmi častou chybou (ne-li nejčastěǰśı) je špatné zadáńı argument̊u př́ıkaz̊u. Každý
př́ıkaz má definované použit́ı. Vždy mu muśıme nastavit povinné argumenty, můžeme přidat
volitelné (charakterizované slov́ıčkem optional). Argumenty muśı být zadány vždy v ta-
kovém tvaru, jaký je předepsaný. Informace o tom, jak daný př́ıkaz použ́ıt, jak specifikovat
argumenty př́ıkazu, které argumenty jsou povinné a které volitelné, nalezneme v nápovědě
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systému Maple k př́ıslušnému př́ıkazu. Následuje přehled chybových zpráv, které Maple při
špatném zadáńı argument̊u vypisuje.

Obrázek 5.2: Ve všech př́ıpadech si Maple stěžuje na špatný vstup. Nejprve je př́ıkazu sin zadán
seznam, kdežto Maple očekává algebraickou hodnotu. Argumentem př́ıkazu Eigenvalues má být
čtvercová matice (nikoli reálné č́ıslo). Př́ıkazu solve jsou v chybné variantě zadány dvě rovnice
jako dva parametry, př́ıkaz však očekává, že v př́ıpadě v́ıce rovnic budou tyto zadány v jediném
parametru jako seznam (resp. množina). Nakonec př́ıkaz simplify neakceptuje nerovnosti jako
dodatečná omezeńı.

Obrázek 5.3: Př́ıkaz roots očekává jako argument polynom nad č́ıselným tělesem, což sin(x)
neńı. Př́ıkaz convert vyžaduje uvedeńı jména proměnné, pokud upravovaný výraz obsahuje v́ıce
neznámých.
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Obrázek 5.4: Chybné zápisy omezuj́ıćıch podmı́nek pro př́ıkaz simplify spolu s jejich správnými
variantami.

5.1.3 Nesprávné použit́ı závorek

V systému Maple můžeme použ́ıvat všechny typy závorek, každý typ má však jiný význam
a tedy jiné použit́ı. Nav́ıc je třeba dávat pozor na počet levých (otev́ıraj́ıćıch) a počet pravých
(uzav́ıraj́ıćıch) závorek. Vždy, když se tyto počty nerovnaj́ı, systém vyṕı̌se chybovou zprávu
Error, unable to match delimiters (obrázek 5.5).

Obrázek 5.5: Chyby v použ́ıváńı závorek.

5.1.4 Nesprávné přǐrazeńı

Systém Maple disponuje tzv. systémovými proměnnými a př́ıkazy. Jejich názvy jsou chráněné,
tj. do chráněných proměnných neńı možné přǐrazovat jiný typ hodnot, než pro který jsou
určeny, a názvy př́ıkaz̊u neńı možné použ́ıvat jinak než jako př́ıkazy s definovaným použit́ım
(tj. neńı možné si např. vytvořit proměnnou se stejným názvem jako některý z př́ıkaz̊u).
To, jestli je nějaký název chráněný či nikoliv, je možné zjistit př́ıkazem type maj́ıćım dva
argumenty: název (jméno), u nějž chceme zjistit, zda je chráněný, a argument protected

(který už se nenastavuje na žádnou hodnotu) – viz obrázek 5.6.
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Obrázek 5.6: Chyby v přǐrazováńı hodnot do proměnných.

5.1.5 Děleńı nulou

Když se při úpravě zadaného výrazu (př́ıkazu) dostane Maple do situace, kdy má dělit nulou,
vyṕı̌se zprávu Error, numeric exception: division by zero. Tato situace se může přihodit
i u výraz̊u (př́ıkaz̊u), u nichž to neočekáváme (např. u funkce ln) – obrázek 5.7.

Obrázek 5.7: Vyhodnoceńı výrazu, v němž se děĺı nulou.

5.1.6 Nesprávný zápis mocnin

Některé chybové zprávy při práci s mocninami nab́ıźı obrázek 5.8.

5.1.7 Nesprávné použit́ı objekt̊u

V systému Maple můžeme narazit také na chybovou zprávu Error, illegal use of an object
as a name. Ta se objev́ı vždy, když použijeme nějaký objekt, který neńı jménem, na mı́stě,
kde systém jméno očekává. Význam chyby bude nejlépe patrný z obrázku 5.9.

5.1.8 Nesprávné definice a použit́ı funkćı

Různých chyb se můžeme dopustit i při definici a použit́ı funkce (obrázek 5.10).
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Obrázek 5.8: Nesprávný zápis mocnin.

Obrázek 5.9: Nesprávné použit́ı objekt̊u.

Obrázek 5.10: Nesprávné definice a použit́ı funkćı.
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5.1.9 Chyby při vykreslováńı

Následuj́ı chyby vyskytuj́ıćı se při vykreslováńı. Jako u každého př́ıkazu muśıme dbát na
správně uvedené argumenty i u př́ıkaz̊u pro vykreslováńı funkćı a výraz̊u. Chyby uvedené na
obrázku 5.11 jsou zp̊usobeny předevš́ım nesprávně uvedeným rozsahem proměnné x.

Obrázek 5.11: Chyby při vykreslováńı.

5.1.10 Daľśı chybové zprávy

Závěrem chybových zpráv ukažme ještě tři časté chybové zprávy, obrázek 5.12.

179



Obrázek 5.12: Daľśı chybové zprávy.

5.2 Varováńı (Warnings)

Kromě chybových zpráv vypisuje systém ještě tzv. varováńı. Varováńı může signalizovat naši
chybu (v zápisu př́ıkazu), ale zpravidla informuje o d̊uvodech, proč nemůže systém zadaný
př́ıkaz vyhodnotit (někdy jej přesto vyhodnot́ı). Při výpisu varováńı s textem Warning,
solutions may have been lost je nutné přeformulovat problém (zapsat př́ıkaz jinak, nebot’

jej Maple nedokáže vyhodnotit). Ne vždy je toto možné. Zpravidla můžeme jinou formulaćı
problému dosáhnout alespoň

”
nějakých zlepšeńı“.

Obrázek 5.13: Varováńı.
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Obrázek 5.14: Varováńı po spuštěńı př́ıkazu plot.

5.3 Ostatńı chyby

Podkapitola ukazuje několik častých chyb, které však nevyvolávaj́ı chybové zprávy ani va-
rováńı.

5.3.1 Nenačteńı baĺıku (knihovny)

Obrázek 5.15: Při nenačteńı potřebného baĺıku (knihovny) se př́ıkaz pouze
”
přeṕı̌se“ na následuj́ıćı

řádek.

5.3.2 Nesprávné použ́ıváńı některých symbol̊u

Maple je tzv. case sensitive, tj. zálež́ı na velikosti ṕısmen. Nav́ıc např. pro Eulerovo č́ıslo je
vyhrazen speciálńı symbol r̊uzný od ṕısmene e psaného na klávesnici poč́ıtače.
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Obrázek 5.16: Nesprávné použ́ıváńı některých symbol̊u.
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6 Návody k řešeńı př́ıklad̊u

6.1 Úvod do systému Maple

Př́ıklad 1.2: Pro vložeńı zadaného výrazu potřebujeme: sumačńı symbol a symbol nekonečna.
Sumačńı symbol nalezneme v paletě Expression, symbol nekonečna v paletě Common
Symbols. Zlomek můžeme bud’ vźıt také z palety Expression, nebo jej zaṕı̌seme ručně
pomoćı lomı́tka.

Př́ıklad 1.3: Potřebujeme vložit zlomek a mocninu (resp. exponent). Oboj́ı najdeme v paletě
Expression. Můžeme také použ́ıt lomı́tko a

”
stř́ı̌sku“.

Př́ıklad 1.4: Opět využijeme již dř́ıve zmı́něných palet. Pozor však na vkládáńı Eulerova
č́ısla. To je nutné vźıt z palety (resp. použ́ıt př́ıkaz exp). Zapsané ṕısmeno e z klávesnice
Maple bere jako

”
obyčejné“ ṕısmeno (proměnnou) e.

Př́ıklad 1.6: K zadáńı výrazu potřebujeme př́ıkaz sqrt pro vložeńı odmocniny a př́ıkaz exp

pro vložeńı Eulerova č́ısla. Př́ıkaz má jeden parametr, kterým je exponent Eulerova č́ısla (tj.
pro Eulerovo č́ıslo samotné zadáváme exp(1)). Vložit Eulerovo č́ıslo je možné též zapsáńım
ṕısmene e, vyvoláńım funkce automatického dokončováńı a zvoleńım položky Exponential
’e’.

Př́ıklad 1.7: Nejrychleǰśı zp̊usob je zadat do dokumentu ?sum, př́ıpadně zadat sum, umı́stit
kurzor na př́ıkaz a stisknout klávesu F2.

Př́ıklad 1.8: Je několik zp̊usob̊u, jak to zjistit. Zřejmě nejrychleǰśı je vyhledávat v nápovědě
kĺıčová slova matrix a vector, př́ıpadně Linear Algebra.

Př́ıklad 1.10: Pozor na rozd́ıl mezi počtem platných cifer a počtem desetinných mı́st.

Př́ıklad 1.11: Když zaṕı̌śıme nějaké č́ıslo s desetinnou tečkou, Maple jej automaticky bude
brát jako č́ıslo v pohyblivé řádové čárce a výpočty s ńım bude zaokrouhlovat na počet
platných mı́st specifikovaný proměnnou Digits.

Př́ıklad 1.13: Použijeme př́ıkaz isolve.

Př́ıklad 1.14: Použijeme př́ıkaz isolve. Systém Maple vyṕı̌se řešeńı s použit́ım konstant,
které jsou přirozenými č́ısly (bez nuly). Správně však maj́ı být použity nezáporné celoč́ıselné
konstanty.

Př́ıklad 1.16: Řeš́ıme jako soustavu nerovnic př́ıkazem solve.
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Př́ıklad 1.17: Použijeme př́ıkaz solve. Pro a = 0 bychom dostali lineárńı polynom.

Př́ıklad 1.18: Řeš́ıme opět př́ıkazem solve. Pozor, daná rovnice má nekonečně mnoho řešeńı.

Př́ıklad 1.19: Řeš́ıme jako soustavu rovnic př́ıkazem solve.

6.2 Matematická analýza s Maple v R
Př́ıklad 2.3: Použijeme zavedeńı předpokladu: assuming.

Př́ıklad 2.4: Použijeme př́ıkaz simplify.

Př́ıklad 2.5: Použijeme př́ıkaz simplify.

Př́ıklad 2.6: Použijeme př́ıkaz factor.

Př́ıklad 2.7: Použijeme př́ıkaz simplify.

Př́ıklad 2.8: Využijeme př́ıkaz̊u simplify, factor a convert.

Př́ıklad 2.12: Pro všechna x ∈ R plat́ı: sin(x) ∈ [−1, 1].

Př́ıklad 2.13: Plat́ı: f(x) = 1
x2−5·x+6

a f(−x) = 1
x2+5·x+6

. Z toho máme: f(x) 6= f(−x),
f(x) 6= −f(−x) a tedy funkce neńı sudá, ani lichá. D(f) = R \ {2, 3}, H(f) = R \ (−4, 0].
Obor hodnot urč́ıme z toho, že polynom x2 − 5 · x + 6 nabývá všech kladných hodnot (a
proto muśı i funkce f(x)). Zmı́něný polynom nabývá též záporných hodnot, a to na intervalu
(2, 3), přičemž tu nejmenš́ı přesně uprostřed intervalu, tj. v bodě x = 5

2
. Funkce f(x) v tomto

bodě naopak nabývá své nejvyšš́ı hodnoty na intervalu (2, 3), a to hodnoty −4.
Z předešlého plyne, že funkce neńı ohraničená.

Př́ıklad 2.14:

(a) f(x) = 9− x2, f(−x) = 9− x2 = f(x)⇒ sudá funkce,

(b) f(x) =
√
x, f(−x) =

√
−x⇒ ani sudá, ani lichá,

(c) f(x) = 1
x
, f(−x) = −1

x
= −f(x)⇒ lichá funkce.

Př́ıklad 2.15:

(a) f(x) = 2 · x, kde x ∈ (0, 1),

(b) f(x) = 1
x−1

,

(c) f(x) = 1
x

+ 1,

(d) f(x) = ex,

(e) f(x) =

{
x+ 2 ... x ≤ −2

x− 2 ... x ≥ 2
,

(f) f(x) =


x− 2 ... x ≤ 0

2 ... 0 < x ≤ 1

x+ 1 ... x ≥ 1

,

(g) f(x) = arctan(x),

(h) f(x) =

{
ln(−x) ... x < 0

ln(x) ... x > 0
.

184



Př́ıklad 2.16: f(x) = x3 − k · x2 + 2 · x, f(−x) = −(x3 + k · x2 + 2 · x). Z toho dostáváme:
k = −k = 0.
Př́ıklad 2.17:

(a) Pro a 6= 0 se jedná o bijekci.

(b) Ano, je to bijekce.

(c) Nejedná se o bijekci, funkce neńı prostá.

(d) Ano, je to bijekce.

(e) Ano, je to bijekce.

Př́ıklad 2.19:

(a) f−1(x) = 1
2
· (x− 1),

(b) f−1(x) = 3
√
x,

(c) f−1(x) = x−1
x+1

,

(d) f−1(x) = (1− x)2 ... x ≥ 0,

(e) f−1(x) = 1
x
,

(f) zadaná funkce neńı prostá (a nemá tak inverzi).

Př́ıklad 2.20: Každá funkce osově symetrická vzhledem k př́ımce y = x je sama sobě inverźı.
To znamená, že jich je dokonce nekonečně mnoho.

Př́ıklad 2.22: g−1(x) = 1
2
· ln(x). Legendu můžeme do grafu přidat nastaveńım parametru

legend př́ıkazu plot nebo kliknut́ım na graf a výběrem z kontextové nab́ıdky.

Př́ıklad 2.23: Použijeme př́ıkaz animate. Funkce h(x) je klesaj́ıćı pro a < 0, rostoućı pro
a > 0 a konstantńı pro a = 0.

Př́ıklad 2.25: Vycháźıme z definice 2.8, pouze se nyńı přibližujeme k bodu x0 zprava, tj.
uvažujeme interval (x0, x0 + δ).

Př́ıklad 2.26: Vyjdeme z definic 2.9 a 2.10. Uvažujeme bod ∞ (resp. −∞) a chceme popsat
stav, kdy pro libovolně

”
vysokou“ (resp.

”
ńızkou“) hodnotu M existuje hranice, nad ńıž

(resp. pod ńıž) pro všechna x plat́ı, že funkčńı hodnota f(x) je větš́ı (resp. menš́ı) než ona
p̊uvodně (libovolně) zvolená hodnota M .

Př́ıklad 2.27: Maple zvládne určit všechny limity. Postupujeme tedy klasicky využit́ım sym-
bolu pro poč́ıtáńı limit z palety, kontextové nab́ıdky nebo př́ıkazu limit.

Př́ıklad 2.28:

(a) Zavedeme substituci y = x3.
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(b) Využijeme vzorce cos(x) = cos(x
2
)2 − sin(x

2
)2.

(c) Rozš́ı̌ŕıme výrazem
√
x2 + 5 + 3.

(d) Rozš́ı̌ŕıme výrazem 1
x

a uvědomı́me si, že pro x→ −∞ je x = −
√
x2.

(e) Zadaný zlomek rozlož́ıme na součet dvou zlomk̊u a zavedeme substituci u = −x.
Daľśımi drobnými úpravami umı́me rozhodnout, kam se který výraz (zlomek) limitně
bĺıž́ı pro u→∞.

(f) Využijeme vzorce sin(2 · t) = 2 · sin(t) · cos(t) a platnosti lim
x→0

sin(x)
x

= 1.

Př́ıklad 2.29:

(a) Stač́ı dát př́ıklad takřka jakékoli
”
rozumné“ funkce definované na nějakém neprázdném

intervalu – viz definice 2.7.

(b) Vycháźıme z 2.10. Je třeba dát př́ıklad funkce f(x), jej́ıž hodnoty se bĺıž́ı nějakému
konečnému č́ıslu pro x→∞ (resp. x→ −∞). Mohla by něco takového splňovat nějaká
polynomiálńı, mocninná, exponenciálńı, či goniometrická funkce?

(c) Takřka
”
opačný“ př́ıpad k předešlému. Hledáme funkci f(x), která pro nějaké konečně

velké x
”
roste nade všechny meze“ (resp.

”
klesá pod všechny meze“). Mohla by něco

takového splňovat nějaká polynomiálńı, mocninná, exponenciálńı, či goniometrická
funkce?

(d) Nyńı chceme naj́ıt funkci f(x), jej́ıž hodnoty se bĺıž́ı ∞ (resp. −∞) pro x→∞ (resp.
x→ −∞). Opět je na mı́stě stejná otázka: splňuje toto nějaká polynomiálńı, mocninná,
exponenciálńı, či goniometrická funkce?

(e) Muśıme spojit všechny předešlé body. Na bod (a) můžeme zapomenout. Pokud splńıme
všechny ostatńı, bude splněna i tato podmı́nka. Jedno možné řešeńı je naj́ıt funkci
splňuj́ıćı (b) a (d) – takovou funkci jste již možná dokonce našli – a zkombinovat ji (tj.
např. vynásobit) s funkćı splňuj́ıćı bod (c).

Př́ıklad 2.31:

(a) Muśıme se obej́ıt bez systému Maple, jelikož př́ıkaz discont neumı́ hledat nespojitosti
u funkćı definovaných po částech. Podezřelé body z nepojitosti jsou body 1 a 2. Muśıme
ověřit, zda v nich existuje limita a zda je rovna př́ıslušné funkčńı hodnotě.

(b) V tomto př́ıpadě př́ıkaz discont pracuje bezchybně.

(c) Opět se muśıme obej́ıt bez systému Maple. Postupujeme analogicky k řešeńı př́ıkladu
2.30.

Př́ıklad 2.32: Postupujeme analogicky k řešeńı př́ıkladu 2.30. Hledáńı č́ısel c a d vede na
soustavu dvou rovnic.

Př́ıklad 2.33: Jsou dvě hlavńı možnosti, jak postupovat. Bud’ vźıt známou funkci, která neńı
spojitá, ale v́ıme, že má limitu v každém bodě (na daném intervalu), nebo vźıt funkci spojitou
(ta má limitu v každém bodě) a nespojitost

”
vytvořit“, aniž bychom porušili existenci limity.
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Př́ıklad 2.34: Systém Maple zvládne určit všechny derivace. Ke správné odpovědi je nutné
porozumět výpisu systému v př́ıpadě (b). Symbol D tu znač́ı diferenciálńı operátor.

Př́ıklad 2.35: Je třeba naj́ıt spojitou funkci f(x), pro niž by v nějakém bodě x0 neexistovala

limita z definice 2.14: lim
x→x0

f(x)−f(x0)
x−x0 . K tomu, aby tato limita neexistovala, stač́ı, aby se

nerovnaly limity zleva a zprava, tedy aby platilo: lim
x→x0−

f(x)−f(x0)
x−x0 6= lim

x→x0+
f(x)−f(x0)

x−x0 . Jak

muśı vypadat funkce splňuj́ıćı předchoźı nerovnost?
Když najdeme právě popsanou funkci, je již jednoduché např. definováńım po částech

vytvořit funkci, která bude mı́t na daném intervalu libovolný počet (a tedy i např. rovný
dvěma) bod̊u, v nichž bude funkce spojitá, ale nebude v nich mı́t derivaci.

Př́ıklad 2.36: Z poznámky 2.4 v́ıme, že směrnice tečny je rovna derivaci funkce v př́ıslušném
bodě. V rovnici tečny tak zbývá určit pouze konstantńı člen, jehož hodnotu zjist́ıme z toho,
že tečna má s funkćı jeden společný bod.

Př́ıklad 2.37: Jelikož má být tečna rovnoběžná s nějakou př́ımkou, muśı mı́t stejnou směrnici.
Tedy pokud y = k ·x+q je rovnićı tečny k funkci f(x) v bodě x0, pak muśı platit k = f ′(x0) =
12 (nebot’ 12 je směrnice rovnoběžné př́ımky). Jelikož f ′(x0) = 3 · x0

2, dostáváme dva r̊uzné
body x0 a tedy dvě tečny.

Př́ıklad 2.38: Řeš́ıme obdobně jako předchoźı př́ıklad. Směrnice zadané př́ımky je rovna −1
3
.

My potřebujeme nyńı směrnici kolmice. K tomu využijeme lineárńı algebry, odkud v́ıme, že
dva vektory jsou na sebe kolmé, jestliže je jejich skalárńı součin roven 0. Máme-li př́ımky
y = k · x a y = l · x, pak tyto jsou na sebe kolmé, jestliže 1 + k · l = 0. Z toho dostáváme, že
směrnice hledané kolmice je rovna 3, což je tedy směrnice tečny. Tedy pokud y = k · x+ q je
rovnićı tečny k funkci f(x) v bodě x0, pak muśı platit k = f ′(x0) = 3. Jelikož f ′(x0) = 3 ·x0

2,
dostáváme opět dva r̊uzné body x0 a tedy dvě tečny.

Př́ıklad 2.40: f(x) =
√
x, x0 = 49, h = 2.

Př́ıklad 2.41: f(x) = 3
√
x, x0 = 125, h = −2.

Př́ıklad 2.42: f(x) = x4, x0 = 3, h = −0.05.

Př́ıklad 2.43: Použijeme př́ıkaz taylor pro bod x = 0 a źıskaný výsledek převedeme na
polynom př́ıkazem convert.

Př́ıklad 2.44: Použijeme př́ıkaz taylor pro bod x = 1. Proměnnou Order nastav́ıme na
hodnotu 5 a źıskaný výsledek převedeme na polynom př́ıkazem convert.

Př́ıklad 2.45: Použijeme př́ıkaz taylor pro bod x = 2.

Př́ıklad 2.47: Postupujeme analogicky k př́ıkladu 2.46.

(a) Uvažujeme funkci ex, kterou rozvineme do Taylorova polynomu v bodě x0 = 0, a hledáme
aproximaci v bodě x = −1. Stejným postupem jako v př́ıkladu 2.46 dospějeme k tomu,
že je pro požadovanou přesnost potřeba nastavit proměnnou Order na hodnotu 7.
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(b) Uvažujeme funkci 5
√
x, kterou rozvineme do Taylorova polynomu v bodě x0 = 243,

a hledáme aproximaci v bodě x = 250. Nyńı muśıme k odhadu velikosti Taylorova
zbytku použ́ıt poznámku 2.7, nebot’ x0 6= 0. Tvar zbytku je pak nejjednodušš́ı vyhod-
nocovat postupně pro n = 1, 2, ..., nebot’ Maple neumı́ vyřešit př́ıslušnou nerovnici.
Dostatečné n v tomto př́ıpadě: n = 2.

Př́ıklad 2.50:

(a) Funkce f má tři stacionárńı body, z nichž jediný je lokálńı extrém, daľśı dva jsou body
inflexńı. Funkce nemá žádnou asymptotu.

(b) Funkce f má dva stacionárńı body, oba jsou lokálńımi extrémy. Funkce má dále tři
inflexńı body. Funkce neńı definována ve dvou bodech, v nichž má asymptoty bez
směrnice. Asymptoty se směrnićı neexistuj́ı. Aby Maple tento př́ıklad správně vyřešil,
je potřeba nač́ıst baĺık RealDomain.

(c) Funkce má dva stacionárńı body, z nichž jeden je lokálńı extrém, druhý je inflexńım
bodem. Funkce neńı definována v jediném bodě, v němž má asymptotu bez směrnice.
Funkce má také asymptotu se směrnićı.

(d) Funkce má nekonečně mnoho stacionárńıch bod̊u (na zjǐstěńı tohoto v Maple je třeba
použ́ıt atribut allsolutions), všechny jsou však inflexńımi body. Funkce má i daľśı
inflexńı body (vždy uprostřed intervalu tvořeného stacionárńımi body). Funkce nemá
asymptotu bez směrnice ani asymptotu se směrnićı. Opět pozor na výpočet systému
Maple – při poč́ıtáńı limit v některých př́ıpadech vypisuje interval jako hodnotu limity
(limita však neexistuje).

(e) Zásadńı otázka v tomto př́ıkladu je, zda je funkce f(x) spojitá v bodě 0. Funkce má tři
stacionárńı body a všechny jsou jej́ımi lokálńımi extrémy. Funkce má dále dva inflexńı
body a žádnou asymptotu (bez směrnice či se směrnićı).

Př́ıklad 2.54:

(a) Stač́ı rozložit na dva zlomky a určit př́ımo ze znalosti
”
tabulkových“ integrál̊u.

(b) Výraz pod odmocninou je možné upravit tak, aby se dala odmocnina odstranit (apli-
kovat). Poté už se výsledek urč́ı podobně jako v předchoźım př́ıpadě.

(c) Po roznásobeńı je možné integrovat každý člen zvlášt’.

(d) Rozklad na parciálńı zlomky.

(e) Opět rozklad na parciálńı zlomky. V tomto př́ıpadě je však výrazně pracněǰśı než
předchoźı, nebot’ jeden ze źıskaných parciálńıch zlomk̊u je třeba dále upravit (rozložit),
abychom integraćı źıskali přirozený logaritmus. T́ım se nám však objev́ı daľśı zlomek,
u nějž je třeba rozpoznat, že připomı́ná derivaci funkce arkus tangens (arctan), jen je
potřeba zlomek opět upravit do vhodného tvaru.

(f) Zavedeme substituci t = 5 · x+ 6.

(g) Zavedeme substituci t = ln(x).

(h) Zavedeme substituci t = x2 + 1.
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(i) Řeš́ıme metodou per partes, přičemž funkce, kterou budeme cht́ıt derivovat, bude
funkce x. Maple při použit́ı př́ıkazu Parts využije znalosti

∫
cos2(x) dx = 1

2
· cos(x) ·

sin(x) + 1
2
· x, k čemuž dospějeme užit́ım vztahu cos2(x) = 1+cos(2·x)

2
. Integrál źıskaný

metodou per partes je třeba rozložit a na jeden z nich použ́ıt substitučńı metodu.

(j) Řeš́ıme metodou per partes. Funkćı, kterou budeme derivovat, je funkce ln(x).

(k) Řeš́ıme opět metodou per partes. Funkci arctan(x) si zaṕı̌seme jako arctan(x)·1 a právě
samotná funkce arctan(x) bude ta, kterou budeme derivovat.

(l) Řeš́ıme nejprve substitučńı metodou položeńım t = x2. Následně použijeme metodu
per partes, přičemž funkce, kterou budeme derivovat, bude funkce x.

Př́ıklad 2.55: Ve všech př́ıpadech využ́ıváme Newton-Leibnizovy formule.

(a) Řeš́ıme metodou per partes.

(b) Zavedeme substituci x = t2.

(c) Zavedeme substituci cos(x) = t.

(d) Zavedeme substituci ex = t.

(e) Řeš́ıme metodou per partes.

(f) Zavedeme nejprve substituci t = ex a následně u2 = t− 1.

Př́ıklad 2.58:

(a) Řeš́ıme naprosto analogicky s př́ıkladem 2.56. Výsledek je: S = 16·
√

2
3

.

Obrázek 6.1: Zobrazeńı plochy z př́ıkladu 2.58.(a) vlevo, zobrazeńı plochy z př́ıkladu 2.58.(b) vpravo.
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(b) Obsah zadané plochy je třeba poč́ıtat
”
na dvakrát“. Nejprve se spoč́ıtá obsah plochy

mezi křivkami y = −x a y = 1 na intervalu [−1, 0], následně obsah plochy mezi
křivkami y = x3 a y = 1 na intervalu [−1, 0]. Výsledek je: S = 5

4
.

(c) Stač́ı si uvědomit, mezi kterými částmi křivek lež́ı zadaná plocha. Výsledek je: S = 1
3
.

Obrázek 6.2: Zobrazeńı plochy z př́ıkladu 2.58.(c) vlevo, zobrazeńı plochy z př́ıkladu 2.58.(d) vpravo.

Obrázek 6.3: Zobrazeńı plochy z př́ıkladu 2.58.(e).

(d) Řeš́ıme rovnou podle poznamky 2.23. Výsledek je: S = ln(2)
2

.
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(e) Řeš́ıme opět rozděleńım na dva určité integrály. Výsledek je: S = 4 · ln(2)− 2.

Př́ıklad 2.59:

(a) Pomoćı derivace muśıme určit rovnici tečny. Dále už řeš́ıme analogicky k předchoźım
př́ıklad̊um. Výsledek je: S = 23

8
.

Obrázek 6.4: Zobrazeńı plochy z př́ıkladu 2.59.(a) vlevo, zobrazeńı plochy z př́ıkladu 2.59.(b) vpravo.

(b) Opět muśıme určit rovnici tečny a také jej́ı pr̊useč́ık s funkćı y = x3. Výsledek je:
S = 27

4
.

(c) Nyńı je třeba určit rovnice dvou tečen a jejich pr̊useč́ık. Výsledek je: S = 9
4
.

Př́ıklad 2.60: Ve všech př́ıpadech využijeme poznámky 2.24:

(a) Výsledek je: S = 72·
√

3
5

.

(b) Výsledek je: S = 12 · π.

(c) Výsledek je: S = 27·π
16

.

Př́ıklad 2.61: Je třeba odvodit rovnici kružnice. Máme dvě možnosti – bud’ popsat
”
horńı“ po-

lovinu kružnice vztahem y =
√
r2 − x2 a

”
spodńı“ polovinu kružnice vztahem y = −

√
r2 − x2,

nebo kružnici popsat parametricky předpisem x = r·sin(t), y = r·cos(t), t ∈ [0, 2·π]. Následně
využijeme odpov́ıdaj́ıćıho určitého integrálu. Při použit́ı prvńıho postupu je v Maple nutné
přidat při výpočtu integrálu předpoklad, že r je nezáporné (reálné) č́ıslo, abychom dospěli
k požadovanému výsledku.
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Obrázek 6.5: Zobrazeńı plochy z př́ıkladu 2.59.(c).

Obrázek 6.6: Zobrazeńı plochy z př́ıkladu 2.60.(a) vlevo, zobrazeńı plochy z př́ıkladu 2.60.(b) vpravo.
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Obrázek 6.7: Zobrazeńı plochy z př́ıkladu 2.60.(c).

Př́ıklad 2.64: Ve všech př́ıpadech využijeme poznámky 2.25.

(a) l = 26·
√

13
27
− 16

27

(b) l =
e−1·
√

2·e2+e4+1·(e2−1)
e2+1

.
= 2.35

(c) Systém Maple vyjádř́ı řešeńı za pomoci eliptického integrálu. Informace k tomuto
výsledku můžeme nalézt v nápovědě. Př́ıkazem evalf źıskáme přibližné numerické
řešeńı.

l = 2 ·
√

2 · EllipticE(
√

2
2

) = 2 ·
√

2 ·
1∫
0

√
1−x2

2√
1−x2 dx

.
= 3.82

(d) l = 2 ·
√

2 · EllipticE(
√

2
2

) = 2 ·
√

2 ·
1∫
0

√
1−x2

2√
1−x2 dx

.
= 3.82

Př́ıklad 2.65: Ve všech př́ıpadech využijeme poznámky 2.26.

(a) l = 2 ·
√

3

(b) l = 2 · π2

(c) l = 2 · π ·
√

1 + 16 · π2 − 1
2
· ln
(
−4 · π +

√
1 + 16 · π2

)
Př́ıklad 2.66: Řeš́ıme analogicky jako v př́ıkladu 2.61, jen mı́sto obsahu kruhu poč́ıtáme
obvod kružnice.

Př́ıklad 2.69: Ve všech př́ıpadech využijeme poznámky 2.27:

(a) Výsledek: V = 3·π
10

.

(b) Výsledek: V = π2

2
.

(c) Výsledek: V = 8·π
3

.

(d) Výsledek: V = 8·π
3

.
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Obrázek 6.8: Zobrazeńı zadané plochy a źıskaného rotačńıho tělesa z př́ıkladu 2.69.(a).

Obrázek 6.9: Zobrazeńı zadané plochy a źıskaného rotačńıho tělesa z př́ıkladu 2.69.(b).
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Obrázek 6.10: Zobrazeńı zadané plochy a źıskaného rotačńıho tělesa z př́ıkladu 2.69.(c).

Obrázek 6.11: Zobrazeńı zadané plochy a źıskaného rotačńıho tělesa z př́ıkladu 2.69.(d).
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Př́ıklad 2.70: Ve všech př́ıpadech využijeme poznámky 2.28:

(a) Výsledek: V = 3·π
4

.

Obrázek 6.12: Zobrazeńı zadané plochy a źıskaného rotačńıho tělesa z př́ıkladu 2.70.(a).

(b) Výsledek: V = 288·π
35

.

Obrázek 6.13: Zobrazeńı zadané plochy a źıskaného rotačńıho tělesa z př́ıkladu 2.70.(b).

(c) Výsledek: V = 3 · π.

(d) Výsledek: V = 4 · π2.
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Obrázek 6.14: Zobrazeńı zadané plochy a źıskaného rotačńıho tělesa z př́ıkladu 2.70.(c).

Obrázek 6.15: Zobrazeńı zadané plochy a źıskaného rotačńıho tělesa z př́ıkladu 2.70.(d).

Př́ıklad 2.71: Koule vznikne např́ıklad rotaćı
”
horńı“ poloviny kruhu kolem osy x. Je tedy

potřeba odvodit rovnici kružnice o poloměru r a jej́ı
”
horńı“ polovinu použ́ıt pro dosazeńı

do vztahu pro výpočet objemu.

Př́ıklad 2.72: Válec o poloměru podstavy r a výšce válce v vznikne rotaćı (kolem osy x)
obdélńıka tvořeného stranou o délce v na ose x, kolmicemi v krajńıch bodech o délkách r
a zbylou stranou o délce v (spojuj́ıćı kolmice

”
na druhé straně“).

Př́ıklad 2.73: Kužel vznikne rotaćı trojúhelńıka kolem osy x. Trojúhelńık je tvořen úsečkou
na ose x odpov́ıdaj́ıćı výšce kužele a kolmićı na jednom konci úsečky o délce rovné po-
loměru kužele. Lineárńı funkce pak spoj́ı

”
zbývaj́ıćı konce“ úsečky a kolmice (při vhodném
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”
rozmı́stěńı“ může být lineárńı funkćı funkce y = r

v
· x).

Př́ıklad 2.76: Ve všech př́ıpadech využijeme poznámky 2.30. Obsah pláště zpravidla poč́ıtáme
rozděleńım na části pláště źıskané rotacemi jednotlivých funkćı na odpov́ıdaj́ıćıch intervalech.

(a) S = 1
96
· π ·

(
134 ·

√
5− 3 · ln

(√
5 + 2

)
− 16

) .
= 9.14 .

(b) S = 2 · π ·
(√

2 + ln
(
1 +
√

2
)) .

= 14.42.

(c) S = π ·
(√

17 + 2 · ln (2)− ln
(
1 +
√

17
)

+ 2 ·
√

2 + ln
(
1 +
√

2
)

+ 6
) .

= 42.68.

(d) S = 4 · π ·
(√

2 + 2
) .

= 42.90.

Př́ıklad 2.77: Ve všech př́ıpadech využijeme poznámky 2.31:

(a) S = 3 · π.

(b) S = 108·π
5

.

(c) S = π ·
(
2 ·
√

5 + ln
(√

5 + 2
)) .

= 18.58.

(d) S = 8 · π2.

Př́ıklad 2.78: Řeš́ıme zcela analogicky k př́ıkladu 2.71.

Př́ıklad 2.79: Řeš́ıme analogicky k př́ıkladu 2.72. Pozor na to, že v zadáńı se požaduje povrch
celého válce, tj. muśıme určit povrch pláště i podstavy válce.

Př́ıklad 2.81: Postupujeme stejným zp̊usobem jako v př́ıkladu 2.80. Tentokrát je funkce

nespojitá v bodě 0, a muśıme tak určit lim
t→0+

1∫
t

x · ln(x) dx.

Př́ıklad 2.83:

(a) Integrál diverguje: lim
x→∞

(2 ·
√
x) =∞.

(b)
∞∫
−∞

1
1+x2

dx = lim
x→−∞

arctan(x) + lim
x→∞

arctan(x).

(c) Maple ve výledku zobraźı Fresnel̊uv integrál definovaný jako

FresnelS (x) =

x∫
0

sin

(
1

2
· π · t2

)
dt,

nebot’ neumı́ zapsat řešeńı analyticky pomoćı standardńıch funkćı. Př́ıkazem evalf

zjist́ıme, že př́ıslušný integrál konverguje.

(d) Integrál diverguje: lim
x→∞

ln(x) =∞.
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6.3 Matematická analýza s Maple v Rn

Př́ıklad 3.4: Nakreslené oblasti jsou zobrazeny na obrázćıch 6.16 – 6.18

(a),(b)

Obrázek 6.16: Zobrazeńı zadané oblasti z př́ıkladu 3.4.(a) vlevo, zobrazeńı zadané oblasti z př́ıkladu
3.4.(b) vpravo.

(c), (d)

Obrázek 6.17: Zobrazeńı zadané oblasti z př́ıkladu 3.4.(c) vlevo, zobrazeńı zadané oblasti z př́ıkladu
3.4.(d) vpravo.
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(e)

Obrázek 6.18: Zobrazeńı zadané oblasti z př́ıkladu 3.4.(e).

Př́ıklad 3.6: Př́ıslušné definičńı obory jsou zobrazeny na obrázćıch 6.19 – 6.21

(a), (b) Výraz pod odmocninou muśı být nezáporný.

Obrázek 6.19: Zobrazeńı definičńıho oboru funkce z př́ıkladu 3.6.(a) vlevo, zobrazeńı definičńıho
oboru funkce z př́ıkladu 3.6.(b) vpravo.

(c), (d) Argument funkce ln muśı být kladný. Argument funkce arccos muśı nabývat hod-
not z intervalu [−1, 1]. Systém Maple má s vykresleńım př́ıslušné množiny př́ıpadu
(d)

”
problémy“. Při vyšš́ıch hodnotách parametr̊u gridrefine a crossingrefine je

výsledek akceptovatelný.

(e), (f) Výrazy pod odmocninami muśı být nezáporné. Dı́ky jejich tvaru je pro ně možné vy-
tvořit jedinou nerovnost a zbývaj́ıćı část podmı́nky

”
schovat“ do rozsahu proměnných,

abychom mohli použ́ıt př́ıkaz implicitplot. Argument funkce ln muśı být kladný,
tzn. x > 0 ∧ y − x > 0 pro př́ıpad (f).
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Obrázek 6.20: Zobrazeńı definičńıho oboru funkce z př́ıkladu 3.6.(c) vlevo, zobrazeńı definičńıho
oboru funkce z př́ıkladu 3.6.(d) vpravo.

Obrázek 6.21: Zobrazeńı definičńıho oboru funkce z př́ıkladu 3.6.(e).

Př́ıklad 3.7:

(a) Pro některé hodnoty parametru contours Maple nezobraźı vrstevnice y = −x a y = x.

(b) Pro rovnoměrné rozložeńı vrstevnic na zadané oblasti je vhodné specifikovat parametr
contours seznamem funkčńıch hodnot.

(c) Zadaná funkce je nespojitá pro y = 0, s č́ımž si Maple
”
neumı́ poradit“ a vykresluje

v tomto mı́stě svislou plochu. Př́ıkaz plot3d nemá k dispozici parametr discont, což se
obcháźı vytvořeńım dvou graf̊u tak, abychom se nespojitosti

”
vyhnuli“ – vykresĺıme

funkci nalevo od mı́sta nespojitosti a napravo, grafy pak spoj́ıme v jeden př́ıkazem
display.
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Obrázek 6.22: Zobrazeńı vrstevnic funkce z př́ıkladu 3.7.(a).

Obrázek 6.23: Zobrazeńı vrstevnic funkce z př́ıkladu 3.7.(b).
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Obrázek 6.24: Zobrazeńı vrstevnic funkce z př́ıkladu 3.7.(c).

(d)

Obrázek 6.25: Zobrazeńı vrstevnic funkce z př́ıkladu 3.7.(d).

Př́ıklad 3.10: Polož́ıme δ = min{ε, 1}. Následně muśıme ukázat, že pro libovolná x, y splňuj́ıćı
|x| < δ, |y| < δ, [x, y] 6= [0, 0] plat́ı:

x2 · y2

x2 + y2
< ε.

Jelikož x, y splňuje [x, y] 6= [0, 0], je aspoň jedno z nich nenulové. Bez újmy na obecnosti
předpokládejme, že např́ıklad y 6= 0. Pak pro jinak libovolná x, y plat́ı: x2 < x2 + y2. Z toho
máme:

x2 · y2

x2 + y2
< y2.
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Pro ε > 1 máme |x| < 1, |y| < 1 a tedy

x2 · y2

x2 + y2
< y2 < 1 < ε.

Pro ε ≤ 1 máme |x| < ε, |y| < ε a tedy

x2 · y2

x2 + y2
< y2 < ε2 ≤ ε.

Př́ıklad 3.11:

(a) Maple urč́ı správně, že limita neexistuje. Sami to můžeme ověřit např́ıklad přibližováńım
se po př́ımkách y = k ·x. Výsledek je závislý na k, tj. na př́ımce, po ńıž se k limitńımu
bodu bĺıž́ıme.

(b) Maple limitu neumı́ spoč́ıtat. Limita v tomto př́ıpadě opět neexistuje, což můžeme
stejně jako v předchoźım př́ıpadě ověřit přibližováńım se k limitńımu bodu po př́ımkách.

(c) Maple limitu nespoč́ıtá. Limita neexistuje, což můžeme zjistit pomoćı transformace do
polárńıch souřadnic. Źıskaný výsledek záviśı na úhlu ϕ.

(d) Maple limitu nespoč́ıtá ani v tomto př́ıpadě, i když stač́ı pouze dosadit.

(e) Maple limitu nespoč́ıtá. Limita existuje a je rovná 0. Ověřit to můžeme transformaćı
do polárńıch souřadnic a aplikaćı poznámky 3.4.

(f) Maple limitu nespoč́ıtá. Proměnná y tu přitom neńı zdrojem nespojitosti, a tak za ni
můžeme dosadit a poč́ıtat zadanou limitu pouze jako limitu v proměnné x.

(g) Maple limitu nespoč́ıtá ani tentokrát. Limita existuje a je rovná 1
2
. Výsledek źıskáme

po rozš́ı̌reńı zadaného výrazu doplněńım čitatele na rozd́ıl čtverc̊u, následné úpravě
a dosazeńı.

Př́ıklad 3.13: V př́ıpadech a) – d) jsou body nespojitosti tvořeny vždy body, které nejsou
v definičńım oboru funkce f(x, y). Ve všech bodech definičńıho oboru jsou funkce totiž spo-
jité.

(a) Jmenovatel rovný nule, takže jediným bodem nespojitosti funkce f(x, y) je bod [0, 0].

(b) Jmenovatel rovný nule, tj. body [x, y] takové, že x = 0 nebo y = 0.

(c) Jmenovatel rovný nule, tj. body [x, y] takové, že y = 0.

(d) Argument funkce ln(x) nekladný, tj. body [x, y] takové, že x2 + y2 = 1.

(e) Funkce f(x, y) nemá body nespojitosti. Jediný
”
podezřelý“ bod z nespojitosti je bod

[0, 0], v němž je však limita rovna funkčńı hodnotě (viz př́ıklad 3.9).

Př́ıklad 3.14:

(a) Podle př́ıkladu 3.11.(g): C = 1
2
.
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(b) Podle př́ıkladu 3.11.(c) limita v bodě [0, 0] neexistuje, tj. neńı možné
”
dodefinovat“ C

tak, aby zadaná funkce byla v bodě [0, 0] spojitá.

Př́ıklad 3.15:

(a) f ′x(x, y) = 2 · x · y + 1
x
,

f ′y(x, y) = x2 − 1
y
,

f ′′xx(x, y) = 2 · y − 1
x2

,
f ′′xy(x, y) = 2 · x,
f ′′yx(x, y) = 2 · x,
f ′′yy(x, y) = 1

y2
,

(b) f ′x(x, y) = 8 · (x2 · y + y)3 · x · y,
f ′y(x, y) = 4 · (x2 · y + y)

3 · (x2 + 1),
f ′′xx(x, y) = 56 · x6 · y4 + 120 · x4 · y4 + 72 · x2 · y4 + 8 · y4,
f ′′xy(x, y) = 32 · x7 · y3 + 96 · x5 · y3 + 96 · x3 · y3 + 32 · x · y3,
f ′′yx(x, y) = 32 · x7 · y3 + 96 · x5 · y3 + 96 · x3 · y3 + 32 · x · y3,

f ′′yy(x, y) = 12 · y2 · (x2 + 1)
4
,

(c) f ′x(x, y) = xy ·y
x

,
f ′y(x, y) = xy · ln(x),
f ′′xx(x, y) = xy−2 · y · (y − 1),
f ′′xy(x, y) = xy−1 · (y · ln(x) + 1),
f ′′yx(x, y) = xy−1 · (y · ln(x) + 1),
f ′′yy(x, y) = xy · ln(x)2,

(d) f ′x(x, y) = y · ln(x+ y) + x·y
x+y

,

f ′y(x, y) = x · ln(x+ y) + x·y
x+y

,

f ′′xx(x, y) = y · x+2∗y
(x+y)2

,

f ′′xy(x, y) = ln(x+ y) + y
x+y

+ x
x+y
− x·y

(x+y)2
,

f ′′yx(x, y) = ln(x+ y) + y
x+y

+ x
x+y
− x·y

(x+y)2
,

f ′′yy(x, y) = x · 2·x+y
(x+y)2

.

Př́ıklad 3.16:

(a) f ′x(1, 2) =
1+ 1

5
·
√

5

1+
√

5
, f ′y(1, 2) = 2

5
·
√

5
1+
√

5
,

(b) f ′x(e, e) = 12
e
, f ′y(e, e) = −12

e
,

(c) f ′x(1, 2) = 0, f ′y(1, 2) = 1
4
.

Př́ıklad 3.18:

(a) f ′u(A) =
√

2
2

,

(b) Př́ıkaz DirectionalDerivative neumı́ pracovat s obecnými směry. Je proto potřeba
vypoč́ıtat řešeńı jinak. f ′u(A) = 1

2
· (cos(α) + sin(α)).

Př́ıklad 3.20:
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(a) f(x, y) = xy, [x0, y0] = [3, 1], [x, y] = [3.05, 0.99],

(b) Nejprve převedeme stupně na radiány. f(x, y) =
√
x · cos(y), [x0, y0] = [3, π

3
], [x, y] =

[3.05, 31·π
90

],

(c) f(x, y) = arctan(x
y
), [x0, y0] = [1, 1], [x, y] = [1.02, 0.95],

(d) f(x, y) = log4(x · y2), [x0, y0] = [4, 1], [x, y] = [4.01, 0.97].

Př́ıklad 3.22:

(a) t(x, y) = 4 · x− 2 · y − 5,

(b) t(x, y) = 5 · x+ y − 3,

(c) t(x, y) = 4
5
· x+ 2

5
· y + ln(5)− 2,

(d) t(x, y) = 1.

Př́ıklad 3.23: Ve všech př́ıkladech použijeme př́ıkaz mtaylor.

(a) muśıme specifikovat bod [x = 1, y = 1],

(b) muśıme specifikovat bod [x = 0, y = π
2
],

(c) muśıme změnit proměnnou Order nebo přidat třet́ı parametr př́ıkazu mtaylor,

(d) muśıme specifikovat všechny tři proměnné.

Př́ıklad 3.24:

(a) f(x, y) =
√
x3 + y3, [x0, y0] = [1, 2], [x, y] = [1.02, 1.97],

(b) Nejprve převedeme stupně na radiány. f(x, y) =
√
x · cos(y), [x0, y0] = [3, π

3
], [x, y] =

[3.05, 31·π
90

],

(c) f(x, y) = arctan(x
y
), [x0, y0] = [1, 1], [x, y] = [1.02, 0.95],

(d) f(x, y) = log4(x · y2), [x0, y0] = [4, 1], [x, y] = [4.01, 0.97].

Př́ıklad 3.25: Definice lokálńıho minima je naprosto stejná s definićı 3.9, jen nyńı požadujeme,
aby pro všechna X z nějakého okoĺı bodu X∗ platilo: f(X) ≥ f(X∗).

Př́ıklad 3.30:

(a) Funkce má 2 stacionárńı body, z nichž jeden (bod [1, 1]) je lokálńım minimem.

(b) Funkce má 4 stacionárńı body. Dva z nich jsou lokálńımi extrémy. Bod [0,−1] je
lokálńım minimem, bod [0, 1] je lokálńım maximem.

(c) Funkce má 8 stacionárńıch bod̊u. Čtyři z nich jsou lokálńı extrémy. Body [−
√

2·e
2·e ,−

√
2·e

2·e ]

a [
√

2·e
2·e ,

√
2·e

2·e ] jsou lokálńı minima, body [−
√

2·e
2·e ,

√
2·e

2·e ] a [
√

2·e
2·e ,−

√
2·e

2·e ] jsou lokálńı maxima
zadané funkce.
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(d) Funkce má nekonečně mnoho stacionárńıch bod̊u, které jsou též jej́ımi lokálńımi extrémy.
V bodě [0, 0] se nacháźı lokálńı minimum. Ostatńı stacionárńı body, které jsou všechny
lokálńımi maximy, lež́ı na kružnici x2 +y2 = 1. Klasickým zp̊usobem neumı́me o těchto
bodech rozhodnout. Pro ověřeńı, že se jedná o lokálńı maxima, můžeme zavést substi-
tuci t = x2 + y2 a vyšetřit lokálńı extrémy funkce, jako by se jednalo o funkci jedné
proměnné.

(e) Funkce má jediný stacionárńı bod ([2, 4]), který je jej́ım lokálńım minimem. Pro y = 0
neexistuje parciálńı derivace podle proměnné y. Podle toho, jak chápeme pojem okoĺı
bodu (funkce neńı definovaná pro y < 0), bychom měli vyšetřit ještě body, pro něž
y = 0. Nicméně pro y = 0 funkce lokálńıho extrému nenabývá, o čemž je potřeba se
přesvědčit vyšetřeńım okoĺı

”
potenciálńıho“ lokálńıho minima v bodě [4

3
, 0].

(f) Funkce má jeden stacionárńı bod, který neńı jej́ım lokálńım extrémem. Pro x = −1
nebo y = −1 neexistuj́ı parciálńı derivace zadané funkce. Opět je na uvážeńı, jak chápat
pojem okoĺı bodu a př́ıpadně vyšetřit i lokálńı chováńı funkce v př́ıpadech x = −1 nebo
y = −1. Již z grafu je vidět, že funkce tu dosahuje lokálně své nejvyšš́ı hodnoty v bodě
[−1,−1], takže je možné mluvit o lokálńım maximu funkce v tomto bodě.

(g) Funkce má nekonečně mnoho stacionárńıch bod̊u, žádný z nich však neńı jej́ım lokálńım
extrémem. Funkce má dále dva body, v nichž neexistuj́ı parciálńı derivace. Bod [0, 0]
neńı lokálńım extrémem funkce, bod [2, 3] je lokálńım minimem.

Př́ıklad 3.31: Definice absolutńıho minima je naprosto stejná s definićı 3.11, jen nyńı požadujeme,
aby pro všechna X z množiny M platilo: f(X) ≥ f(X∗).

Př́ıklad 3.35:

(a) V tomto př́ıpadě ani neńı potřeba nic poč́ıtat. Jen si pozorně přeč́ıst zadáńı a zamyslet
se nad ńım. Největš́ı hodnota (absolutńı maximum) zadané funkce je dána

”
př́ımo“

množinou M a jsou to tedy všechny body na jej́ı hranici. Absolutńı minimum źıskáme
tak, když si uvědomı́me, že druhá mocnina reálného č́ısla je vždy č́ıslo nezáporné (tj.
větš́ı nebo rovno nule).

(b) Opět neńı třeba nic poč́ıtat, stač́ı použ́ıt
”
selský rozum“. Množinu M můžeme přepsat

do interval̊u: x ∈ [−1, 1], y ∈ [−1, 1] a odtud už je na prvńı pohled vidět, že absolutńı
minimum se nacháźı v bodě [−1,−1] a absolutńı maximum v bodě [1, 1].

(c) Absolutńı minimum funkce urč́ıme již ze zadáńı, nebot’ absolutńı hodnota nabývá své
nejmenš́ı hodnoty pro nulový argument a ten je uvnitř množiny M . Absolutńı maxi-
mum můžeme hledat klasickou cestou. Zadaná funkce nemá stacionárńı body, má ovšem
nekonečně mnoho bod̊u, kde neńı diferencovatelná. Z grafu funkce (př́ıpadně rovnou ze
zadáńı) zjist́ıme, že absolutńı maximum lež́ı na hranici množiny M . Např́ıklad př́ıkazem

extrema můžeme extrém naj́ıt, a to hned ve čtyřech bodech: [
√

2
2
,
√

2
2

], [
√

2
2
,−
√

2
2

],

[−
√

2
2
,
√

2
2

] a [−
√

2
2
,−
√

2
2

].

(d) Postupujeme
”
klasickým“ zp̊usobem. Urč́ıme lokálńı extrémy (lok. max. v bodě [1, 1])

a následně extrémy na hranici množiny M . Celkem dostaneme, že absolutńı maximum
je v bodě [1, 1], absolutńı minima jsou dvě, a to v bodech [0, 4] a [4, 0].
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(e) Zadaný trojúhelńık M je možné vykreslit následuj́ıćı posloupnost́ı př́ıkaz̊u:
p1 := plots[pointplot]([[0, 2], [3, 0], [0, -1]], color = red,

symbolsize = 20, symbol = solidcircle):

p2 := plots[polygonplot]([[0, 2], [3, 0], [0, -1]], color = red,

style = line, thickness = 2):

plots[display](p1, p2)

Základńım krokem je zápis jednotlivých úseček trojúhelńıku v proměnných x a y. Pak
pokračujeme

”
klasickým“ zp̊usobem. Urč́ıme lokálńı extrémy (lok. min. v bodě [1

2
, 1])

a následně extrémy na hranici množiny M . Celkem dostaneme, že absolutńı maximum
je v bodě [0,−1], absolutńı minimum v bodě [1

2
, 1].

(f) Postupujeme opět
”
klasickým“ zp̊usobem. Nejprve hledáme lokálńı extrémy. Dostáváme

”
tři“ stacionárńı body, přičemž jeden z nich pokrývá všechny body takové, že y = 0.

Tento stacionárńı bod (body) však neńı extrémem již na prvńı pohled, protože funkčńı
hodnota je pro něj rovna nule. Zbylé dva stacionárńı body [π

3
, π

3
], [−π

3
,−π

3
] jsou lokálńı

minimum a maximum zadané funkce. Nyńı je potřeba si uvědomit, že funkce sinus je
periodická s periodou 2π, takže těchto lokálńıch extrémů je vlastně nekonečně mnoho
a všechny jsou současně i extrémy globálńımi na celém definičńım oboru. V zadáńı
byla specifikována množina M , a tak je potřeba omezit množinu těchto extrémů tak,
aby vyhovovala zadáńı, tj. absolutńı maxima jsou body [π

3
+ 2 · k · π, π

3
− 2 · l · π] pro

k, l ∈ N0, absolutńı minima jsou body [5·π
3

+ 2 · k · π,−π
3
− 2 · l · π] pro k, l ∈ N0.

Př́ıklad 3.37: Řeš́ıme naprosto stejným postupem jako v př́ıkladu 3.36. Hledaná kladná č́ısla
jsou: x = y = z = 4.

Př́ıklad 3.38: Opět postupujeme stejně jako v př́ıkladu 3.36. Minimalizujeme funkci f(x, y) =
x + y + 50√

x·y pro x > 0, y > 0. Nejmenš́ı možný součet takových č́ısel je 20 pro x = 5, y =
5, z = 10.

Př́ıklad 3.39: Vzdálenost bodu o souřadnićıch [x, y, z] od počátku souřadného systému je:√
x2 + y2 + z2. Tento součet muśıme minimalizovat pro z = x · y− 1. Přepisem analogickým

k předchoźım př́ıklad̊um dostáváme úlohu minimalizovat funkci

f(x, y) =
√
x2 + y2 + (x · y − 1)2

na celém jej́ım definičńım oboru. K tomu můžeme využ́ıt př́ıkaz minimize. Nejbĺıže počátku
je bod [0, 0,−1].

Př́ıklad 3.40: Hledáme rovnici př́ımky y = k · x + q, tj. reálná č́ısla k a q, pro něž plat́ı, že
S = (q − 2)2 + (k + q − 3)2 + (2 · k + q − 5)2 je minimálńı. Můžeme opět využ́ıt př́ıkazu
minimize a dostáváme: k = 3

2
, q = 11

6
.

Př́ıklad 3.42: U každého př́ıpadu vykresĺıme množinu Ω a z obrázku urč́ıme meze dvojnásobného
integrálu.

(a)

Můžeme volit následuj́ıćı:

0 ≤ x ≤ 1, 0 ≤ y ≤ x, nebo 0 ≤ y ≤ 1, 0 ≤ x ≤ y.

208



Obrázek 6.26: Zobrazeńı množiny Ω z př́ıkladu 3.42.(a) vlevo, zobrazeńı množiny Ω z př́ıkladu
3.42.(b) vpravo.

Celkem tak źıskáme:

I =

∫∫
Ω

f(x, y) dx dy =

1∫
0

x∫
0

f(x, y) dy dx =

1∫
0

y∫
0

f(x, y) dx dy.

(b)

Můžeme volit následuj́ıćı:

0 ≤ x ≤ 1,−
√

1− x2 ≤ y ≤
√

1− x2.

Celkem tak źıskáme:

I =

∫∫
Ω

f(x, y) dx dy =

1∫
0

√
1−x2∫

−
√

1−x2

f(x, y) dy dx.

(c)

Můžeme volit následuj́ıćı:

−3 < x ≤ 0,−x− 3 < y < x+ 3, 0 ≤ x < 3, x− 3 < y < −x+ 3.

Celkem tak źıskáme:

I =

∫∫
Ω

f(x, y) dx dy =

0∫
−3

x+3∫
−x−3

f(x, y) dy dx +

3∫
0

−x+3∫
x−3

f(x, y) dy dx.

(d)

Můžeme volit následuj́ıćı:

−2 ≤ x ≤ 0,−x
2
≤ y ≤ 1, 0 ≤ x ≤ 2, x

2
≤ y ≤ 1.
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Obrázek 6.27: Zobrazeńı množiny Ω z př́ıkladu 3.42.(c) vlevo, zobrazeńı množiny Ω z př́ıkladu
3.42.(d) vpravo.

Celkem tak źıskáme:

I =

∫∫
Ω

f(x, y) dx dy =

0∫
−2

1∫
−x

2

f(x, y) dy dx +

2∫
0

1∫
x
2

f(x, y) dy dx.

Př́ıklad 3.43: Podobně jako v předchoźım př́ıkladu si nejprve zobraźıme mmožinu ohraničenou
integračńımi mezemi a následně množinu vyjádř́ıme v obráceném pořad́ı meźı.

(a)

Přepis množiny v obráceném pořad́ı proměnných:

0 ≤ y ≤ 2, 0 ≤ x ≤ 2 · y.

Celkem tak źıskáme:

4∫
0

2∫
x
2

f(x, y) dy dx =

2∫
0

2·y∫
0

f(x, y) dx dy.

(b) Přepis množiny v obráceném pořad́ı proměnných:

0 ≤ y ≤ 2, y
2
≤ x ≤ y,

2 ≤ y ≤ 4, y
2
≤ x ≤ 2.

Celkem tak źıskáme:
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Obrázek 6.28: Zobrazeńı množiny ohraničené integračńımi mezemi z př́ıkladu 3.43.(a) vlevo, zob-
razeńı množiny ohraničené integračńımi mezemi z př́ıkladu 3.43.(b) vpravo.

2∫
0

2·x∫
x

f(x, y) dy dx =

2∫
0

y∫
y
2

f(x, y) dx dy +

4∫
2

2∫
y
2

f(x, y) dx dy.

(c) Přepis množiny v obráceném pořad́ı proměnných:

0 ≤ y ≤ 4,
√
y ≤ x ≤ 2.

Celkem tak źıskáme:

2∫
0

x2∫
0

f(x, y) dy dx =

4∫
0

2∫
√
y

f(x, y) dx dy.

(d) Přepis množiny v obráceném pořad́ı proměnných:

0 ≤ y ≤ 1,
√
y ≤ x ≤ 3

√
y.

Celkem tak źıskáme:

1∫
0

x2∫
x3

f(x, y) dy dx =

1∫
0

3
√
y∫

√
y

f(x, y) dx dy.
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Obrázek 6.29: Zobrazeńı množiny ohraničené integračńımi mezemi z př́ıkladu 3.43.(c).

Př́ıklad 3.45: Řešeńı je velice jednoduché. U př́ıkladu 3.42 stač́ı dosadit f(x, y) = 1 do
integrál̊u, které jsme źıskali řešeńım př́ıkladu. U př́ıkladu 3.43 stač́ı dosadit f(x, y) = 1 jak
do zadáńı, tak do řešeńı př́ıkladu.

Př́ıklad 3.46: Vyjdeme z rovnice kružnice o poloměru r: x2 +y2 = r2. Jestliže postupujeme od
proměnné x, meze prvńıho integrálu jsou zřejmé: x ∈ [−1, 1]. Následně potřebujeme vyjádřit
meze proměnné y, což provedeme právě z rovnice kružnice: y ∈ [−

√
r2 − x2,

√
r2 − x2].

Podle vztahu v poznámce 3.20 již jednoduše pomoćı systému Maple urč́ıme požadovaný
obsah kruhu.

Př́ıklad 3.47: Postupujeme analogicky předchoźımu př́ıkladu. Tentokrát vyjdeme z rovnice
elipsy: x2

a2
+ y2

b2
= 1. Proměnná x nyńı nabývá hodnot z intervalu [−a, a], pro meze proměnné

y plat́ı: y ∈
[
−b ·

√
1− x2

a2
, b ·
√

1− x2

a2

]
.

Př́ıklad 3.49: Ve všech př́ıpadech je vhodné pro źıskáńı představy vykreslit alespoň náznak
tvaru źıskaného tělesa. Dále je vhodné si zobrazit podstavu tělesa, z ńıž odvod́ıme integračńı
meze. Dvojný integrál nám následně spoč́ıtá systém Maple, jen v př́ıpadě (c) neźıskáme
přesnou (symbolickou) hodnotu a muśıme použ́ıt př́ıkaz evalf.
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Obrázek 6.30: Řešeńı př́ıkladu 3.49.(a).
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Obrázek 6.31: Řešeńı př́ıkladu 3.49.(b).

Obrázek 6.32: Řešeńı př́ıkladu 3.49.(c).
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Obrázek 6.33: Řešeńı př́ıkladu 3.49.(d).

Obrázek 6.34: Řešeńı př́ıkladu 3.49.(e).
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Př́ıklad 3.50: Kvádr je třeba vhodně umı́stit do souřadné soustavy – např́ıklad tak, že spodńı
roh podstavy dáme do bodu [0, 0, 0], zbylé rohy podstavy budou v bodech [a, 0, 0], [0, b, 0]
a [a, b, 0]. Výška kvádru bude rovna c. Z toho vyplývá, že funkce ohraničuj́ıćı kvádr je
konstantńı funkce f(x, y) = c a podstavu kvádru můžeme přepsat do meźı následovně:
x ∈ [0, a], y ∈ [0, b].

Př́ıklad 3.51: Je potřeba znát rovnici koule: x2 + y2 + z2 = r2. Koule vyjádřená touto rovnićı
má střed v počátku souřadné soustavy. Jej́ı objem urč́ıme tak, že spoč́ıtáme objem jej́ı horńı
poloviny (která lež́ı nad rovinou z = 0) a ten vynásob́ıme dvěma. Plášt’ horńı poloviny
koule je popsán funkćı f(x, y) =

√
r2 − x2 − y2, podstava je tvořena kruhem popsaným

nerovnićı x2 + y2 ≤ r2. Integračńı meze tak můžeme zapsat následovně: x ∈ [−r, r], y ∈
[−
√
r2 − x2,

√
r2 − x2].

Př́ıklad 3.52: Opět je potřeba vhodně umı́stit válec do souřadného systému. Můžeme např́ıklad
podstavu válce umı́stit do roviny z = 0 tak, že jej́ı střed je v počátku souřadné soustavy.
Podstava je pak popsána nerovnićı x2 + y2 ≤ r2 a je možné ji přepsat do integračńıch meźı
následovně: x ∈ [−r, r], y ∈ [−

√
r2 − x2,

√
r2 − x2]. Válec je shora ohraničen konstantńı

funkćı f(x, y) = v.

Př́ıklad 3.54: Postupujeme stejným zp̊usobem jako v př́ıkladu 3.53.
Výsledky:

(a) S = 3 ·
√

14,

(b) S = −15
16

+ 185
128
· ln (5) + 5

6
·
√

5 + 185
64
· arcsinh

(
2
5
·
√

5
) .

= 5.58,

(c) př́ıslušný integrál muśıme vyhodnotit numericky, S
.
= 583.77,

(d) př́ıslušný integrál muśıme vyhodnotit numericky, S
.
= 7.57,

(e) př́ıslušný integrál muśıme vyhodnotit numericky, S
.
= 6.00.

Př́ıklad 3.55: Kouli umı́st́ıme opět středem do počátku souřadného systému. Povrch horńı
poloviny koule je pak popsán funkćı f(x, y) =

√
r2 − x2 − y2. Integračńı meze můžeme za-

psat následovně: x ∈ [−r, r], y ∈ [−
√
r2 − x2,

√
r2 − x2]. Źıskaný výsledek je třeba vynásobit

dvěma (nebot’ poč́ıtáme povrch pouze horńı poloviny koule).

Př́ıklad 3.56: Povrch horńı poloviny koule je popsán funkćı f(x, y) =
√

25− x2 − y2. Dále
je třeba odvodit integračńı meze. Rovina z = 2 protne kouli v bodech kružnice popsané
rovnićı x2 + y2 = 21 a rovina z = 4 protne kouli v bodech kružnice popsané rovnićı x2 +
y2 = 9. Množina Ω je tedy prstencového tvaru vymezená kružnicemi o poloměrech

√
21

a 3. Dı́ky symetrii celého tělesa je možné zabývat se pouze prvńım oktantem a výsledek
vynásobit čtyřmi. Integračńı meze (meze části množiny Ω) bychom pak zapsali následovně:
x ∈ [0, 3], y ∈ [

√
9− x2,

√
21− x2] ∪ x ∈ [3,

√
21], y ∈ [0,

√
21− x2].

Pro źıskáńı symbolického výsledku je třeba převést integrál do polárńıch souřadnic, např.
př́ıkazem ChangeOfVariables z baĺıku Student[MultivariateCalculus]. Maple to ne-
zvládne dokonale, a tak je potřeba následně zapsat do polárńıch souřadnic ještě množinu
Ω (pro źıskáńı integračńıch meźı). V polárńıch souřadnićıch je nav́ıc jednodušš́ı množinu Ω
zapsat, a tak ji přeṕı̌seme rovnou celou. Pro poloměr r plat́ı: 3 ≤ r ≤

√
21, a pro úhel θ:

0 ≤ θ ≤ 2 · π.
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Obrázek 6.35: Řešeńı př́ıkladu 3.56

Př́ıklad 3.58: Můžeme využ́ıt dvojných integrál̊u již źıskaných při řešeńı př́ıkladu 3.48 a pouze
funkci f(x, y)

”
přepsat“ do meźı pro proměnnou z v třet́ım integrálu. Zřejmě plat́ı:

(a) z ∈ [0, x2 + y2],

(b) z ∈ [0, 64− x2].

Př́ıklad 3.59: Postupujeme analogicky k řešeńı př́ıkladu 3.50. Kvádr vhodně umı́st́ıme do
souřadné soustavy a jeho meze pak můžeme zapsat následovně: x ∈ [0, a], y ∈ [0, b], z ∈ [0, c].

Př́ıklad 3.60: Koule je speciálńım př́ıpadem trojosého elipsoidu z př́ıkladu 3.57 pro a = b =
c = r. Můžeme tedy pouze pozměnit tyto hodnoty v řešeńı v př́ıkladu 3.57 a źıskáme vztah
pro objem koule o poloměru r.

Př́ıklad 3.61: Postupujeme analogicky k řešeńı př́ıkladu 3.52. Válec vhodně umı́st́ıme do
souřadné soustavy a jeho meze pak můžeme zapsat následovně:
x ∈ [−r, r], y ∈ [−

√
r2 − x2,

√
r2 − x2], z ∈ [−v, v].

Př́ıklad 3.63: Zadaná funkce představuje plášt’ horńı poloviny koule o poloměru r = 1.
V př́ıkladu tak poč́ıtáme objem horńı poloviny koule o zmı́něném poloměru a z předešlých
př́ıklad̊u v́ıme, že by výsledek měl vyj́ıt 2·π

3
. Můžeme např́ıklad zapsat dvojný integrál

v kartézských souřadnićıch a použ́ıt př́ıkaz ChangeOfVariables. Nové integračńı meze od-
vod́ıme velmi snadno, nebot’ se jedná o kruh o poloměru r = 1. Dostáváme tedy: r ∈ [0, 1], θ ∈
[0, 2 · π].
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Př́ıklad 3.64: Ve všech př́ıkladech (3.46, 3.51, 3.52, 3.60 a 3.61) jsme v tomto textu využili
kartézských souřadnic. Nyńı tedy provedeme př́ıslušné výpočty v souřadnićıch polárńıch,
sférických a cylindrických.

V př́ıkladu 3.46 poč́ıtáme obsah kruhu o poloměru r. V polárńıch souřadnićıch můžeme
kruh popsat následovně: x = ρ · cos(θ), y = ρ · sin(θ), kde ρ ∈ [0, r], θ ∈ [0, 2 · π]. Podle
poznámky 3.24 tak poč́ıtáme integrál

2·π∫
0

r∫
0

ρ dρ dθ.

Jak v př́ıkladu 3.46, tak i nyńı bychom měli obdržet tabulkový vzorec: S = π · r2.

V př́ıkladu 3.51 poč́ıtáme objem koule o poloměru r. Využijeme polárńıch souřadnic,
v nichž poṕı̌seme podstavu horńı polokoule následovně: x = ρ · cos(θ), y = ρ · sin(θ), kde
ρ ∈ [0, r], θ ∈ [0, 2 · π]. Podle poznámky 3.24 tak poč́ıtáme integrál

2 ·
2·π∫
0

r∫
0

ρ ·
√
r2 − ρ2 · cos(θ)− ρ2 · sin(θ) dρ dθ.

Jak v př́ıkladu 3.51, tak i nyńı bychom měli obdržet tabulkový vzorec: V = 4
3
· π · r3.

V př́ıkladu 3.52 poč́ıtáme objem válce o poloměru podstavy r a výšce v. Využijeme opět
polárńıch souřadnic, v nichž poṕı̌seme podstavu válce: x = ρ · cos(θ), y = ρ · sin(θ), kde
ρ ∈ [0, r], θ ∈ [0, 2 · π]. Podle poznámky 3.24 tak poč́ıtáme integrál

2·π∫
0

r∫
0

ρ · v dρ dθ.

Jak v př́ıkladu 3.52, tak i nyńı bychom měli obdržet tabulkový vzorec: V = π · r2 · v.

V př́ıkladu 3.60 poč́ıtáme objem koule o poloměru r. Ve sférických souřadnićıch můžeme
kouli popsat následovně: x = ρ · cos(φ) · sin(θ), y = ρ · sin(φ) · sin(θ), z = ρ · cos(θ), kde
ρ ∈ [−r, r], φ ∈ [0, 2 · π], θ ∈ [0, 2 · π]. Podle poznámky 3.25 tak poč́ıtáme integrál

2·π∫
0

2·π∫
0

r∫
−r

sin(θ) · ρ2 dρ dφ dθ.

Jak v př́ıkladu 3.60, tak i nyńı bychom měli obdržet tabulkový vzorec: V = 4
3
· π · r3.

V př́ıkladu 3.61 poč́ıtáme objem válce o poloměru podstavy r a výšce v. V cylindrických
souřadnićıch můžeme válec popsat následovně: x = ρ · cos(θ), y = ρ · sin(θ), z = z, kde
ρ ∈ [0, r], θ ∈ [0, 2 · π], z ∈ [0, v]. Podle poznámky 3.26 tak poč́ıtáme integrál

2·π∫
0

r∫
0

v∫
0

ρ dz dρ dθ.

Jak v př́ıkladu 3.61, tak i nyńı bychom měli obdržet tabulkový vzorec: V = π · r2 · v.
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Př́ıklad 3.65: Všechny tři řady umı́ Maple
”
seč́ıst“.

(a)
∞∑
n=1

1
n·(n+1)

= 1, (b)
∞∑
n=1

1
n2 = π2

6
, (c)

∞∑
n=1

1
n

=∞, řada diverguje.

Př́ıklad 3.68:

(a) sn =
√
n, s = lim

n→∞
sn =∞⇒ řada diverguje,

(b) an = 1√
n2+2·n > 1√

n2+2·n+1
= 1√

(n+1)2
= 1

n+1
, řada

∞∑
n=1

1
n+1

diverguje ⇒ zadaná řada

také diverguje,

(c) an =
√
n√

n4+1
<
√

1
n3 , řada

∞∑
n=1

√
1
n3 konverguje ⇒ konverguje i zadaná řada,

(d) použijeme limitńı srovnávaćı kritérium a budeme srovnávat s řadou
∞∑
n=1

1
n2 , o ńıž v́ıme,

že konverguje,

(e) použijeme limitńı verzi pod́ılového kritéria a zjist́ıme, že řada konverguje,

(f) využijeme opět limitńı verze pod́ılového kritéria a zjist́ıme, že řada diverguje,

(g) využijeme limitńı verze odmocninového kritéria a zjist́ıme, že zadaná řada konverguje,

(h) využijeme limitńı verze pod́ılového kritéria a zjist́ıme, že zadaná řada konverguje,

(i) stač́ı zadat systému Maple a zjist́ıme, že zadaná řada konverguje; jinak je možné použ́ıt
např́ıklad integrálńı kritérium.

Př́ıklad 3.71:

(a) Jak součet zadané řady, tak součet řady absolutńıch hodnot umı́ určit Maple př́ımo.
Zadaná řada konverguje absolutně.

(b) Součet zadané řady i řady absolutńıch hodnot opět urč́ı Maple př́ımo (i když je potřeba
se

”
nevyděsit“ vypsaným tvarem výsledku pro součet zadané řady). Zadaná řada kon-

verguje neabsolutně.

(c) Pomoćı Leibnizova kritéria zjist́ıme, že zadaná řada konverguje. Pomoćı integrálńıho
kritéria ověř́ıme, že řada absolutńıch hodnot diverguje. Zadaná řada proto konverguje
neabsolutně.

(d) Pomoćı Leibnizova kritéria zjist́ıme, že zadaná řada konverguje. Srovnávaćım kritériem

s řadou
∞∑
n=1

1
n

ověř́ıme, že řada absolutńıch hodnot diverguje. Zadaná řada proto kon-

verguje neabsolutně.

(e) Pomoćı limitńı varianty odmocninového kritéria zjist́ıme, že řada absolutńıch hodnot
konverguje. Zadaná řada proto konverguje absolutně.

(f) V př́ıkladu 3.67.(c) jsme zjistli, že řada absolutńıch hodnot zadané řady konverguje,
tedy zadaná řada konverguje absolutně.
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6.4 Lineárńı algebra s Maple v Cn

Př́ıklad 4.2: Muśıme naj́ıt lineárńı kombinace vektor̊u báze tak, abychom źıskali vektory báze
standardńı. Tj. např. pro

e1 = (1, 0, 0) =
1

3
· (3, 0, 0) + 0 · (0, 2, 0) + 0 · (0, 0, 1).

Souřadnice vektoru e1 v bázi α jsou proto (1
3
, 0, 0).

Př́ıklad 4.3: Nejsou. Je možné se o tom přesvědčit např. použit́ım př́ıkazu Basis.

Př́ıklad 4.4: Negeneruj́ı. Opět je možné se o tom přesvědčit např. použit́ım př́ıkazu Basis.
Bázi tvoř́ı pouze 2 z vektor̊u.

Př́ıklad 4.6:

G2 − 3 · F =

−2 −6 0
2 1 1
2 −9 −14

 , A− F = nedefinováno, A−G · F · A =

−4 −2
5 59
−7 −13

 ,

B · A · C ·H −B · F ·BT = 113.

Př́ıklad 4.7:

A−1 =

(
1 0
−1

2
1
4

)
, B−1 =

(
1
6
· (1− I) 1

3
1
3
· (1 + I) −1

3
· I

)
, C−1 =

1

a · d− b · c
·
(
d −b
−c a

)
,

F−1 =

 3 −1 0
1 −1 −1
−3 2 1

 .

Př́ıklad 4.8: Ve všech př́ıpadech využ́ıváme vytvořeńı matice pomoćı př́ıkazu Matrix(4,f),
kde funkce f specifikuje požadovanou závislost.

Př́ıklad 4.9:

a) Např́ıklad A =

(
0 1
0 0

)
. b) Např́ıklad A =

(
1 0
0 1

)
.

Př́ıklad 4.10: Zvoĺıme nějaký vektor, např. u = (1, 1)T . Vypočteme v = A · u pro nějakou
hodnotu α a pomoćı př́ıkazu PlotVector vykresĺıme u a v.

Př́ıklad 4.13: Postupujeme zcela analogicky př́ıkladu 4.11. Souřadnice vektoru v v bázi α
jsou: (0, 1, 2)T .

Př́ıklad 4.14: Můžeme použ́ıt např. př́ıkazu Basis:
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a) vektor u3, b) žádný z uvedených.

Př́ıklad 4.15: Jestliže vhodně zvoĺıme bázi, tj. např. α = {1, x, x2, x3} pro R3[x], vektor 1−x
má v této bázi souřadnice (1,−1, 0, 0) atd. Posléze již můžeme použ́ıt př́ıkaz Basis jako
v předchoźım př́ıkladu.

a) vektory jsou lineárně závislé, např. x3 − 1 = −(1− x)− (x− x2)− (x2 − x3),

b) totéž co za (a), např. x3 + 1 = (1 + x)− (x+ x2) + (x2 + x3),

c) vektory jsou lineárně nezávislé,

d) neńı nutné ani cokoli poč́ıtat, jedná se o 4 vektory v prostoru dimenze 3.

Rn[x] se standardńım sč́ıtáńım polynomů a skalárńım násobkem polynomu je vektorový
prostor – je třeba ověřit, že plat́ı:

1. p(x) = 0 ∈ Rn[x] je nulový prvek, tj. ∀q(x) ∈ Rn[x] : q(x) + p(x) = q(x),

2. ∀q(x) ∈ Rn[x] : ∃ − q(x) ∈ Rn[x] : q(x) + (−q(x)) = 0,

3. ∀p(x), q(x), r(x) ∈ Rn[x] : (p(x) + q(x)) + r(x) = p(x) + (q(x) + r(x)),

4. ∀p(x), q(x) ∈ Rn[x] : p(x) + q(x) = q(x) + p(x),

5. ∀a, b ∈ R, p(x) ∈ Rn[x] : a · (b · p(x)) = (a · b) · p(x),

6. p(x) = 1 ∈ Rn[x] je jednotkový prvek, tj. ∀q(x) ∈ Rn[x] : q(x) · p(x) = q(x),

7. ∀a ∈ R, p(x), q(x) ∈ Rn[x] : a · (p(x) + q(x)) = a · p(x) + a · q(x),

8. ∀a, b ∈ R, p(x) ∈ Rn[x] : (a+ b) · p(x) = a · p(x) + b · p(x).

Př́ıklad 4.16: Řeš́ıme analogicky př́ıkladu 4.12:

a)
”
kritické“ hodnoty: a = −1, b = 1,

b)
”
kritické“ hodnoty: a = 0, b = −2.

Př́ıklad 4.17: Řeš́ıme opět analogicky př́ıkladu 4.12:
”
kritické“ hodnoty: a = 1, b = 2, c = 6.

Př́ıklad 4.19: Řešeńı prob́ıhá analogicky př́ıkladu 4.18. Postup v př́ıpadě (a) ilustruje obrázek
6.36. Pokud použ́ıváme př́ıkaz assign a řeš́ıme v́ıce př́ıklad̊u najednou, je třeba mı́t na
paměti, že vytvář́ıme proměnné, do nichž přǐrazujeme nějaké hodnoty – to může v daľśıch
př́ıkladech

”
vadit“ a je třeba bud’ změnit názvy proměnných nebo z použ́ıvaných jmen

(x1, x2, ...) hodnoty odstranit. O správnosti řešeńı se můžeme též přesvědčit dosazeńım do
p̊uvodńı rovnice.

Př́ıklad 4.20: Řeš́ıme opět analogicky př́ıkladu 4.18. Dostáváme nekonečně mnoho řešeńı pro
tři r̊uzné reálné parametry.
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Obrázek 6.36: Řešeńı př́ıkladu 4.19.

Př́ıklad 4.21: Můžeme řešit mnoha zp̊usoby, které Maple nab́ıźı. Vždy bychom se měli do-
pracovat k výsledku, v němž se ve jmenovateĺıch objevuj́ı v součinu výrazy a2 + b2 a c, tj.
zadaná soustava má právě jedno řešeńı, pokud jsou tyto r̊uzné od nuly.

Př́ıklad 4.23: Postupujeme stejně jako v př́ıkladu 4.22.

Př́ıklad 4.24: Postupujeme stejně jako v př́ıkladu 4.22.

Př́ıklad 4.25: V zadáńı neńı specifikován postup výpočtu, takže stač́ı pouze
”
přepsat“ do

systému Maple a vyhodnotit.

Př́ıklad 4.26: Totéž jako v předešlém př́ıkladu. Pouze je třeba dát si pozor na zápis symbolu
pro násobeńı matic.

Př́ıklad 4.28: K Laplaceovu rozvoji využijeme zavedený př́ıkaz laplace. Matice lze jednoduše
upravovat do tvar̊u

”
výhodněǰśıch“ pro výpočet, nicméně to neńı nutné. Př́ımým výpočtem

determinantu můžeme ověřit správnost výpočtu pomoćı Laplaceova rozvoje.

Př́ıklad 4.29: Pro reálné matice z př́ıkladu 4.23 neńı třeba nic ověřovat, nebot’ konjugovaná
matice je shodná s p̊uvodńı matićı (podobně jako v př́ıpadě reálného č́ısla). U nereálných
matic využijeme např. př́ıkaz̊u conjugate a map.
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definičńı obor, 36
DeleteColumn, 170

DeleteRow, 170
Determinant, 115, 168
diff, 54, 106
Digits, 16, 20
DirectionalDerivative, 109
discont, 52, 64, 66, 67, 105
display, 45, 107
divergence řady, 140
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Drawing, 43
dsolve, 23

Error, (in plot) ..., 179
Error, (in rtable/Power) singular matrix, 158
Error, illegal use of an object as a name, 177
Error, invalid assignment, 176
Error, invalid input, 169, 174
Error, invalid operator parameter name, 177
Error, invalid power, 177
Error, numeric exception: division by zero,

177
Error, recursive assignment, 151
Error, unable to match delimiters, 176
eval, 33, 34, 55, 115, 170
evalb, 38
evalf, 16, 18, 24
expand, 29, 33
extrema, 65, 115, 119
ExtremePoints, 71

factor, 29, 158
fsolve, 23
FunctionChart, 70

GaussianElimination, 164, 165, 167
GaussianEliminationTutor, 164
grid, 95
gridrefine, 95, 97, 100

HermitianTranspose, 172
hessián, 115

223



Hessian, 115
Hessova matice, 115
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